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Preface
Welcome to the Multimedia 7.6 Deployment Guide. This guide introduces you 
to the architecture, required components, and procedures relevant to the 
deployment of a Genesys Multimedia solution in your contact center.
This guide is valid only for the 7.6 release(s) of this product.

Note: For releases of this document created for other releases of this product, 
please visit the Genesys Technical Support website, or request the 
Documentation Library DVD, which you can order by e-mail from 
Genesys Order Management at orderman@genesyslab.com.

This preface provides an overview of this document, identifies the primary 
audience, introduces document conventions, and lists related reference 
information:

Multimedia and the CIM Platform, page 12
Intended Audience, page 14
Chapter Summaries, page 14
Document Conventions, page 15
Related Resources, page 17
Making Comments on This Document, page 19
Document Change History, page 19

Genesys Multimedia is a series of components working together to handle 
interactions from disparate media-based devices. It allows you to centralize 
your handling of the various communication channels that customers use to 
reach your interaction contact center. Bringing your Multimedia solution into 
production requires that you deploy a number of Genesys components, as well 
as several separate, third-party software applications, without which 
Multimedia cannot work.

mailto:orderman@genesyslab.com
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Multimedia and the CIM Platform
Genesys Multimedia (formerly Multi-Channel Routing) is a cover term for 
Genesys components that work together to manage interactions whose media 
is something other than traditional telephonic voice (for example, e-mail or 
chat).
Multimedia includes some parts of the Genesys Customer Interaction 
Management (CIM) Platform, plus certain of the media channels that run on 
top of the Platform. See Figure 1 on page 13.

CIM Platform
The CIM Platform consists of the following components:
• Management Framework
• Reporting (CC Analyzer, CCPulse+)
• Interaction Management, which in turn consists of:

Universal Routing
Interaction Workflow
Knowledge Management
Content Analysis
Universal Contact History

On top of the CIM Platform are various media channels. Some, such as 
Genesys Network Voice, handle traditional telephony. Others, such as Genesys 
E-mail, handle other media.

Multimedia
Multimedia, then, consists of the following components:
• From the CIM Platform, all of Interaction Management components except 

for Universal Routing. This includes:
Interaction Workflow—Centralized handling of interactions 
irrespective of media type.
Knowledge Management—Creation and maintenance of standard 
responses and screening rules.
Content Analysis—Optional enhancement to Knowledge Management, 
applying natural language processing technology to categorize 
interactions.
Universal Contact History—Storage of data on contacts and on 
interactions (linked as threads).

Universal Routing is not considered part of Multimedia because it deals 
with both traditional telephonic interactions and the nontraditional 
interactions that are handled in Multimedia.
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• From the media channels, at least one of the following components:
Genesys E-mail—E-mail support.
Genesys Web Media—Chat capability.
Genesys Open Media—Ability to add customized support for other 
media (such as fax).
Optionally, Web Collaboration—The ability for agents and customers 
to co-browse (simultaneously navigate) shared web pages. This is an 
option that you can add to either Genesys Web Media or Inbound 
Voice.

Figure 1: Multimedia in Relation to the CIM Platform and Media Channels

Note: Although Universal Routing is not considered part of Multimedia, any 
functioning solution (platform plus channels) that includes any part of 
the Interaction Management sector requires Universal Routing.

Licensing

Licensing requirements are:
• For each agent, one Multimedia Agent seat.
• For each media option, one media channel (E-mail and/or Web Media and/or 

custom media).
• For Genesys Content Analyzer, NLP Content Analysis license.
See the Genesys 7 Licensing Guide for additional details.
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Reporting

Reporting templates are available for Multimedia. For details see the Reporting 
Technical Reference Guide for the Genesys 7.x Release.

Intended Audience
This guide, primarily intended for system administrators and anyone else who 
wants to configure and install Multimedia 7.6.1, assumes that you have a basic 
understanding of:
• Computer-telephony integration (CTI) concepts, processes, terminology, 

and applications.
• Network design and operation.
• Your own network configurations.
• Internet, e-mail, chat, and World Wide Web basics.
You should also be familiar with Genesys Framework architecture and 
functions.

Chapter Summaries
In addition to this preface, this document contains the following chapters: 
• Chapter 1, “Overview,” on page 21, lists the components required for 

Multimedia 7.6.1, describes a sample architecture, and summarizes 
configuration methods. This chapter also includes a list of new features 
available in this release.

• Chapter 2, “Deployment Task Flow,” on page 31, provides a complete flow 
of the steps required to deploy your Multimedia solution, as well as links to 
the detailed procedures found elsewhere in the document.

• Chapter 3, “Deployment Planning,” on page 37, provides procedures and 
worksheets used in the planning phase: algorithms for calculating database 
size, a worksheet to help organize configuration values, and a table listing 
all required connections.

• Chapter 4, “Deploying Third-Party Web Applications,” on page 55, 
describes how to install non-Genesys components that are prerequisites for 
Multimedia 7.6.1. It also outlines platform issues that may be relevant to 
your environment.

• Chapter 5, “Model Configuration and Installation on Windows,” on 
page 91, provides instructions for installing Genesys components for a 
model installation of Multimedia 7.6.1 using a Windows environment.
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• Chapter 6, “Deploying an E-Mail System in Secured Mode,” on page 145. 
desrcibes how to configure an e-mail system to work in secured mode 
using SSL.

• Chapter 7, “Deploying Multimedia in UNIX Environments,” on page 153, 
provides instructions for installing Genesys components for a model 
installation of Multimedia 7.6.1 using a Solaris, Linux, or AIX 
environment.

• Chapter 8, “Manual Deployment—Web Components and UCS,” on 
page 177, describes how to manually configure and install Web API 
Server, Web Compound Samples, Universal Contact Server, and Universal 
Contact Server Manager.

• Chapter 9, “UCS Proxy and Interaction Server Proxy,” on page 183, 
describes the manual deployment of Universal Contact Server Proxy and 
Interaction Server Proxy.

• Chapter 10, “Uninstalling Multimedia,” on page 189, describes how to 
uninstall Multimedia 7.6.1.

• Chapter 11, “Starting and Stopping Procedures,” on page 193, describes 
how to start and stop Multimedia 7.6.1.

• The Appendix, “Deploying an E-Mail Solution Using MIME 
Customization,” on page 199, describes how to ensure your e-mail solution 
is compliant with MIME standards.

Document Conventions
This document uses some stylistic and typographical conventions with which 
you might want to familiarize yourself.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:

76mm_dep_03-2007_v7.6.001.00

You will need this number when you are talking with Genesys Technical 
Support about this product.
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Type Styles

Italic

In this document, italic is used for the titles of documents, when a term is being 
defined, for emphasis, and for mathematical variables.

Examples • Please consult the Genesys 7 Migration Guide for more information.
• A customary and usual practice is one that is widely accepted and used 

within a particular industry or profession.
• Do not use this value for this option.
• The formula, x +1 = 7 where x stands for . . .

Monospace Font

A monospace font, which is shown in the following examples, is used for all 
programming identifiers and GUI elements. 
This convention includes the names of directories, files, folders, configuration 
objects, paths, scripts, dialog boxes, options, fields, text and list boxes, 
operational modes, all buttons (including radio buttons), check boxes, 
commands, tabs, CTI events, and error messages; the values of options; logical 
arguments and command syntax; and code samples.

Examples • Select the Show variables on screen check box.
• Click the Summation button.
• In the Properties dialog box, enter the value for the host server in your 

environment.
• In the Operand text box, enter your formula.
• Click OK to exit the Properties dialog box.
• The following table presents the complete set of error messages T-Server® 

distributes in EventError events.
• If you select true for the inbound-bsns-calls option, all established 

inbound calls on a local agent are considered business calls.
Monospace font is also used for any text that users must manually enter during 
a configuration or installation procedure, or on a command line:

Example • Enter exit at the command line.

Screen Captures Used in This Document

Screen captures from the product GUI (graphical user interface), as used in this 
document, may sometimes contain a minor spelling, capitalization, or 
grammatical error. The text accompanying and explaining the screen captures 
corrects such errors except when such a correction would prevent you from 
installing, configuring, or successfully using the product. For example, if the 
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name of an option contains a usage error, the name would be presented exactly 
as it appears in the product GUI; the error would not be corrected in any 
accompanying text.

Square Brackets

Square brackets indicate that a particular parameter or value is optional within 
a logical argument, a command, or some programming syntax. That is, the 
parameter’s or value’s presence is not required to resolve the argument, 
command, or block of code. The user decides whether to include this optional 
information. Here is a sample:
smcp_server -host [/flags]

Angle Brackets

Angle brackets indicate a placeholder for a value that the user must specify. 
This might be a DN or port number specific to your enterprise. Here is a 
sample:
smcp_server -host <confighost>

Related Resources
Consult these additional resources as necessary: 
• Multimedia 7.6 Reference Manual, which provides a reference listing of all 

configuration options and of field codes used in standard responses.
• Multimedia 7.6 User’s Guide, which provides overall information and 

recommendations on the use and operation of Multimedia.
• Multimedia 7.6 Universal Contact Server Manager Help, which is a guide 

to the Universal Contact Server Manager user interface.
• Multimedia 7.6 Knowledge Manager Help, which is a guide to the 

Knowledge Manager user interface.
• Multimedia 7.6 Web API Reference, which is a Javadoc listing of classes, 

methods, fields, and constants of the Web API portion of the Web API 
Server component.

• Multimedia 7.6 Web API Client Developer’s Guide, which describes the 
structure of the Web API, explains the Simple and Compound Samples, 
and describes procedures for customizing them. 

• Genesys 7 Events and Models Reference Manual, which includes a set of 
basic interaction models, showing the components involved and the event 
messages sent among them. These models and events were formerly 
presented in the Open Media Interaction Models Reference Manual. The 
request messages that were also described in that book are now 
documented in the API References of the Platform SDK.
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• For the Web Collaboration option, the following documents describing 
design and administration for the KANA Response Live Server, which is 
supplied by Genesys as part of the Web Collaboration product:

Hipbone Client API Reference Guide
KANA Response Live Organization Administration
KANA Response Live Server Installation Guide
KANA Response Live System Administration Tool User Guide

• Genesys Desktop 7.6 Deployment Guide, which describes deployment 
procedures for the Genesys Desktop.

• Genesys Desktop 7.6 Developer’s Guide, which describes customizing the 
Genesys Desktop.

• Genesys Desktop 7.6 Agent Help, which is a guide to the Genesys Agent 
Desktop.

• Genesys Desktop 7.6 Supervisor's Help, which is a guide to the Genesys 
Supervisor Desktop.

• Universal Routing 7.6 Reference Manual, which contains descriptions of 
all routing strategy objects, including those that are specific to Multimedia. 

• Universal Routing 7.6 Strategy Samples, which describes the sample 
strategies supplied with Universal Routing.

• Universal Routing 7.6 Business Process User’s Guide, which contains 
step-by-step instructions for using Interaction Routing Designer to design 
interaction workflows. It also describes the sample business processes 
supplied with Multimedia.

• Universal Routing 7.6 Interaction Routing Designer Help, which is a guide 
to Interaction Routing Designer, including the portion of it that designs 
interaction workflows and business processes for Multimedia.

• “Multimedia Log Events” in Framework 7.6 Combined Log Events Help, 
which is a comprehensive list and description of all events that may be 
recorded in logs.

• The Genesys Technical Publications Glossary, which ships on the Genesys 
Documentation Library DVD and which provides a comprehensive list of 
the Genesys and CTI terminology and acronyms used in this document.

• The Genesys 7 Migration Guide, also on the Genesys Documentation 
Library DVD, which contains a documented migration strategy for 
Genesys product releases 5.x and later. Contact Genesys Technical Support 
for additional information.

• The Release Notes and Product Advisories for this product, which are 
available on the Genesys Technical Support website at 
http://genesyslab.com/support.

• The documentation on the other three members of the Genesys Customer 
Interaction Platform: Universal Routing, Reporting, and Management 
Framework. 

http://genesyslab.com/support
http://genotype.genesyslab.com/support/dl/retrieve/default.asp?item=AACD2BA6319CF7E2EDE8E30A6D90D616&view=item
http://genotype.genesyslab.com/support/dl/retrieve/default.asp?item=ACD1197663705D3A970491DA1F648CF0&view=item
http://genotype.genesyslab.com/support/dl/retrieve/default.asp?item=AED517861584138211800F727980EA0A&view=item
http://genotype.genesyslab.com/support/dl/retrieve/default.asp?item=ADD31C7A5836A432A02EACCE343A3F3D&view=item
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Information on supported hardware and third-party software is available on the 
Genesys Technical Support website in the following documents: 
• Genesys Supported Operating Environment Reference Manual
• Genesys Supported Media Interfaces Reference Manual
Genesys product documentation is available on the:
• Genesys Technical Support website at http://genesyslab.com/support. 
• Genesys Documentation Library DVD, which you can order by e-mail 

from Genesys Order Management at orderman@genesyslab.com. 

Making Comments on This Document
If you especially like or dislike anything about this document, please feel free 
to e-mail your comments to Techpubs.webadmin@genesyslab.com. 
You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the information in this document only and to the 
way in which the information is presented. Speak to Genesys Technical 
Support if you have suggestions about the product itself.
When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.

Document Change History
This section lists topics that are new in the current release of this document, or 
that have changed significantly from the preceding release.

New in Version 7.6.1
The following topics have been added or significantly changed since the initial 
7.6 release:
• Chapter 4, “Deploying Third-Party Web Applications,” on page 55 was 

updated to include KANA Response Live deployment procedures for 
Linux.

• Chapter 6, “Deploying an E-Mail System in Secured Mode,” on page 145 
is new for the 7.6.1 release. 

• Chapter 9, “UCS Proxy and Interaction Server Proxy,” on page 183 is new 
for the 7.6.1 release.

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
http://genesyslab.com/support
http://genesyslab.com/support
mailto:techpubs.webadmin@genesyslab.com
mailto:orderman@genesyslab.com
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1 Overview
Genesys Multimedia is a platform on which you can assemble a coordinated 
suite of components that processes, manages, and archives customer/agent 
interactions in the media of your choice. This chapter introduces the 
components, functionality, and concepts behind them.
The information in this chapter is divided among the following topics:

Functions and Components, page 21
Architecture, page 25
Required Software Components, page 27
How to Configure, page 28
New in This 7.6.1 Release, page 29

Functions and Components
Figure 2 shows the overall functionality of Multimedia, with any media type. 
This figure shows functions only, not components.

Figure 2: General Functioning of Multimedia 
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The three major functions shown in Figure 2 are:
• The media interface, which brings interactions into the system. It may 

interface with e-mail, the Web, or other media.
• A database, which stores the history of the interaction and associates it 

with related interactions to form a thread. It also stores contact information 
and other types of data used at different points in the processing of 
interactions.

• Workflow control, which determines where the interaction goes and what 
happens to it.

For some media types (such as chat), the media interface also communicates 
directly with the agent desktop.
The following sections explain these functions further and describe the 
components involved.

Media Interfaces
The media interfaces available with Multimedia 7.6.1 are E-mail Server Java 
and Chat Server. 

Note: Multimedia 7.6.1 also supports the processing of open media 
interactions with the help of Genesys’s Open Media SDK and 
Interaction SDK products. See the documentation for those products 
for more information.

• E-mail Server Java interfaces with the enterprise mail server and the 
Genesys Web API Server, bringing in new e-mail interactions and sending 
out replies or other outbound messages.

• Chat Server works with Web API Server to open, conduct, and close chat 
interactions between agents and customers.

To the workflow control components, these interfaces transmit operational data 
about each interaction, consisting of an identifying code plus some data about 
the interaction (date received, originating party, and so on).
To the data storage components, they transmit the body of the interaction—that 
is, a transcript of the e-mail or chat session.

Data Storage: Universal Contact Server
Universal Contact Server (UCS) interfaces with a database that stores the 
following:
• Contact information, such as names, addresses, phone numbers
• Contact history: previous interactions with this contact
• Other data used in processing interactions, such as standard responses and 

screening rules.
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Your Multimedia installation (as part of the Universal Contact Server 
installation package) includes scripts for setting up the database (Microsoft 
SQL Server, Oracle, and DB2 are supported). Universal Contact Server 
Manager provides a user interface for setting data-archiving and pruning 
functions.

Workflow Control
The components illustrated in Figure 3 handle workflow control.

Figure 3: Workflow Control Components

Not shown in Figure 3 are other required Genesys Management Framework 
components, such as Configuration Server and the Management Layer.
The workflow control components fall into three groups, described in the 
following sections.

Interaction Server

Interaction Server is the central interchange for interaction flow.
• It receives interaction operational data from the media interface.
• It stores the operational data in a cache (a database) while receiving and 

transmitting information about the interaction. This cache also contains 
queues through which the interaction passes as part of its processing.

• It works in concert with the Routing components to route interactions 
according to interaction workflows and routing strategies (see the 
“Routing” section).

• It provides the means for agents to log in and indicate readiness.
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Routing

Routing components include the following:
• Interaction Routing Designer (IRD) and Universal Routing Server 

(URS) design and execute routing strategies, which trigger functions such 
as automatic responses and screening; apply logic (segmentation and 
conditional branching) to the flow; and ultimately deliver the interaction to 
an agent or other target. Routing strategies are one of the two main types of 
objects used in interaction workflows (see the “Interaction Server” 
section).

• Interaction Design, a sub component of IRD, creates and displays 
Business Processes, which plot an overall path for interactions. Interaction 
workflows map a route for the interaction between contact center objects, 
principally queues and routing strategies (see the “Knowledge 
Management” section). Interaction workflows are executed by Interaction 
Server.

• Stat Server accumulates data about places, agents, and place/agent groups; 
converts the data into statistically useful information; and passes these 
calculations to other software applications. In particular, Stat Server 
provides information to URS about agents’ capacities in terms of the 
number of interactions, the media type of an interaction, and so on.

Knowledge Management

Genesys Knowledge Management is made up of the following:
• Classification Server, which applies screening rules when triggered to do 

so by a routing strategy. Screening rules are basic pattern-matching queries 
performed on interaction contents. The results of these queries can then be 
referred to by further routing strategy logic. In the Genesys Content 
Analyzer option (see below), Classification Server also applies models to 
categorize incoming interactions. Both screening rules and models are 
stored in the Universal Contact Server database.

• Training Server, which trains the system to recognize categories. It is 
active only in the Content Analyzer option (see below).

• Knowledge Manager, which is the user interface component for 
Knowledge Management. You use Knowledge Manager to:

Manage the Standard Response Library, which is a collection of ready-
made responses to common inquiries and topics.
Manage screening rules.
Manage categories, which are used to organize standard responses.

Genesys Content Analyzer is an optional enhancement to Knowledge 
Management, requiring a separate license. It uses natural language processing 
technology to analyze incoming interactions for assignment to the categories 
of the standard response category system. The statistical tools that enable this 
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analysis, called models, are built up and refined by Training Server as it 
processes collections of preclassified interactions. Setting up and scheduling 
these training sessions is another function of Knowledge Manager.
FAQ works with Genesys Content Analyzer to convert your category structure 
and standard responses into an Frequently Asked Questions (FAQ) list. You 
can either post the resulting list as text on your web site or use it as the source 
for an automatic question-answering facility.

Summary

To summarize interaction flow:
• At the highest level the flow is controlled by interaction workflows that 

Interaction Server executes.
• Each interaction workflow contains queues and routing strategies.
• Routing strategies may bring in other applications/components to apply 

processing to the interaction—for example, sending a transcription of the 
chat session to the customer.:

Send an acknowledgment or an automatic reply.
Apply a screening rule.
Apply content analysis (with Content Analyzer option only).
Forward or redirect the interaction.

Architecture
This section presents the architecture for Multimedia 7.6.1. Figure 4 shows the 
main Multimedia components. 

Figure 4: Multimedia Architecture
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Note: For simplicity, not all connections and details are included in Figure 4. 
For example, many components (including Web API Server) connect 
to Stat Server.

Interaction processing generally proceeds according to the type of interaction. 
The following sections describe how two of the most common interactions 
types (e-mail and chat) are processed.

Processing E-Mail
This section describes how e-mails are processed.
1. E-mail interactions arrive in one of two ways:

a. If the customer sends ordinary e-mail, the interaction arrives via the 
enterprise mail server.

b. If the customer sends e-mail from a web site (by filling out a web 
form), the interaction arrives via the Web API Server.

2. E-mail Server Java stores the body of the interaction in the Universal 
Contact Server database, and then sends operational data on the interaction 
to Interaction Server.

3. Interaction Server parks the interaction’s operational data in its cache and 
starts processing the data according to an interaction workflow.

4. What happens next depends on the interaction workflow and the routing 
strategies that it contains. The system may: 

Apply a screening rule.
Assign the interaction to one or more categories (if Content Analyzer is 
present).
Generate an automatic response.
Route the interaction to an agent’s desktop, possibly also sending an 
automatic acknowledgment to the customer.

A supervisor may intervene at various points as long as the interaction’s 
operational data remains in the Interaction Server’s cache and the 
interaction is not being actively worked on by the Routing components.

5. The agent receives the interaction.
6. The agent may then:

Simply reply to the interaction.
Reply making use of a standard response. With the Content Analyzer 
option, the interaction may have arrived already equipped with a 
category assignment and associated suggested response. Otherwise, the 
agent may search manually for a category with suggested response.
Transfer the interaction to another agent.
Produce a collaborative response by consulting with other agents.
Return the interaction to the system for further processing.
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7. When the agent or agents finally release the reply (typically to an 
Outbound queue in the Interaction Server cache), the interaction workflow 
may route it to a senior agent or supervisor for QA review. The reviewer 
decides whether to let the reply continue through the outbound part of the 
interaction workflow, return it to the agent for revision, or take other 
action.

Processing Web Media
This section describes how chat interactions are processed.
1. Chat interactions begin processing when the Web Client submits a 

customer’s chat request to Chat Server.
2. Chat Server creates a chat session and asks Universal Contact Server to 

create an interaction record.
3. Chat Server submits the interaction to Interaction Server.
4. Interaction Server places the interaction in its initial queue and begins 

processing it according to an interaction workflow. 
5. The interaction workflow and its component routing strategies may do 

various things, including sending a message to a customer prior to an agent 
actually handling the interaction, but eventually they select an agent who is 
available for chat sessions and send an invitation to that agent to participate 
in a chat session.

6. The agent accepts the invitation and connects to the chat session.
7. Agent and customer conduct a chat session.
8. The chat session ends.
9. Chat Server writes the content of the chat session to the Universal Contact 

Server database.
10. Any postprocessing occurs; for example, a transcript of the chat session is 

e-mailed to the customer.

Required Software Components
The components that you must have running to operate a Multimedia 7.6.1 
environment can be grouped into the following categories. In this list, when the 
item is a generic description it is followed in parentheses by a typical instance:
• Genesys components

Framework
Any third-party items that Genesys Framework requires, such as a 
database engine and databases to run with DB Server. (See the 
Genesys Supported Operating Environment Reference Manual for a 
list of supported databases.)

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
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Configuration Layer
Management Layer

Stat Server (from the Real-Time Metrics Engine)
Genesys Universal Routing (either an Enterprise Routing solution or a 
Network Routing solution)
Multimedia

Servers
Clients

• Web components
Web Server (such as Microsoft IIS)
Browser (such as Microsoft Internet Explorer)
Website content (Genesys supplies Web Client, a starter application 
that you can customize.)

• Java components
Java virtual machine (such as Java Runtime Environment or JRE)
Java web application container (such as Tomcat)

Notes: The 7.6.1 release of Genesys Multimedia supports only specific 
releases of Tomcat. Check the Genesys Supported Operating 
Environment Reference Manual for more information.
The Tomcat web application container requires the Java 
Development Kit (JDK), not just JRE.

• Other items
Database engine for Interaction Server and Universal Contact Server 
databases

How to Configure
You can configure Multimedia 7.6.1 in two ways:
• Using the wizards supplied with the software.
• Manually, using the following steps:

Creating objects in Configuration Manager, one for each Multimedia 
component.
Giving the objects the proper settings for options and other attributes.
Assigning the various connections that link components together.

Note: Whether you are deploying Multimedia exclusively to a Windows 
environment or to a Solaris, Linux, or AIX environment, Genesys 
strongly recommends that you use wizards to install and configure 
your Multimedia solution.

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
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Chapter 4, beginning on page 55, describes the configuration for various third-
party software components that Multimedia uses, such as Apache or 
Microsoft IIS for the web server. In your final deployment, you will of course 
substitute your own architecture (more or fewer hosts), settings (Configuration 
Layer Persons corresponding to actual agents in your environment), and third-
party applications (such as WebSphere, rather than Apache or Microsoft IIS).
Chapter 5, beginning on page 91, describes a model wizard deployment on a 
single Windows host, such as you might use in a lab configuration. (The model 
does not suggest a production environment.) The sample includes specific 
values for all settings.
Genesys Multimedia 7.6.1 supports Windows, Solaris, Linux, and AIX 
operating systems. The model installation uses a Windows environment. 
Deployment for Solaris, Linux, and AIX environments is similar; the 
differences are described in Chapter 7, beginning on page 153.
If you want to configure and install Multimedia 7.6.1 manually in a Windows 
environment, consult:
• Configuration Manager 7.6 Help for instructions on using Configuration 

Manager.
• This chapter, Chapter 1, beginning on page 21, and Table 7 on page 93 for 

a list of required components.
• Chapter 5, beginning on page 91, and each component’s configuration 

steps for the required connections between Multimedia components.
• Multimedia 7.6 Reference Manual for descriptions of all Multimedia 

options.

New in This 7.6.1 Release
This release includes the following new features:
• Knowledge Management 

You can select the language for standard response spell check. 
Screening rules can match the POP box from which the e-mail entered 
the Multimedia system, rather than the To address 
Attachments to standard responses can be viewed in the Standard 
Response Editor. 
Searching for standard responses can use additional attributes, such as 
active or not, approved or not, usage type, and others. 
In creating a training object, you have the option of selecting an agent 
group rather than individual agents. 

• Interaction Server 
Support for multiple agent desktops 
Ability to limit number of records in Snapshot query results 
Ability to add user fields to the Interaction Server database 
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Built-in scheduling in workflow 
Pre-routing segmentation of interactions for proportional queuing 
Event Logger storing reporting events 

• Platform support: IBM DB2 9.1. 
• Support for Windows Vista for Knowledge Manager and Universal 

Contact Server Manager.
• Support for Windows Vista for Interaction Workflow Samples and 

Multimedia Configuration Wizards.
• New components: Interaction Proxy Server and UCS Proxy Server. 
• E-mail Server Java: Support for internationalized domain names. 
• Web Collaboration

Support for Internet Explorer 7 and Red Hat Enterprise Linux 4.
Support for MSSQL 2005.

• Current supported version of KANA Response Live is now version 10 R1 
for Windows, and version 10 R2 for Solaris and Linux.

• Relevant new features of other Genesys products:
Support for Supervisor Desktop ability to take interactions that are 
being routed and removed them for redistribution. 
Exposure of field code rendering in .NET SDK. 
When a field code in a standard response returns an empty result, you 
can have the desktop display the field code source code rather than 
nothing. 
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2 Deployment Task Flow
This chapter guides you through the various actions you must take to plan, 
deploy, and test your Multimedia solution.
You can find task flow information for the following operating systems:

Windows Deployment Task Flow, page 31
UNIX Deployment Task Flow, page 34

Windows Deployment Task Flow
This task flow describes a model setup of a blended (e-mail and chat), single-
tenant Multimedia solution deployed on a single Windows host machine, such 
as might be deployed in a lab setting. Complete these actions in the following 
order to deploy your solution.

Table 1: Task Flow for Windows Deployment

Objective Related Procedures and Actions

1. Plan your deployment. 1. Choose which machines will host Multimedia and various 
third party components. For a sample architecture layout, 
see “Component Distribution” on page 38.

2. Choose which machines will host your databases. To help 
calculate the rough size of your databases, use the 
formulas in “Estimating Database Size” on page 39.

3. Print out and complete the Configuration Worksheet 
(Table 3 on page 43) with values that fit your deployment.

2. Complete all prerequisite actions. 1. Verify that all prerequisite components are in place. See 
Table 7 on page 93.

2. “Create Host” on page 94.
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2. Complete all prerequisite actions. 
(continued)

3. For deployments across multiple machines, see “Create a 
Shared Directory” on page 94.

4. If you have already installed KANA Response Live, you 
must stop it from running as a service. For more 
information, see “Remove the KANA Response Live Start 
Service” on page 94.

5. “Create Contact, Interaction (and Co-Browsing) 
Databases” on page 95.

3. Install and configure third-party 
software for processing Web-
based interactions (chat and web 
e-mail).

Install, connect, and/or configure components that enable web 
services. Use one of the following web server/application 
container combinations.

Apache and Tomcat
For an Apache/Tomcat combination, complete these steps:
1. Downloading and installing the Java SDK, page 56.
2. Installing the Apache Web Server on Windows, page 57
3. Installing the Tomcat web application container on 

Windows, page 59
4. Installing the JK1 Connector with Apache, page 63

IIS and Tomcat
For an IIS/Tomcat combination, complete these steps:
1. Installing the Tomcat web application container on 

Windows, page 59
2. Installing the JK1 Connector with IIS, page 65

IIS and JRun
This guide does not provide detailed procedures for this 
configuration. Refer to the documentation from the relevant 
vendors for more information.

4. Install and configure third-party 
software for co-browsing *

*Skip this step if you are not using co-
browsing functionality.

To use Genesys co-browsing, install and configure the KANA 
Response Live Server.
See Table 6 on page 75 for the deployment task flow.
1. Installing KANA Response Live for Windows, page 78
2. Configuring KANA Response Live for Windows, page 80
3. Testing the KANA Response Live installation on 

Windows, page 82
4. Launching a co-browsing session, page 87

Table 1: Task Flow for Windows Deployment (Continued) 

Objective Related Procedures and Actions
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5. Configure Multimedia objects. 1. Installing the Multimedia Configuration Wizards, page 96.
2. Create sample workflows for routing simple test 

interactions through the contact center to an agent. See 
Installing and Starting Interaction Workflow Samples, 
page 96.

3. Configure Multimedia objects for installation. See 
Configuring Multimedia objects using the wizard, 
page 98.

4. Specify the web-api port for Chat Server, for dedicated 
communication with Web API Server. See Specifying a 
webapi-port for Chat Server, page 129.

6. Install Multimedia components Performing an integrated installation of all Multimedia 
servers, page 131
Note: For deployments across multiple hosts, you need to 
launch the Integrated Installation one time for each host.

7. Verify connections 1. Double-check that the connections you made with the 
configuration wizard are in place. For a list of necessary 
connections, see Table 4 on page 52.

2. From Configuration Manager, add a connection from Stat 
Server to Interaction Server. Stat Server uses this 
connection to find and route interactions to available 
Multimedia agents.

For more information, see Verifying connections, page 137.

8. Modify your databases to process 
interactions

Running scripts for your databases, page 136

9. Test the components 1. Testing the Multimedia servers, page 138
2. Testing the components using the Web-based 

TestTool761, page 139
Testing that Genesys Desktop can handle interactions, 
page 140

10. Test the setup 1. Configuring ABC Simple BP for routing e-mail 
interactions, page 141

2. Configuring ABC Simple Chat BP for routing chat 
interactions, page 142

3. Sending a test e-mail to a Desktop agent, page 142
4. Starting a test chat session with a Desktop agent, page 143
5. Sending a test web form e-mail to a Desktop agent, 

page 144

Table 1: Task Flow for Windows Deployment (Continued) 

Objective Related Procedures and Actions
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UNIX Deployment Task Flow
For Solaris, AIX, or Linux deployments, Genesys recommends that you use 
the Multimedia Configuration Wizards on a Windows host to configure and 
install components to other hosts. Complete the actions in the following order 
to deploy your solution.

Table 2: Task Flow for Solaris/AIX/Linux Deployment

Objective Related Procedures and Actions

1. Prepare your environment. 1. Define an environment variable for your Multimedia 
directory.
GES_HOME_761

2. Create a shared directory on your UNIX host that your 
Windows host can access.
OR
Create a shared directory on the Windows host that your 
UNIX hosts can access.

3. If you have already installed KANA Response Live, 
you must stop it from running as a service. Use the 
following command:
rm -f /etc/rc2.d/S88hipctl

4. Create your databases.

2. Configure Multimedia objects for 
installation

Launch the Multimedia Configuration Wizard from a 
Windows host to configure the components that will run in 
the Solaris, Linux, or AIX environments. 
1. Installing the Multimedia Configuration Wizards, 

page 96
2. Installing and Starting Interaction Workflow Samples, 

page 96
3. Configuring Multimedia objects using the wizard, 

page 98

3. Install Third Party Components On each host where you plan to install components, run the 
Third Party Components installation package from the 
following directory:
<platform>\ThirdPartyComponents

Note: For an explanation of the difference between Third 
Party Components and ThirdPartyApplications, see the note 
on page 55.

4. Install the Multimedia components Run the installation package for each remaining component:
<component>\<platform>
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5. Install and configure third-party 
software for processing Web-based 
interactions

Install, connect, and/or configure components that enable 
web services. Use one of the following web 
server/application container combinations.

Solaris—WebLogic Web Application
1. Deploying Genesys web applications for WebLogic, 

page 170
2. Checking your WebLogic configuration file, page 171
3. Deploying your web applications, page 172
4. Testing the WebLogic installation and deployment, 

page 175

Solaris—Apache and Tomcat
• Obtaining Apache documentation from the CD, page 72
• Obtaining Tomcat documentation from the CD and the 

Web, page 73

Solaris—WebSphere Web Application
1. Deploying WebSphere on Solaris, page 160
2. Testing the WebSphere installation on AIX or Solaris, 

page 169

AIX—WebSphere Web Application
1. Deploying WebSphere on AIX, page 157
2. Testing the WebSphere installation on AIX or Solaris, 

page 169

Linux—Apache and Tomcat
1. Obtaining Apache documentation from the CD, page 72
2. Obtaining Tomcat documentation from the CD and the 

Web, page 73

Table 2: Task Flow for Solaris/AIX/Linux Deployment (Continued) 

Objective Related Procedures and Actions
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6. Install and configure third-party 
software for co-browsing. (Solaris 
and Linux only)

To use Genesys co-browsing, install and configure the 
KANA Response Live Server.
See Table 6 on page 75 for the deployment task flow.
Solaris or Linux
1. Installing KANA Response Live for Solaris, page 83
2. Installing KANA Response Live for Linux, page 84
3. Creating the KANA database schema on Solaris or 

Linux, page 85
4. Configuring KANA Response Live for Solaris or Linux, 

page 86
5. Testing the KANA installation on Solaris or Linux, 

page 86
6. Launching a co-browsing session, page 87

Table 2: Task Flow for Solaris/AIX/Linux Deployment (Continued) 

Objective Related Procedures and Actions
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3 Deployment Planning
This chapter describes, in general terms, how to plan an effective deployment 
process for Multimedia 7.6.1. It covers these topics:

Overview, page 37
Component Distribution, page 38
Estimating Database Size, page 39
Configuration Worksheet, page 41
Connections Table, page 52

For further information about specific issues, see also the “Ongoing 
Administration and Other Topics” chapter of the Multimedia 7.6 User's Guide.

Note: Genesys recommends that you configure Multimedia using the wizards 
provided with it and that, for Windows deployments, you install it 
using the integrated installation package. These utilities configure and 
install all Multimedia components

Overview
Chapter 5, beginning on page 91, and Chapter 7, beginning on page 153, 
describe deployment in detail. Before beginning the deployment process there 
are several things you can think about and do to make the process easier.
Genesys recommends that you configure Multimedia using the wizards 
provided with it and that, for Windows deployments, you install it using the 
integrated installation package. These utilities configure and install all 
Multimedia components.
This chapter provides general information on deployment planning. For further 
information about specific issues, see also the “Ongoing Administration and 
Other Topics” chapter of the Multimedia 7.6 User’s Guide.
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Component Distribution
Genesys recommends that you divide Multimedia and associated components 
among several host machines. See Figure 5 for a sample architecture.

Figure 5: Sample Architecture for a Single-Tenant Multimedia Deployment

When choosing host machines for your Multimedia deployment, keep the 
following recommendations in mind:
• Keep web servers for different applications on separate machines. For 

example, Kana Response Live server installs its own instance of the 
Apache Tomcat application container, which you should keep separate 
from the Apache Tomcat used for Web API Server (according to the 
procedures available in this guide).

Multimedia Core Components Databases

Multimedia User Interfaces

Co-Browsing Components

host network

Web API Server

Windows Server
(one of the following)
• Apache and Tomcat
• IIS and Tomcat
• IIS and JRun

Solaris Server
(one of the following)
• Apache and Tomcat
• IBM WebSphere
• BEA WebLogic

AIX Server
• IBM WebSphere

Linux Server
• Apache and Tomcat

Windows or Solaris Server
• Genesys Co-Browsing Server
• Kana Response Live Server 

(requires separate application 
container from Web API Server)

Windows or Unix
• Interaction Server cache
• Universal Contact Sever database

Windows
• Interaction Routing Designer
• Knowledge Manager
• UCS Manager

Windows or Unix Server
• Interaction Server (with separate 

installation of DB Server )
• Universal Contact Server
• E-mail Server Java
• Chat Server

and Third-party Web Components
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• Install Multimedia graphical user interface (GUI) applications on Windows 
hosts only. These GUI applications include:

Knowledge Manager
Universal Contact Server Manager
Interaction Workflow Samples

• Based on the load and nature of contact center media (e-mail, chat, or 
blended), you might need to deploy the following components on separate 
machines:

Universal Contact Server
E-mail Server Java
Chat Server

For information about distributing Multimedia components across multiple 
hosts for load-balancing purposes, see the “Load Balancing and Backup 
Configuration” chapter of the Multimedia 7.6 User’s Guide.

• You should also deploy the corporate mail server on a separate computer.

Estimating Database Size
This section suggests some ways of estimating the size of the Universal 
Contact Server (UCS) and Interaction Server databases. Please keep in mind 
that these are rough estimates only. The size of a database file on a hard drive 
depends on a number of factors other than the number of interactions it 
contains. For example:
• The size of a database file can vary according to the DBMS platform you 

are using.
• Interactions are not uniform in size. An e-mail may be as small as 4 KB or 

it may be 200 KB or more. Also, interactions can include attachments, 
which can increase size greatly.

Note: You can configure Universal Contact Server Manager to automatically 
archive and/or prune old messages to keep this database to a 
manageable size. See Multimedia 7.6 Universal Contact Server 
Manager Help for more information.

Beginning in 7.6.1, Event Logger functionality can be implemented. This 
feature requires its own database. For more information on Event Logger, 
including creating the database, refer to the “Event Logger” section in the 
“Interaction Server: Advanced Topics” section of the “Ongoing Administration 
and Other Topics” chapter of the Multimedia 7.6 User’s Guide.
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Procedure:
Estimating UCS database size for e-mail interactions

Start of procedure

1. Multiply the number of interactions expected each day by the number of 
days you want to keep the interactions.

2. Multiply the result by 25 KB (estimating 20 KB for the message body and 
5 KB for headers, comments, and indexes).
For example
If you anticipate 100 incoming interactions per day and you want to keep 
90 days’ worth of history, reserve 100 x 90 x 25 KB or 225 MB of disk 
space.

Note: Though the average interaction will probably be less than 25 KB in 
size, this is a reliable estimate of the amount of disk space required 
for contact and history records

3. Add 1 KB for each related contact in the database. So for 100,000 contacts, 
allow 100 MB for the database.

End of procedure

Next Steps

• Estimating UCS database size for chat interactions

Procedure:
Estimating UCS database size for chat interactions

Start of procedure

1. Multiply the number of chat interactions expected each day by the number 
of days you want to keep the interactions. 

2. Multiply the result by 5 KB.
For example
If you anticipate 1000 incoming chat interactions per day, and you want to 
keep 90 days’ worth of history, reserve 1000 x 90 x 5 KB, or 450 MB of 
disk space. 

3. Add 1 KB for each related contact in the database. So for 100,000 contacts, 
allow 100 MB for the database.

End of procedure
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Next Steps

• Estimating the size of the Interaction Server database

Procedure:
Estimating the size of the Interaction Server database

Start of procedure

1. Use the following formula:
(3.5 +d)m = x KB
Where:
• 3.5 KB is the size of system data and business properties (also called 

operational data). See the initialization script for the particular limit for 
each property.

• d is the size, in KB, of attached user data. Attached data is normally 4 
KB or less, but it may be more. Multimedia imposes an upper limit on 
the size of attached user data written in the logs. However, there is no 
limit set for the total amount of attached data that Interaction Server 
has to process.

• m is the expected maximum number of active interactions. In choosing 
this number for Genesys E-mail, take into consideration the large 
number of e-mails that may build up during off hours or system 
malfunctions.

End of procedure

Next Steps

• Completing the configuration worksheet

Configuration Worksheet
Before you begin deployment, it is helpful to assemble information that the 
configuration wizards will require you to supply. 

Tip: For more information about limits, see the Multimedia 7.6 User’s 
Guide.

Tip: For example, if you limit attached user data to 64 KB and you 
expect a maximum of 10,000 active interactions, allow about 700 MB 
for the database.
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Use the following worksheet (see Table 3) to plan your Multimedia 
deployment. After filling out the worksheet you are ready to start the 
configuration wizards. 
This worksheet lists:
• Values (mostly Application object names and port numbers) that the 

wizards ask you to invent. You can invent them ahead of time in case you 
want to incorporate some systematically (for example, you may want all 
Application object names to start with a certain prefix, or you may want 
port numbers to be consecutive or to all start with the same two digits).

• Model Setup Values used during our model deployment. These provide a 
reference to help you during the deployment procedures.

• Names (or other attributes) of non-Multimedia objects that the wizards ask 
you to enter. Some of these are likely to exist already. Of those which do 
not, you can create them before, after, or (in some cases) while running the 
Multimedia Wizard. Here are two examples:

Multimedia requires several databases (tablespaces): one for 
Interaction Server, two for UCS, and one for Co-Browsing Server (if 
you plan on deploying it). See “Databases and Associated 
Configuration Objects” on page 44 for more information.
Multimedia requires a Person or Access Group object that UCS can use 
to log in to Configuration Server (see “Login account” on page 46).

The wizards also ask you to select some items from a list. This worksheet does 
not list most items of this type, but they are described in Chapter 5, beginning 
on page 91.

Procedure:
Completing the configuration worksheet

Purpose:  To provide a printable reference sheet that lists all the parameters 
required to deploy a Multimedia solution.

Start of procedure

1. Print out Table 3.
2. Add deployment information for your environment in the Your Value 

column.
3. Keep a copy of this worksheet with you during the deployment process.

End of procedure

Next Steps

• If you already have a web server and servlet for Web API Server installed, 
continue with Chapter 5 on page 91.
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• If you still need to install a web server and servlet, before you start the 
configuration of Multimedia objects, continue with: 

Windows Chapter 5 on page 91

UNIX Chapter 7 on page 153

Table 3: Configuration Worksheet

Field Value Model Setup Value Description

Log In to Wizard Manager

User name User name for logging in to 
Configuration Server

User password Password for logging in to 
Configuration Server

Application Configuration Server 
Manager Application object 
name

Host Host of Configuration Server

Port Port on Configuration Server 
host where Configuration 
Server listens for queries

Solution

Name MM761 Invent a name for your 
Multimedia solution.

Tenant (in multi-tenant environment)

Name Name of the Tenant object 
holding the Multimedia 
solution that you are 
configuring.
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Databases and Associated Configuration Objects
Note: Before installing Multimedia, you must configure and install a DBMS and create four 
databases/tablespaces, one for Interaction Server, two for Universal Contact Server (one main, one 
archive), and one for Co-Browsing Server (if you plan on deploying it). You can do this before or after 
running the Multimedia Wizard. 

Interaction Server Database Objects

Database Access Point (DAP)

DAP Name MM761_Ixn_DAP Invent a name for the DAP to 
use with Interaction Server.
If you intend to use the Event 
Logger functionality that is 
available in version 7.6.1, you 
will need another DAP. 
Configuration and 
deployment of Event Logger 
is explained in the “Event 
Logger” section in the 
“Interaction Server: 
Advanced Topics” section of 
the “Ongoing Administration 
and Other Topics” chapter of 
the Multimedia 7.6 User’s 
Guide.

DB Server

Name MM761_IxnDBServer Name of the DB Server 
application object.

DBMS type Microsoft SQL Server Type of database management 
system you are using 
(Microsoft SQL, Oracle, 
DB2).

Host MMHost Host where you want DB 
Server installed.

Port 6110 Port where DB Server listens 
for queries.

SNMP Port Not included in the model 
setup.

Port where DB Server listens 
for management commands 
(optional).

Table 3: Configuration Worksheet (Continued) 

Field Value Model Setup Value Description
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DBMS name MMHost Name of your database 
management system.

DBMS type Microsoft SQL Server Type of database management 
system you are using 
(Microsoft SQL, Oracle, 
DB2).

Database 
name

IxnDB Name of the database 
(tablespace) for Interaction 
Server.

User name sa User name for logging in to 
the DBMS.

Password <password for user sa> Password for logging in to the 
DBMS.

Universal Contact Server (UCS) Database Objects

DB Server

Not needed because UCS uses JDBC to connect with the database.

Database Access Point (DAP)

DAP name MM761_UCS_DAP Invent a name for the DAP to 
use with UCS.

Host MMHost Host name where database is 
running.

Port 1433 Port where the database 
listens for queries (for 
example, 1521 is the default 
for Oracle, 1433 for Microsoft 
SQL, 50000 for DB2).

DBMS type Microsoft SQL Server Type of database management 
system you are using 
(Microsoft SQL, Oracle, 
DB2).

Database 
name

Customer Name of the database 
(tablespace) for UCS.

User name sa User name for logging in to 
the DBMS.

Table 3: Configuration Worksheet (Continued) 

Field Value Model Setup Value Description
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Password <password for user sa> Password for logging in to the 
DBMS.

Universal Contact Server

Name MM761_UCS Invent a name for your UCS 
Application object.

Host MMHost Host where you want UCS 
installed.

Port 6120 Listening port for requests.

Universal 
Contact Server 
API port

Default port value Port for Remote Method 
Invocation (RMI) connection 
to the UCS API. Must be 
different from standard server 
port.

Login account Not specified for the 
model setup. See the 
description, and choose a 
Person or Access Group 
accordingly.

The User Account (Person) or 
Access Group that UCS will 
use to log in to Configuration 
Server.
Note: This Person or Access 
Group must have 
Administrator or higher 
access rights so it can update 
information in the 
Configuration Database. Use 
an existing account with these 
rights or create one for the 
purpose.

Multimedia Switch

Name In the model setup, we 
select New-Style 
Interaction Server, which 
creates a Multimedia 
switch and switching 
office automatically in 
the background.

Select or create a multimedia 
switch. 
Note: Include only one 
multimedia switch per tenant 
to preserve Stat Server and 
URS support for Interaction 
Server.

Table 3: Configuration Worksheet (Continued) 

Field Value Model Setup Value Description
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Switching Office

Name In the model setup, we 
select New-Style 
Interaction Server, which 
creates a Multimedia 
switch and switching 
office automatically in 
the background.

Select or create a switching 
office.

Interaction Server

Name MM761_IxnSrv Invent a name for your 
Interaction Server Application 
Object.

Host MMHost Host where you want 
Interaction Server installed.

Port 6130 Port where Interaction Server 
listens for queries.

Stat Server

Name In the model setup, we 
select the existing, 
properly configured 
prerequisite Stat Server.
See Table 7 for details.

Select or create a Stat Server.

Host Host of Stat Server.

Port Port where Stat Server listens 
for queries.

Application Cluster (optional)

Name Model setup does not use 
the Application Cluster.

Invent a name for your 
Application Cluster.

Web API Server

Name MM761_WebAPIServer Invent a name for your Web 
API Server Application 
Object.

Host MMHost Host where you want Web 
API Server installed.

Table 3: Configuration Worksheet (Continued) 

Field Value Model Setup Value Description
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Port 80 Port for web server (defaults 
are 80 for HTTP, 443 for 
HTTPS); used for load 
balancing between web 
clients. This assumes that the 
web clients and Web API 
Server are installed on the 
same host. 

Web Compound Samples

Name MM761_WebClient Invent a name for your Web 
Compound Samples.

E-mail request 
preferences

Not included in the model 
setup.

The address from which 
replies to web e-mail requests 
will be sent.

Tenant Name of the Tenant object 
holding the Multimedia 
solution that you are 
configuring.

UCS Manager

Name MM761_UCSMgr Invent a name for your UCS 
Manager Application Object.

E-Mail Server Java (for Genesys E-mail)

Name MM761_E-mailServer Invent a name.

Host MMHost Host where you want E-mail 
Server Java installed.

Port 6150 Listening port for requests

POP server MMHost The name of your corporate 
POP server.

SMTP server MMHost The name of your corporate 
SMTP server if different from 
the POP server.

POP3 user 
name and 
password

Not specified in the 
model setup. Use valid 
user information for your 
corporate mail server.

Address, user name and 
password for logging on to 
your POP server.

Table 3: Configuration Worksheet (Continued) 

Field Value Model Setup Value Description
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Default e-mail 
address domain

MMHost Domain to be appended to 
e-mail (both incoming and 
outgoing) that does not 
already have a domain 
specified in its To address 
field.

External agent 
e-mail address

external@MMHost Address to be used as the 
From address in messages to 
external agents and as the To 
address in messages from 
external agents. Typically, this 
is different from your general 
corporate e-mail addresses.

Integrated Web 
Form 
processing port 
(optional)

7777 Listening port number for 
Web Form–processing entry 
point.

Automated 
Reply Agent

Agent1 Notional agent name used in 
automatic responses. 
Typically this is something 
generic like Genesys 
Technical Support.

E-mail 
account(s) for 
customer 
access

<mailboxName1>@MM
Host
<mailboxName2>@MM
Host

Account name and e-mail 
address. These are the 
accounts on your corporate 
POP server that E-mail Server 
Java will pull e-mails from 
and bring them into the 
Multimedia system. Be sure 
to also create them on your 
corporate mail server if they 
do not exist already.

Table 3: Configuration Worksheet (Continued) 

Field Value Model Setup Value Description
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Classification Server

Name MM761_ClassificationSe
rver

Invent a name.

Host MMHost Host where you want 
Classification Server 
installed.

Port 6160 Listening port for requests.

Training Server

Name MM761_TrainingServer Invent a name.

Host MMHost Host where you want Training 
Server installed.

Port 6170 Listening port for requests.

Knowledge Manager

Name MM761_KnowledgeMan
ager

Invent a name.

Chat Server (for Genesys Web Media)

Name MM761_ChatServer Invent a name.

Host MMHost Host where you want Chat 
Server installed.

Port 6180 Listening port for requests.

Webapi-port 
(recommended)

6181 A specific port for web client 
connections only.

ESP Server 
Port

6182 Listening port for ESP 
requests.

ESP default 
nickname

system Name to be used in place of 
agent’s name for use in 
automated chatting.

Co-Browsing Server

Name MM761_Co-
BrowsingServer

Invent a name.

Table 3: Configuration Worksheet (Continued) 

Field Value Model Setup Value Description
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Host MMHost2 Host on which you want 
Co-Browsing Server installed.

Port 6195 Listening port for requests.

Co-Browsing 
Server alias

Invent a four-character name.

Co-Browsing Server Database Access Point (DAP)
Note: If you use the UCS DAP for Co-Browsing Server as well, this is not needed. Genesys does not 
recommend using the same DAP.

DAP name In the model setup, we 
use the UCS DAP and 
Database for Co-
Browsing Server.

Invent a name for the DAP to 
use with Co-Browsing Server.

Host Host name where database is 
running.

Port Port where the database 
listens for queries (for 
example, 1521 is the default 
for Oracle, 1433 for Microsoft 
SQL, 50000 for DB2).

DBMS type Type of database management 
system you are using 
(Microsoft SQL, Oracle, 
DB2).

Database 
name

Name of the database 
(tablespace) for Co-Browsing 
Server.

User name User name for logging on to 
the DBMS.

Password Password for logging on to 
the DBMS.

Table 3: Configuration Worksheet (Continued) 

Field Value Model Setup Value Description
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Connections Table
Table 4 on page 52 lists connections that you set in the Configuration Layer for 
Multimedia components.
In addition to the information in Table 4, keep in mind that:
• Connections to Message Server are required only if you are running 

Multimedia 7.6.1 with the Management Layer.
• A Local Control Agent (LCA) runs on each host. All Genesys components 

on a host connect to the local LCA. Refer to the Framework 7.6 
Deployment Guide for details on configuring LCAs.

• For Reporting purposes, you must also add a connection from your 
Reporting Stat Server to the Interaction Server.

Note: It is possible to have multiple connections to some components. These 
components are marked with a *. For information about how and why 
you use multiple connections, please see the “Load Balancing and 
Configuration” chapter of the Multimedia 7.6 User’s Guide.

Table 4: Multimedia Application Connections

Application Connects to

Chat Server Interaction Server
Message Server
Universal Contact Server

Classification Server Message Server
Universal Contact Server

E-mail Server Java Interaction Server
Message Server
Universal Contact Server

Interaction Server Chat Server*
Classification Server*

E-mail Server Java*

Interaction Server DAP*

Message Server
Stat Server (for reporting)*

Universal Contact Server*
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Knowledge Manager Universal Contact Server

Training Server Message Server
Universal Contact Server

Universal Contact Server Message Server
Stat Server*

UCS DAPs

Universal Contact Server 
Manager

Universal Contact Server

Co-Browsing Server JDBC-based DAP
Message Server

Web API Server Application Cluster*
Chat Server*
Co-Browsing Server
E-mail Server Java*
Interaction Server
Message Server 
Solution Control Server
Stat Server*
Universal Callback Server*
Universal Contact Server*
Web API Servera

a. If this Web API Server is acting as a load balancer for other Web API Servers.

Table 4: Multimedia Application Connections (Continued) 

Application Connects to
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4 Deploying Third-Party Web 
Applications
A web server and a web application container are prerequisites for deploying 
Multimedia. Your environment may already have its own established 
configuration of these components. This chapter describes the steps you must 
take to install and configure common combinations of these applications, 
including the Apache Web Server and the Apache Tomcat web application 
container in Windows, Linux, and Solaris environments, as well as the initial 
setup for WebSphere in an AIX environment. Be sure to check the Genesys 
Supported Operating Environment Reference Manual for the supported 
versions of the third-party software you are using. This chapter includes these 
sections:

Java Software Development Kit, page 56
Installing Apache and Tomcat on Windows, page 57
Connecting Tomcat and Its Web Server, page 63
Configuring Apache and Tomcat for Linux or Solaris, page 72
Deployments with WebSphere on AIX or Solaris, page 73
Deploying KANA Response Live for co-browsing, page 74

Note: It is important to distinguish Third Party Components from third-party 
applications.

Multimedia Third Party Components—refers to a collection of files, 
mostly Java libraries, that Multimedia uses for its normal operation. 
Third Party Components are included in the integrated install, as 
described in Performing an integrated installation of all Multimedia 
servers, page 131. The Third Party Components installation package 
places these files in various locations on the host machine.
ThirdPartyApplications—refers to a directory on the Multimedia 
product CD that contains the web server Apache, the application 
container Tomcat, and various supporting files. Multimedia requires a 

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
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web server and an application container, but Apache and Tomcat are 
not the only supported types, and you are not required to install the 
particular copies in this directory; they are provided as a convenience.

Java Software Development Kit

Procedure:
Downloading and installing the Java SDK

Purpose:  This procedure describes how to download and install the Java SDK.

Start of procedure

1. Determine the correct Java software development kit (SDK) for your 
system. For supported releases of Java SDK on Windows, Solaris, Linux, 
and AIX systems, see the Genesys Supported Operating Environment 
Reference Manual.

2. Select one of the URLs from the list below, according to your system. 
Paste the URL into your browser, replacing <release_number> with 1.5.0, 
or the supported release number that you found in Step 1.

3. Make sure the JAVA_HOME environment variable points to the directory 
where Java SDK is located. For example, on Solaris it might be this path:
JAVA_HOME=/usr/local/jdk1.5.0_11

export JAVA_HOME

Or for Windows, set the JAVA_HOME environment variable to something like 
c:\jdk1.5.0_11

End of procedure

Tip: Multimedia 7.6.1 supports JDK 5.0, which uses the extended 
version number format of 1.5.0.

Solaris http://java.sun.com/j2se/<release_number>/install-solaris.html

Linux http://java.sun.com/j2se/<release_number>/install-linux.html

Windows http://java.sun.com/j2se/<release_number>/install-windows.html

AIX http://www-1.ibm.com/support/docview.wss?rs=180&context=SSE
QTP&uid=swg24006713

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
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Next Steps

• If you are deploying the Apache HTTP server and Tomcat Application 
Container on a Windows platform, see Installing Apache and Tomcat on 
Windows, page 57.

• If you are deploying the Apache HTTP server and Tomcat Application 
Container on a Solaris or Linux platform, see Configuring Apache and 
Tomcat for Linux or Solaris, page 72.

Installing Apache and Tomcat on Windows
This section describes procedures for installing the Apache Web Server and the 
Tomcat web application container in a Windows environment. The installation 
packages for both Apache and Tomcat are included on your Multimedia 7.6.1 
CD.
If you are using Microsoft’s Internet Information Server (IIS) as your web 
server, skip the instructions for installing Apache, proceed to the Tomcat 
instructions, and then use the steps in “Setting Up the JK1 Connector with IIS 
5 or 6” on page 65 for further configuration details.

Apache
Genesys provides the Apache Web Server with your Multimedia software. 
Look for it in the third-party applications portion of the installation CDs.

Procedure:
Installing the Apache Web Server on Windows

Purpose:  This procedure outlines how to install the Apache Web Server on 
Windows.

Start of procedure

1. Shut down any other web servers (such as IIS) on the machine where 
Apache is to run.

2. On the Interaction Management CD, go to the directory 
ThirdPartyApplications\Apache<release_number>\Windows\binary. Find 
and double-click apache_<release_number>-win32-x86-no_ssl-r2.msi.

3. Click Next at the Welcome window.
4. Accept the license agreement, and click Next.
5. Click Next at the Read This First page.
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6. At the Server Information prompt, enter the following information:
a. Network domain
b. Server name

Note: Servers may have an external name that differs from the internal 
name. Be sure to use the right name for your situation.

c. Administrator’s e-mail address.
d. Choose whether to run as a service. Keep the default if you want 

Apache running as a service; otherwise select the radio button to 
manually start and stop Apache. Click Next to continue.

7. Choose a typical or custom install.
8. Choose a destination folder. Genesys recommends that you use a short path 

name, such as C:\ApacheGroup.

Warning! Do not include any spaces in the folder name (for example, use 
ApacheGroup instead of Apache Group).

9. Click Install. The Installation Wizard uses the settings you specified to 
install and configure Apache.

10. Click Finish. The installation is complete.

Note: Throughout this document, <APACHE_HOME> represents the folder you 
define here for your Apache installation. During installation, a sub-
folder named Apache2 may be created. If this is the case, <APACHE_HOME> 
represents the folder you define here as well as the sub-folder Apache2 
(C:\ApacheGroup\Apache2).

End of procedure

Next Steps

• If you plan on using Genesys Web Collaboration (Co-Browsing Server), 
you need to implement a Secure Socket Layer (SSL) for your web server. 
See Installing a new SSL certificate using IIS, page 76.

• Otherwise, proceed with Testing the Apache Web Server on Windows.
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Procedure:
Testing the Apache Web Server on Windows

Start of procedure

1. From the Windows taskbar, select Start > Programs > Apache HTTP Server 
<release_number> > Control Apache Server > Start.

Note: If Apache is already running, then the Start command displays an 
error message. Continue with Step 2 to confirm that Apache is 
running correctly.

2. Open a web browser and go to Apache’s host 
(http://<servername_or_IP>:80). If Apache is running correctly, you will 
see a white page with the message It works!

End of procedure

Next Steps

• Installing the Tomcat web application container on Windows, page 59

Tomcat
Genesys provides the Tomcat web application container with your Multimedia 
software. Look for it in the ThirdPartyApplications folders of the installation 
CDs.

Note: The 7.6.1 release of Genesys Multimedia supports only specific 
releases of Tomcat. Check the Genesys Supported Operating 
Environment Reference Manual for more information.

Procedure:
Installing the Tomcat web application container on 
Windows

Start of procedure

1. On the Multimedia Interaction Management CD, go to the directory 
ThirdPartyApplications\Tomcat_Servlet<release_number>\

Windows\binary. Find and double-click apache-tomcat-
<release_number>.exe.

2. At the Welcome to the Apache Tomcat Setup Wizard window, click Next.

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item


60 Multimedia 7.6

Chapter 4: Deploying Third-Party Web Applications Installing Apache and Tomcat on Windows

3. Click I Agree to accept the license agreement.
4. At the Installation Options window, select Full from the Select type 

of install drop-down list (see Figure 6 on page 60). 

Figure 6: Tomcat Installation Options

5. Click Next to continue.
6. At the Choose Install Location window, enter a path to your Tomcat 

installation location, and click Next.

Warning! Do not include any spaces in the folder name (for example, use 
Tomcat6 instead of Tomcat 6).

7. Specify the HTTP/1.1 Connector Port and Administrator Login details for 
your Tomcat installation, and click Next.

8. Confirm the location of your Java SDK, and click Install. The Installation 
Wizard uses the settings you specified to install and configure Tomcat.

9. Click Finish. The installation is complete.
10. Verify the values of the following environment variables (Start/My 

Computer/Properties/Advanced/Environment Variables), or create them if 
they do not already exist:

CATALINA_HOME—Your Tomcat installation directory.

Tip: For the HTTP/1.1 Connector Port, you can use the default value of 
8080.
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JAVA_HOME—Your JDK base directory, as described under “Java 
Software Development Kit” on page 56.

Note: Throughout this document, <CATALINA_HOME> represents the base 
directory of your Tomcat installation.

End of procedure

Next Steps

• Testing the Tomcat installation on Windows.

Procedure:
Testing the Tomcat installation on Windows
If they exist, you should always start and stop Tomcat using the batch files 
<CATALINA_HOME>\bin\startup.bat and <CATALINA_HOME>\bin\shutdown.bat. 
Using shutdown.bat to stop Tomcat stops the executable and also closes 
various files that would otherwise remain open.
If there are no batch files, use the Tomcat Monitor (visible as an icon in the 
system taskbar) to start and stop Tomcat.

Start of procedure

1. Verify that Apache is already running.
2. Start Tomcat using <CATALINA_HOME>\bin\startup.bat. If Tomcat is 

running correctly, you will see a console window (see Figure 7).

Tip: You can find an icon for the Tomcat Monitor in the system taskbar:

To start or stop Tomcat, right-click the Tomcat Monitor icon and select your 
action: Start service, Stop service, and so on.
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Figure 7: Tomcat Console Window

3. Further test the Tomcat installation by opening a browser to 
http://localhost:8080. You should see the web page displayed in 
Figure 8.

Figure 8: Successful Tomcat Installation Web Page

4. Shut down Tomcat. Use shutdown.bat if it exists, or press Ctrl+C from the 
console window if the batch file does not exist.

5. Shut down Apache. Select Start > Programs > Apache HTTP Server 
<release_number> > Control Apache Server > Stop.

End of procedure

Next Steps

• Connecting Tomcat and Its Web Server
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Connecting Tomcat and Its Web Server
This section describes connecting Tomcat and its web server on the Windows 
platform.

Setting Up the JK1 Connector with Apache

Procedure:
Installing the JK1 Connector with Apache

Start of procedure

1. On the Interaction Management CD, navigate to 
ThirdPartyApplications\Tomcat\jk_apache_for_windows\binary and 
locate the file that matches your version of Apache: 
• mod_jk-apache-2.2.4.so (for Apache 2.2 or later)
• mod_jk-apache-2.0.59.so (for Apache 2.0.59 or later)

2. Copy this file to your <APACHE_HOME>/modules directory, and rename it to 
mod_jk.so.

3. In the <CATALINA_HOME>/conf/jk directory, create a file called 
workers.properties, with the following contents:

worker.list=ajp13
worker.ajp13.port=8009
worker.ajp13.host=localhost
worker.ajp13.type=ajp13

Note: If there is no jk directory, create one.

4. In the <APACHE_HOME>/conf directory, create a file called mod_jk.conf, 
with the following contents:

<IfModule !mod_jk.c>
 LoadModule jk_module "<APACHE_HOME>/modules/mod_jk.so"
</IfModule>
JkWorkersFile "<CATALINA_HOME>/conf/jk/workers.properties"
JkLogFile "<CATALINA_HOME>/logs/mod_jk.log"
JkLogLevel emerg
JkMount /examples/* ajp13

5. Add the following statement to the end of the 
<APACHE_HOME>/conf/httpd.conf file:

Include "<APACHE_HOME>/conf/mod_jk.conf"

End of procedure
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Next Steps

• After completing the installation, you should test the JK1 connector to 
ensure that it functions properly. See Testing the JK1 Connector with 
Apache.

Procedure:
Testing the JK1 Connector with Apache

Start of procedure

1. Start Tomcat and Apache.
Open a web browser and enter the following address:
http://localhost/examples/jsp/jsp2/el/basic-arithmetic.jsp 

You should see the web page shown in Figure 9.

Figure 9: JK1 Test Page

End of procedure

Next Steps

• If you want your Multimedia solution to include co-browsing functionality, 
see Deploying KANA Response Live for co-browsing, page 74.

• Otherwise, you can begin to deploy the Model Setup of the Multimedia 
components. See Chapter 5 on page 91.
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Setting Up the JK1 Connector with IIS 5 or 6

Procedure:
Installing the JK1 Connector with IIS

Purpose:  This procedure describes how to install the JK1 connector with IIS. 
This procedure applies to both IIS 5 and IIS 6. For IIS 6, follow all steps; for 
IIS 5, skip Steps 11 to 13.

Start of procedure

1. On the Interaction Management CD, go to 
ThirdPartyApplications\Tomcat\jk_apache_for_windows\binary, locate 
isapi_redirect<release number>.dll, and place it in c:\jakarta-
tomcat\bin.

2. Create the properties files workers.properties and 
uriworkermap.properties in c:\jakarta-tomcat\conf.
Here is a minimum workers.properties, using just ajp13 to connect your 
IIS web server to the Tomcat engine.

# workers.properties
#
# This file provides minimal jk configuration properties needed to
# connect to Tomcat.
# Define 1 real worker using ajp13
#
worker.list=ajp13w
#
# Set properties for worker ajp13w
# Note that the name and the type do not have to match.
#
worker.ajp13w.type=ajp13
worker.ajp13w.host=localhost
worker.ajp13w.port=8009

Here is a minimum example of uriworkermap.properties:

# This file provides sample mappings for example
# ajp13w worker defined in workermap.properties
/examples/*=ajp13w
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Note: The workers.properties and uriworkermap.properties files must 
be saved in Microsoft Windows/MS-DOS format. Otherwise, an 
error will occur when installing the Web API Server and setup will 
not proceed.

3. In the registry, create a new registry key named:
HKEY_LOCAL_MACHINE\SOFTWARE\Apache Software Foundation\Jakarta 

Isapi Redirector\1.0

4. Add a string value with the name extension_uri and a value of 
/jakarta/isapi_redirect.dll.

5. Add a string value with the name log_file and a value pointing to where 
you want your log file to be (for example c:\jakarta-
tomcat\logs\isapi.log). 

6. Add a string value with the name log_level and a value for your log level 
(can be debug, info, error or emerg). 

7. Add a string value with the name worker_file and a value which is the full 
path to your workers.properties file (for example, c:\jakarta-
tomcat\conf\workers.properties).

8. Add a string value with the name worker_mount_file and a value which is 
the full path to your uriworkermap.properties file (for example 
c:\jakarta-tomcat\conf\uriworkermap.properties).

9. Using the IIS management console, add a new virtual directory to your IIS 
web site. The name of the virtual directory must be jakarta. Its physical 
path should be the directory where you placed isapi_redirect.dll (in our 
example it is c:\jakarta-tomcat\bin). While creating this new virtual 
directory assign it with execute access.

10. Using the IIS management console, add isapi_redirect.dll as a filter in 
your IIS web site. The name of the filter should reflect its task (for 
example, tomcat), its executable must be our c:\jakarta-
tomcat\bin\isapi_redirect.dll. 

For IIS 6, continue with Step 11.
For IIS 5, skip to Step 14.

11. Open IIS Manager, as shown in Figure 10. 
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Figure 10: IIS Manager

12. Click Add New Web Service Extension. The resulting dialog box is shown 
in Figure 11 on page 67.

Figure 11: New Web Service Extension

13. In the New Web Service Extension dialog box:
a. In the Extension name box, type jakarta.
b. In the Required files box, click Add and browse to the location of the 

isapi_redirect.dll file.
c. Select the Set extension status to Allowed check box, then click OK.

14. Restart the IIS service. Ensure that the filter you added in Step 10 is 
marked with a green up-pointing arrow. 

End of procedure
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Next Steps

• Testing the JK1 Connector with IIS

Procedure:
Testing the JK1 Connector with IIS

Start of procedure

1. Start Tomcat. Start or restart IIS.
2. Open a web browser and go to:

http://localhost/examples/jsp/jsp2/el/basic-arithmetic.jsp 
You should see the web page shown in Figure 12 on page 68.

Figure 12: JK1 Test Page

End of procedure

Next Steps

• Advanced Configuration of the Tomcat Context

Advanced Configuration of the Tomcat Context
To perform additional advanced configuration of your IIS-Tomcat 
implementation, see the following:
• Configuring IIS to serve static content, page 69
• Protecting the WEB-INF Directory, page 70
• Configuring Tomcat to serve multiple contexts, page 70



Deployment Guide  69

Chapter 4: Deploying Third-Party Web Applications Connecting Tomcat and Its Web Server

Procedure:
Configuring IIS to serve static content

Purpose:  To configure IIS-Tomcat so that IIS handles all static content (.html, 
.jpg, and so on), leaving Tomcat to process the Java Server Pages (JSP) and 
servlets.

Genesys Multimedia web applications (Web API Server) use a combination of 
static web pages and active java content. You can reduce processing time by 
letting IIS serve static pages, even if these files are part of a context already 
served by Tomcat. For example, the .html and .gif files in the examples 
context do not need to be served from the Tomcat process—it is enough for IIS 
to serve them.

Start of procedure

1. Configure IIS to include the Tomcat contexts. 
Adding a Tomcat context to IIS requires the addition of a new IIS virtual 
directory that covers the Tomcat context. For example, you could add a 
/example IIS virtual directory that covers the D:\tomcat\webapps\examples 
directory.

2. Configure the redirector to leave the static files for IIS.
To configure the redirector, you must edit the uriworkermap.properties file 
to specify the URL-path pattern(s) that you want Tomcat to handle (usually 
only JSPs and servlets). For the examples context, you must replace the 
following line:

/examples/*=ajp13

with the following two lines:
/examples/*.jsp=ajp13 
/examples/servlet/*=ajp13 

The second line is more explicit; it actually instructs the redirector to 
redirect only the following:

Requests to resources under /examples/servlet/.
Resources under /examples/ whose name ends with .jsp. 

You can be more explicit and provide lines such as the following:
/examples/servlet/<servletname>=ajp13 

This instructs the redirector to redirect requests whose URL path equals 
/examples/servlet/<servletname> to the worker named ajp13.

End of procedure
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Next Steps

• If you want to do any more advanced configuration of the Tomcat context, 
return to the list of configuration options—see Advanced Configuration of 
the Tomcat Context, page 68.

• If you want your Multimedia solution to include co-browsing functionality, 
see Deploying KANA Response Live for co-browsing, page 74.

• Otherwise, you can begin to deploy the Model Setup of the Multimedia 
components—see Chapter 5 on page 91.

Procedure:
Protecting the WEB-INF Directory
Each servlet application (context) has a special directory named WEB-INF. This 
directory contains sensitive configuration data and Java classes, and you must 
prevent web users from accessing or even seeing these directories. Although 
you can use the IIS management console to do this, the administrator must 
remember that it has been done. To avoid this complication, the redirector 
plugin automatically protects your WEB-INF directories by rejecting any request 
that contains WEB-INF in its URL-path.

Start of procedure

• You do not need to perform any actions to obtain this WEB-INF 
protection. The redirector plugin does this automatically.

End of procedure

Next Steps

• If you want to do any more advanced configuration of the Tomcat context, 
return to the list of configuration options—see Advanced Configuration of 
the Tomcat Context, page 68.

• If you want your Multimedia solution to include co-browsing functionality, 
see Deploying KANA Response Live for co-browsing, page 74.

• Otherwise, you can begin to deploy the Model Setup of the Multimedia 
components—see Chapter 5 on page 91.

Procedure:
Configuring Tomcat to serve multiple contexts

Purpose:  To configure the workers.properties file so that different Tomcat 
processes can serve different contexts—for example, to spread the load among 
different machines.
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Summary

For Tomcat to serve multiple contexts, you must:
1. Define the workers (the Tomcat processes or instances) that you want to 

use.
2. Assign each context its own worker.

Start of procedure

1. Open the workers.properties file, located in the <CATALINA_HOME>/conf 
directory.

2. In the worker.list entry, add workers using the following format:
worker.list=<a comma separated list of worker names>

Example
worker.list=ajp13, ajp13second

3. Add entries for each individual worker, one for each associated host and 
port, using the following format:
worker.<worker name>.<property>=<property value>

Example
worker.ajp13.host=localhost

worker.ajp13.port=8007

worker.ajp13second.host=otherhost

worker.ajp13second.port=8007

4. You can now assign the workers to serve the various contexts (one worker 
for each context).
For example, look at the following uriworkermap.properties fragment:

/examples/*=ajp13
/webpages/*=ajp13second

The examples context is served by ajp13 while the webpages context is 
served by ajp13second.

End of procedure

Next Steps

• If you want to do any more advanced configuration of the Tomcat context, 
return to the list of configuration options—see Advanced Configuration of 
the Tomcat Context, page 68.

• If you want your Multimedia solution to include co-browsing functionality, 
see Deploying KANA Response Live for co-browsing, page 74.

• Otherwise, you can begin to deploy the Model Setup of the Multimedia 
components—see Chapter 5 on page 91.
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Configuring Apache and Tomcat for Linux 
or Solaris 

This section points you to third-party documentation on how to perform further 
Apache and Tomcat configuration for Solaris or Linux. You can obtain third-
party documentation using either of these methods:
• Obtaining Apache documentation from the CD
• Obtaining Tomcat documentation from the CD and the Web

Note: For information about deploying Solaris or AIX with IBM WebSphere, 
or Solaris with BEA WebLogic, see the following sections:
• Deploying WebSphere on AIX or Solaris, page 156
• Deploying WebLogic on Solaris, page 169

Procedure:
Obtaining Apache documentation from the CD

Start of procedure

1. From the Interaction Management CD, locate the .html file applicable to 
your operating system from one of the following folders:
Solaris
ThirdPartyApplications\Apache2.2.9\solaris\apache_documentation.html

Linux
ThirdPartyApplications\Apache2.2.9\linux\apache_documentation.html

2. Open the apache_documentation.html file. This document can assist you in 
installing and building Apache for a Solaris or Linux environment.

End of procedure

Next Steps

• If you have not done so already, configure and install Multimedia as 
outlined in:

— Chapter 5 on page 91
— Deploying Multimedia on UNIX Hosts, page 153
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Procedure:
Obtaining Tomcat documentation from the CD and the 
Web

Start of procedure

1. From the Interaction Management CD, locate the .html file:
ThirdPartyApplications\TomCat_Servlet6.0.16\unix\tomcat_documentatio

n.html

2. Open the tomcat_documentation.html file. This document includes 
information about installing, configuring, and operating an Apache Tomcat 
server.

3. For documentation about installation, building, and configuring mod_jk for 
UNIX, see:
http://tomcat.apache.org/connectors-doc/index.html

4. The site referenced above also describes how to connect Apache to Tomcat 
on UNIX.

Note: You can access links to these same locations from the port 8080 page of 
your local host when your Tomcat server is running:
http://localhost:8080/docs

End of procedure

Next Steps

• If you have not done so already, configure and install Multimedia as 
outlined in:

— Chapter 5 on page 91
— Deploying Multimedia on UNIX Hosts, page 153

Deployments with WebSphere on AIX or 
Solaris

If you intend to use WebSphere on AIX or Solaris for Multimedia and its Web-
based interaction capabilities, necessary components, such as an Enterprise 
Archive project, are dynamically generated during installation of the Genesys 
Web API Server for AIX or Solaris. (This feature was introduced in the 7.2 
release.) Details on how to deploy web projects are set out in Chapter 7, 
beginning on page 153, after configuration and installation of Multimedia 
itself.
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Minimum Requirements
For hardware and operating system minimum requirements, see the Genesys 
Supported Operating Environment Reference Manual. Ensure that you have at 
least the following amount of free disk space on your installation host.

WebSphere Application Server 6.0

For AIX ® (32-bit WebSphere Application Server):
• Minimum 970 MB free disk space for installation (includes SDK)
• Minimum 512 MB physical memory; 1 GB recommended

Web Sphere Application Server 5.1

For Sun Solaris:
• Minimum 580 MB free disk space for installation (includes SDK)
• Minimum 256 MB physical memory; 512 MB recommended

Software

Use IBM HTTP Server 2.0.x and IBM WebSphere 5.0, 5.1, or 6.0.

Deploying KANA Response Live for 
co-browsing

KANA Response Live is used to enable the Multimedia Web Collaboration 
feature, which allows an agent to direct a client’s web browser so that they can 
view websites at the same time.
This section describes how to install and configure KANA Response Live on 
the following platforms.

Table 5: KANA Response Live Supported Platforms

OS Web Server Application Container

Windows Microsoft Internet Information 
Server (IIS)

Apache Tomcat

Solaris Apache HTTP server Apache Tomcat

Linux Apache HTTP server Apache Tomcat

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
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Prerequisites
• Create a new Microsoft SQL or Oracle database to use with KANA 

Response Live.
• Request and install an SSL certificate for your server. See Installing a new 

SSL certificate using IIS, page 76.

Table 6: Task Flow to Deploy KANA Response Live

Objective Related Procedures and Actions

1. Install KANA 
Response Live

Follow the procedure for your operating system:
• Installing KANA Response Live for Windows, 

page 78
• Installing KANA Response Live for Solaris, 

page 83
• Installing KANA Response Live for Linux, 

page 84

2. Create the database 
schema.

Windows
On Windows deployments, the database schema is 
created automatically during installation.
Solaris and Linux
For Solaris and Linux deployments, you must 
manually create the schema:
• Creating the KANA database schema on Solaris 

or Linux, page 85

3. Configure additional 
settings.

Windows
For Windows deployments:
1. Change the router.enabled option in the 

config.properties file to false.
2. Point the Home Directory in IIS to your KANA 

installation folder.
For the full procedure, see Configuring KANA 
Response Live for Windows, page 80.
Solaris or Linux
For Solaris or Linux deployments:
1. Change the router.enabled option in the 

config.properties file to false.
2. Install a valid SSL certificate in the Apache 

Web Server directory.
For the full procedure, see Configuring KANA 
Response Live for Solaris or Linux, page 86.
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Procedure:
Installing a new SSL certificate using IIS

Purpose:  To configure an SSL certificate for your Kana Response Live server, 
using Microsoft IIS Manager.

Start of procedure

1. To open IIS Manager, select Start > Administrative Tools > Internet 
Information Services (IIS) Manager.

2. In the left frame, expand Server_Name(local computer), find and right-
click Default Web Site, and then select Properties.

3. On the Directory Security tab, in the Secure communications section, 
click Server Certificate.
The Web Server Certificate Wizard opens.

4. On the Welcome page, click Next.
5. Select Create a new certificate, and then click Next.

4. Test the installation. Windows
For Windows, you can start running the KANA 
Response Live server by launching the .bat files in 
kana\hbroot\bin .
For the full procedure, see Testing the KANA 
Response Live installation on Windows, page 82.
Solaris or Linux
For Solaris or Linux, you can start the KANA 
server using the following command:
/usr/local/kana/hipctl start

For the full procedure, see Testing the KANA 
installation on Solaris or Linux, page 86.

5. Test co-browsing 
functionality.

Use the following URLs to start a test co-browsing 
session:
• Windows: 
http://<hostname>/index.html

• Solaris or Linux:
http://<hostname>/responselive/index.html

For the full procedure, see Launching a co-
browsing session, page 87.

Table 6: Task Flow to Deploy KANA Response Live (Continued) 

Objective Related Procedures and Actions
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6. Select Prepare the request now, but send it later, and then click Next.
7. Enter a name for your certificate, select a bit length (the higher the bit 

length, the stronger the encryption), and then click Next.
8. On the Organization Information page, enter your company name in the 

Organization box and a descriptive name for your organizational unit in 
the Organizational unit box.

9. Enter either the fully qualified domain name (FQDN) or the server name as 
the Common name for your website—the address you want users to enter 
when browsing to your site.

10. Enter your location information, and then click Next. Do not use 
abbreviations for State/province or City/locality.
The Certificate Request File Name page opens.

11. Enter the path and file name where you want to save your certificate 
request, and then click Next.

12. Review the summary of your certificate request information, and then click 
Next.
IIS creates the certification file.

13. Click Finish.
14. At this point, you need to send the certification file to the online Certificate 

Authority of your choice. Contact the Certificate Authority for directions 
on how to submit your request.

15. When you receive the response file from the Certificate Authority, you 
need to reopen the certificate installation wizard. Again on the Directory 
Security tab of your Default Web Site Properties dialog box, click 
Server Certificate. Click Next to continue.

16. Select Process the pending request and install the certificate, and 
then click Next.

17. Enter the location of the certificate file you received from the Certificate 
Authority, and then click Next.

18. Review the summary, and then click Next.
19. Click Finish.

End of procedure

Next Steps

• Installing KANA Response Live for Windows

Tip: For the Common name, make sure you use a valid DNS name. It must 
match the external FQDN of your website. For intranet-only purposes, 
you can use the internal FQDN for your sever, or the NetBIOS name.
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Installing and Configuring KANA Response Live for Windows
Use these procedures to install and configure KANA Response Live in a 
Windows environment.

Procedure:
Installing KANA Response Live for Windows

Purpose:  This procedure outlines how to install KANA Response Live for 
Windows.

Prerequisites

• Installing a new SSL certificate using IIS, page 76

Start of procedure

1. Locate and double-click the KANA Response Live setup file. For 
Windows, this file is called V<version>_Win_Tomcat_IIS_DB_CHAT.exe.

Note: For Multimedia 7.6.1, the current supported version for Windows 
is KANA Response Live Version 10 R1. The file on the 7.6.1 CD 
is V10.1.0.17_Win_Tomcat_IIS_DB_CHAT.exe. 

2. Enter your Web Server and Application Server host names, and click Next.

Figure 13: KANA Response Live Installation

3. Select the database type you created, and click Next.
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4. Enter login parameters for the database instance that you created, and click 
Next.

5. Enter a Server ID, and click Next. This Server ID is a unique name of four 
characters or less.

6. If you did not enter valid database login information, the Database Check 
Result page displays an error message. To correct the information, click 
Previous to return to the appropriate pages. To continue, click Next.

7. Click Next to start the preinstallation checks.
If you did not install a valid SSL certificate before installing KANA 
Response Live, a warning appears (see Figure 14). Click Next to continue, 
and install your SSL certificate after completing the installation.

Figure 14: System Requirements Warning

8. Click Next at the Introduction page.
9. Choose the installation folder for KANA Response Live, and click 

Install.

Warning! Do not include any spaces in the folder name (for example, use 
ResponseLive instead of Response Live).

10. Click Next.
11. Leave the Yes checkbox unselected, and click Next.
12. At the Launch Page page, click Next.
13. Click Done. The installation is complete.

End of procedure
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Next Steps

• Configuring KANA Response Live for Windows, page 80

Procedure:
Configuring KANA Response Live for Windows

Purpose:  After installing KANA Response Live on your Windows machine, 
you need to make the following additional configurations:

• Update your config.properties file. Change the router.enabled option in 
the config.properties file to false. 

• Change your IIS Default Web Site so that the Home Directory points to 
your KANA installation folder.

Note: KANA Response Live has many other functions and configurable 
options that are not described in this Deployment Guide. To ensure 
compatibility, Genesys does not recommend making use of additional 
functionality or changing any options other than those described below.

Prerequisites

• Configuring KANA Response Live for Windows, page 80

Start of procedure

1. To update your config.properties file, complete the following actions:
a. Open the config.properties file located in <KANA_HOME>\hbroot\conf.
b. Change the router.enabled option to false.
c. Save and close the properties file.

2. To change your IIS Default Web Site home directory, complete the 
following actions:
a. Open Internet Information Services (IIS) Manager.
b. Right-click on Default Web Site, and select the Properties option 

(Figure 15 on page 81).
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Figure 15: Internet Information Services (IIS) Manager

c. On the Default Web Site Properties page, select the Home Directory 
tab (Figure 16).

Figure 16: Default Web Site Properties



82 Multimedia 7.6

Chapter 4: Deploying Third-Party Web Applications Deploying KANA Response Live for co-browsing

d. Change the Local path value to <KANA_HOME>\web.
e. Click OK to save the change.

End of procedure

Next Steps

• Testing the KANA Response Live installation on Windows

Note: To configure Kana Response Live application server to support a 
single remote web server, make the following change on the Response 
Live application server:
In the System Administration Tool, edit the ISystems properties for the 
Response Live Server. In the Host Servers, change Login Cookie 
Domain to the IIS Server domain name.

Procedure:
Testing the KANA Response Live installation on 
Windows

Purpose:  This procedure describes how to test the KANA Response Live 
installation on Windows.

Prerequisites

• Configuring KANA Response Live for Windows, page 80

Start of procedure

1. Locate and double-click the following files (in the order listed) to start 
your KANA Response Live installation:
a. hipregistry.bat

b. router.bat

c. tomcat.bat

2. Start (or restart) your Web Server.
3. Follow the steps listed in Launching a co-browsing session, page 87 to test 

co-browse functionality.

End of procedure

Next Steps

• Launching a co-browsing session, page 87
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Installing and Configuring KANA Response Live for Solaris or 
Linux

To install KANA Response Live on a Solaris or Linux system, you must use a 
user that has superuser permissions and has write permissions in the 
/usr/local directory, such as root.

Procedure:
Installing KANA Response Live for Solaris

Purpose:  This procedure outlines how to install KANA Response live for 
Solaris.

Start of procedure

1. Transfer the KANA Response Live software package to the system, using 
the following command:
pkgadd -d Cona_sparc-V<version>_sol7-sparc.

Note: For Multimedia 7.6.1, the current supported version for Solaris and 
Linux is KANA Response Live Version 10 R2. For Solaris, use the 
Cona_sparc-V10.2.0.9-sol7-sparc file on the CD.

2. Select 1 and press Enter.
3. Type the fully qualified domain name of your system and press Enter.
4. A message will appear asking where you want to install. Press Enter to 

select the default location /usr/local/kana. You cannot install in any other 
directory, as this path name is hard-coded.

5. A message will appear asking for the packages to install. Press Enter to 
select the default all option and start the installation process. The installer 
creates the KANA Response Live files and copies them to the KANA 
Response Live installation directory /usr/local/kana. 

6. Select the database type that you created. For details, see “Prerequisites” 
on page 75.

7. At the prompt, type the database host name and press Enter.
8. Enter the following information about your database, as prompted:

a. Database server name.
b. Database instance name.
c. Administrator’s user name.
d. Administrator’s password.

9. Enter a server ID. This ID is a unique name of four characters or less.
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10. Press Y to confirm the information you entered, and to transfer the package.

End of procedure

Next Steps

• Creating the KANA database schema on Solaris or Linux

Procedure:
Installing KANA Response Live for Linux

Purpose:  This procedure describes how to install KANA Response Live for 
Linux.

Start of procedure

1. Transfer the KANA Response Live software package to the system, using 
the following command:
./pkginst add

Note: For Multimedia 7.6.1, the current supported version for Solaris and 
Linux is KANA Response Live Version 10 R2. For Linux, use 
Cona_linux-V10.2.0.9-linux.tar. This file will need to be unzipped. 
To do so, enter tar -xvf <filename> at the command prompt, then the 
command above can be entered.

2. Press Enter.
3. Type the fully qualified domain name of your system and press Enter.
4. Select the database type that you created. For details, see “Prerequisites” 

on page 75.
5. Enter the following information about your database, as prompted:

a. Database server name.
b. Database instance name.
c. Administrator’s user name.
d. Administrator’s password.

6. Enter a server ID. This ID is a unique name of four characters or less.

Note: If the following message appears during installation, it can be ignored.
./postinstall_k: line 37: ndd: command not found

It will not have any affect on the installation.

7. The installation generates a dummy certificate.
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Note: Installation on Linux ends without a successful completion message (as 
it does after installation on Solaris).

End of procedure

Next Steps

• Creating the KANA database schema on Solaris or Linux

Procedure:
Creating the KANA database schema on Solaris or 
Linux

Purpose:  This procedure describes how to create the KANA database schema 
on Solaris or Linux.

Prerequisites

• Installing KANA Response Live for Solaris, page 83
• Installing KANA Response Live for Linux, page 84

Start of procedure

1. Enter the following commands to start the installation script:
cd /usr/local/kana/hbroot/bin

./clinstaller.sh

2. Select the database type that you created. For details, see “Prerequisites” 
on page 75.

3. Enter the following information about your database, as prompted:
a. Database instance name.
b. Administrator’s user name.
c. Administrator’s password.
d. Database server name.

4. Type the KANA Response Live server name and press Enter.
5. Enter the server ID that you specified in Step 9 of the “Installing KANA 

Response Live for Solaris” section.
6. Enter the database tablespace name.
7. Press Y to confirm the information that you have entered, and to install the 

database schema.

End of procedure
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Next Steps

• Configuring KANA Response Live for Solaris or Linux

Procedure:
Configuring KANA Response Live for Solaris or Linux

Purpose:  This procedure describes how to configure KANA Response Live 
for Solaris or Linux.

Prerequisites

• Installing KANA Response Live for Solaris, page 83
• Installing KANA Response Live for Linux, page 84

Note: KANA Response Live has many other functions and configurable 
options that are not described in this Deployment Guide. To ensure 
compatibility, Genesys does not recommend making use of additional 
functionality or changing any options other than those described below.

Start of procedure

1. Update your config.properties file:
a. Open the config.properties file located in 

/usr/local/kana/hbroot/conf.
b. Change the router.enabled option to false.
c. Save and close the config.properties file.

2. In order for the KANA Response Live Server to function, you must install 
a valid SSL certificate in the packaged Apache Web Server located at:
/usr/local/kana/apache

End of procedure

Next Steps

• Testing the KANA installation on Solaris or Linux.

Procedure:
Testing the KANA installation on Solaris or Linux

Purpose:  This procedure describes how to test the KANA installation.
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Prerequisites

• Creating the KANA database schema on Solaris or Linux, page 85
• Configuring KANA Response Live for Solaris or Linux, page 86

Start of procedure

1. Start your KANA Response Live installation using the following 
command:
/usr/local/kana/hipctl start

Note: After the Genesys Web Collaboration Server is installed, you do 
not use this command to start or stop KANA Response Live. 
Instead, use the following commands:

Start Genesys Web Collaboration:
/usr/local/kana/hipctl_start.sh

Stop Genesys Web Collaboration:
/usr/local/kana/hipctl_stop.sh

2. Follow the steps listed in Step 1 on page 87 to test co-browsing 
functionality.

End of procedure

Next Steps

• Launching a co-browsing session

Launching a Co-Browsing Session
Complete the following procedure to launch a test co-browsing session using 
either the Windows, Solaris, or Linux deployment of KANA Response Live.

Procedure:
Launching a co-browsing session

Purpose:  Once KANA Response Live is installed, you can use two hosts to 
test the co-browsing sessions.

Start of procedure

1. On the first host, open the KANA Response Live launch page in a web 
browser (see Figure 17 on page 88).
Windows: http://<hostname>/index.html
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Solaris or Linux: http://<hostname>/responselive/index.html

Figure 17: KANA Response Live Launch Page

2. Enter the channel and user ID, and click Go.
iChannel ID: Default

Launch as: guest

3. On the second host, repeat Steps 1 and 2.
4. On the first host, enter the user ID for the second host into the 

Connect With field (see Figure 18 on page 89), and click Go.
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Figure 18: Web Collaboration Connection Window

5. On the second host, click Yes to accept the Web Collaboration session (see 
Figure 19).

Figure 19: Request for Web Collaboration

A new web browser window opens on both hosts, showing the shared web 
session.

Note: Before installing the Genesys Co-Browsing components, you should 
remove the KANA Response Live start service. See “Remove the 
KANA Response Live Start Service” on page 94 for details.

End of procedure
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Next Steps

• Chapter 5 on page 91
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5 Model Configuration and 
Installation on Windows
This chapter describes a model single-tenant setup, using a Windows 
environment, such as might be deployed in a lab setting. This model setup, 
which includes all Genesys and third-party components, is assumed to be a 
first-time installation.
The information in this chapter is divided among the following topics:

The Model Environment, page 91
Overall Strategy, page 92
Prerequisites, page 93
Web Server and Web Application Container, page 95
Configuring Multimedia Objects, page 95
Installing Multimedia Components, page 129
Creating Databases and Running Scripts, page 136
Verifying Connections, page 137
Testing Multimedia Components, page 137
Testing the Setup, page 140

This chapter assumes that you are familiar with the use of the Genesys 
Configuration Manager. See Framework 7.6 Configuration Manager Help for 
detailed directions on using Configuration Manager.
For your own deployment, be sure to use the “Configuration Worksheet” on 
page 41 to help you plan the specifics of your solution.

The Model Environment
The model environment is deployed on one computer with the network name 
MMHost and with the following software components:
• Genesys Framework
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• Universal Routing
• Genesys Desktop (a Genesys-designed agent desktop, not part of 

Multimedia)
• Stat Server (part of Real-Time Metrics Engine)
• POP3 e-mail server
• All Multimedia components
• Web components, including web server and Java components

Overall Strategy
The strategy for configuring and installing the model environment is as 
follows:
1. Prerequisites

You must have some items installed and operating before starting, 
including Framework, Routing, and various third-party applications. This 
document does not describe installation procedures for these components 
beyond what is available in Chapter 4, beginning on page 55. (For detailed 
information on deploying a given non-Multimedia component, see the 
related Deployment Guide for that component.)
You should also create a shared directory to receive the installation 
packages for the Multimedia components.

2. Web Server and Web Application Container
Install, connect, and/or configure components that enable web services.

Install and connect Apache, then Tomcat. (See Chapter 4.)
3. Configuration

Install and use the Multimedia 7.6.1 Configuration Wizards that Genesys 
supplies to guide you through the process of configuring this solution. 
These wizards help you configure a number of different components, and 
each component wizard has its own name. Throughout this section, 
however, these wizards will generally be referred to as the 
Multimedia 7.6.1 Configuration Wizards, unless identifying a specific 
component wizard by name is more helpful.

Note: You can configure most of the components and contact center 
objects you need from within the Multimedia 7.6.1 Configuration 
Wizards interface.

a. Install the Multimedia Configuration Wizards.
b. Install Interaction Workflow Samples.
c. Configure contact center objects—Switching Office, Switch, Places.
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d. Configure Multimedia objects—Media servers, clients, other 
components.

4. Installation 
Install the Multimedia 7.6.1 components.
a. Perform integrated installation of Multimedia servers.
b. Install Genesys Desktop.

5. Testing the setup
a. Test individual components.
b. Test your model setup as a whole and troubleshoot any problems.

The following sections of this chapter describe these procedures in detail.

Prerequisites
The model setup uses the components listed in Table 7.

Table 7: Prerequisite Components

Type of Component Component Used

Operating System A supported Windows environment.

Web Server Apache Web Server.

Web Application 
Container

Tomcat.

E-mail (POP3) Server Third-party e-mail server.

Java Environment Java Runtime Environment (JRE). For supported 
versions, see the Genesys Supported Operating 
Environment Reference Manual.

Database Server Microsoft SQL 2000. For other supported 
databases, see the Genesys Supported Operating 
Environment Reference Manual.

License Server License Server 9.5; License File: 7260@MMHost.

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
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Be sure you have these components installed and operating properly before 
installing Multimedia 7.6.1. For instructions, see the documentation for 
Genesys Framework and Universal Routing.

Create Host If you plan on installing Multimedia on the same computer as Genesys 
Framework, you should already have a Host object created and available for 
your Multimedia deployment. However, if you have not already done so, or if 
you want to install Multimedia on a different computer than Framework, create 
the Host object in the Configuration Layer for the machine that will host your 
model environment.

Create a Shared
Directory

If you plan to install Multimedia components across multiple hosts, create a 
shared directory on your local drive or network to receive the installation 
packages. Genesys recommends that you do this before starting the 
configuration and installation process. (This is unnecessary if you plan to 
install Multimedia on a single host.)

Remove the KANA
Response Live

Start Service

If you plan to install Genesys Co-Browsing components, you should remove 
the KANA Response Live start service. For Windows systems, check the 
Windows Services application to ensure that KANA Response Live Service is 

Genesys Framework, 
including 
• Management Layer
• Stat Server (part of 

Real-Time Metrics 
Engine)

Genesys Framework, single tenant.

Management Layer.

Stat Server Application object name Stat_Server.

If installing a new Stat Server:
• Do so prior to running the Multimedia 7.6.1 

Configuration Wizards.
• Make sure you select Stat Server Java Extensions 

(SSJE). SSJE requires a Java Runtime 
Environment (JRE) on the computer hosting this 
instance of Stat Server.

If using an existing Stat Server:
• You will likely need to enable SSJE. This 

requires creating new Java sections in the Stat 
Server application object and installing new java 
extension files. For details, consult the Stat Server 
7.6 Deployment Guide.

Genesys Universal 
Routing

Genesys Universal Routing, with a multimedia 
routing strategy enabling e-mail and chat.

Table 7: Prerequisite Components (Continued) 

Type of Component Component Used
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configured to start manually and is not running. For Solaris systems, use the 
rm -f /etc/rc2.d/S88hipctl command to remove the start service.

Create Contact,
Interaction (and

Co-Browsing)
Databases

Create three databases in your SQL Server RDBMS. Two of these will 
accommodate Universal Contact Server contact information, and the other will 
handle Interaction Server’s one table for tracking transient data. If you are also 
deploying Co-Browsing Server, you may want to create an additional database 
for it. (Alternatively, you can use the UCS database to store Co-Browsing 
Server information.) You will use the names of these databases during your 
creation of Multimedia Database Access Points (DAPs). After configuration 
and installation, you will run scripts against these databases to make them 
available to Genesys servers.

Note: For DB2 RDMS users, before running your database scripts, you need 
to create an additional table space with a corresponding buffer pool 
page size of at least 8 KB.

Web Server and Web Application Container
The installation of the web server and the web application container are 
described in Chapter 4, beginning on page 55. Any further instructions in this 
chapter coincide with steps you may need to take in using wizards to deploy 
Multimedia.

Configuring Multimedia Objects
The first step in configuring Multimedia 7.6.1 is to install the Multimedia 7.6.1 
Configuration Wizards.
The second step is to install the Interaction Workflow Samples. Doing so 
provides you with a number of Configuration Layer objects that are useful 
later, when implementing the model environment.

Note: Because Multimedia requires specific configuration objects, including 
certain Queue and View objects, if you do not install the Interaction 
Workflow Samples first, you must create these objects manually to 
allow the wizard to install the solution. If you create these objects prior 
to running the wizard, the wizard uses them. If you do not install the 
Samples first, and if you have not created these objects previously, you 
must create and configure the default Queue objects for E-mail Server 
Java and Chat Server prior to completing the Multimedia deployment.

The Multimedia 7.6.1 Configuration Wizards take you through a step-by-step 
configuration process, allowing you to create Configuration Layer objects and 
to associate them with each other as needed. After you configure each 
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component, the wizard copies the software to the directory you specify. Once 
you have configured all the Multimedia components, you will install them with 
the Multimedia Installation Starter. See “Installing Multimedia Components” 
on page 129 for more details.

Note: At certain points, the configuration or installation wizards might 
prompt you to restart your computer. If you receive such a prompt, 
allow the restart to occur, then continue with the configuration or 
installation process.

Procedure:
Installing the Multimedia Configuration Wizards

Prerequisites

• Interaction Management CD.
• Start the Configuration Layer.

Start of procedure

1. Install the Multimedia Configuration Wizards and Genesys Wizard 
Manager.
In the root directory of the Interaction Management CD, find Setup.exe. 
Run Setup.exe and follow the directions. You may want to read the Wizard 
Advisory supplied with the wizard.

2. If you intend to configure your Stat Server as you configure Multimedia, 
you should also install the configuration wizard for this product.

End of procedure

Next Steps

• Installing and Starting Interaction Workflow Samples

Procedure:
Installing and Starting Interaction Workflow Samples

Purpose:  To instantiate objects in the Configuration Layer, which you will find 
helpful when completing the full Multimedia configuration and installation.

Interaction Workflow Samples use a number of preconfigured Script objects 
of various subtypes, including Simple Routing, Interaction Queue, Workbin, 
and Interaction View.
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Start of procedure

1. Install the Interaction Workflow Samples.
a. On your Interaction Management CD, find and double-click Setup.exe 

in the solution_specific\InteractionWorkflowSamples\windows 
directory.

b. At the welcome page for the installation wizard, click Next.
c. Specify the destination for Interaction Workflow Samples, and click 

Next.
d. Click Install.
e. Click Finish.

2. Start the Interaction Workflow Samples.
a. From the Windows taskbar, select Start > Programs > Genesys 

Solutions > Multi-Channel Routing 7.6.1 > Interaction Workflow 

Samples > Start Interaction Workflow Samples. This launches the 
Interaction Workflow Samples Wizard.

b. Login to Configuration Manager using your user name and password.
c. At the Welcome to Interaction Workflow Samples Wizard window, 

click Next.
d. If using a multi-tenant environment, select the Tenant and click Next.

e. Specify a destination directory for the strategy files, and click Next.
You may want to select the directory used for your Interaction Routing 
Designer strategies, unless it already contains strategies with same file 
names, which would then be overwritten. If you do decide to use that 
particular directory, make a backup of its content before proceeding.

f. At the Import Completed window, click Next.

Tip: During the installation, the setup procedure does not look for 
possible name conflicts between existing objects and new 
components from the Interaction Workflow Samples. It overwrites 
any existing objects.
In order to prevent the loss of existing objects, Genesys 
recommends you install the new samples into a separate tenant. 
Alternatively, you should use IRD’s Business processes export 
capability to create backups of workflows and strategies related to 
an existing configuration.

Tip: Do not select the StrategyFiles directory created during 
installation of your Interaction Workflow Samples as the target 
here. This causes file “collision,” since the source and target files 
are then identical.
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g. Click Finish.
Once you exit the wizard, you can view the new objects (over 180 of 
them) installed with these Samples, by opening the <tenant>\Scripts 
folder in Configuration Manager.

End of procedure

Next Steps

• Configuring Multimedia objects using the wizard

Procedure:
Configuring Multimedia objects using the wizard

Purpose:  To configure all Multimedia components required for a Multimedia 
solution. Use the Multimedia Configuration Wizards to launch the main wizard 
and any supplementary wizards necessary for your deployment.

This procedure provides values for a model setup on a single Windows host, 
with two databases. Substitute the model values for the values that you entered 
on your Configuration Worksheet on page 43.

Note: If you are deploying Co-browsing Server, you must install that 
component and the supporting third-party software, KANA Response 
Live Server, on a separate host from the Web API Server. Other than 
Co-Browsing Server, all other components can reside on the same host 
machine.

Prerequisites

• Installing the Multimedia Configuration Wizards, page 96
• Installing and Starting Interaction Workflow Samples, page 96
• Interaction Management CD (for Multimedia Objects)
• Management Framework CD (for adding DB Servers)
• Depending on the type of solution that you purchased, you also require the 

following CDs: 
Genesys Email CD
Knowledge Management CD
Genesys Web Media CD
Genesys Web Collaboration CD

• A license server running on the host computer
• A completed Configuration Worksheet (see Table 3 on page 43).
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Summary of the Wizards

The Multimedia Configuration Wizards consist of a main wizard and multiple 
secondary wizards, which are launched automatically when you indicate that 
you want to configure particular components. The wizard presents only those 
pages that are applicable for your deployment, or for the stage of deployment 
that you have reached.
Table 8 summarizes the flow of the main and secondary wizards to deploy the 
model setup. The information in the Key Actions and Inputs (Model Setup) 
column gives you the model-specific data inputs and actions for that section of 
the wizard. 

Table 8: Configuration Wizard Work Flow

Wizard Step Key Actions and Inputs (Model Setup)

1. Launch the Multimedia 
Configuration Wizard, 
page 105

Start > Programs > Genesys Solutions > 
Multi-Channel Routing 7.6.1 > 
Multimedia Configuration Wizards > 
Start Wizard Manager

2. Give your solution a name, 
page 105

Solution name: MM761

3. Select Simple or Custom 
Configuration, page 106

Select Custom Configuration.

4. Copy the IP to your shared 
directory, page 106

Copy the IP from the Interaction 
Management CD, and paste it to your shared 
directory. 
For more info, see Create a Shared Directory, 
page 94.

5. Select or add a Message 
Server, page 107

Add a Message Server from the existing 
Framework components.
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Add the Database Access Points 
and associated DB Servers:

At the Solution Components: Data Access 
Point page, click Add to launch the Database 
Access Points Wizard, which you run several 
times to create the following:
• Interaction Server DAP
• DB Server for Interaction Server database
• A shared DAP for Universal Contact 

Server and Co-Browsing Server
Note: You must create all required DAPs and 
DB Servers here, before moving on to other 
components. The wizard does not permit you 
to create DAPs later in the configuration.
If you intend to use the Event Logger 
functionality that is available in version 
7.6.1, you will need another DAP. 
Configuration and deployment of Event 
Logger is explained in the “Event Logger” 
section in the “Interaction Server: Advanced 
Topics” section of the “Ongoing 
Administration and Other Topics” chapter of 
the Multimedia 7.6 User’s Guide.

6. Create the Interaction Server 
DAP, page 107

Name = MM761_Ixn_DAP

7. Add the Interaction DB 
Server, page 107

Name = MM761_IxnDBServer
Host = MMHost
Default Port = 6110
DBMS Type = mssql

For the model setup, you can skip TLS 
Settings and Backup Server Information.
Select MM761_IxnDbServer to finish 
configuring the DAP.

Table 8: Configuration Wizard Work Flow (Continued) 

Wizard Step Key Actions and Inputs (Model Setup)
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8. Configure the Interaction 
Server DAP, page 108

DBMS Type = mssql
DBMS Name = MMHost
Database Name/SID = IxnDB
User Name = sa
Password = <password for user sa>
Case Conversion = any

Note: The Interaction Server DAP must have 
its Case Conversion attribute (on the DB 
Info tab) set to any or upper. Setting it to 
lower causes an error when Interaction 
Server initializes.

9. Create the Universal 
Contact Server DAP (Main), 
page 109

This DAP uses a JDBC connection. You do 
not need to create a DB Server, but make 
sure you enable JDBC access and clear the 
DBMS name.
DAP Name = MM761_UCS_DAP
Database Name/SID = Customer
JDBC Port = 1433
JDBC Role = Main

10. Add the Universal Contact 
Server, page 110

At the Solutions Components: Universal 
Contact Server Page, click Add to launch 
the Universal Contact Server Wizard.
Name = MM761_UCS
Server Host = MMHost
Server Default Port = 6120

11. Select the type of Interaction 
Server, page 111

• If you select New-Style Interaction 
Server, the wizard creates a multimedia 
Switch object for you. Continue at 
Step 13.

• If you select Switch-based Interaction 
Server and the wizard detects a properly 
configured Multimedia type Switch object, 
continue at Step 14.

• If you select Switch-based Interaction 
Server and the wizard does not detect a 
properly configured Multimedia-type 
Switch object, continue at Step 12.

For the model setup, select New-Style 
Interaction Server and continue at Step 13.

Table 8: Configuration Wizard Work Flow (Continued) 

Wizard Step Key Actions and Inputs (Model Setup)
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12. Create a Multimedia Switch 
object (Switch-based 
Interaction Server only), 
page 112

For Switch-based Interaction Server only. 
Our model setup uses the following names:
Switch = MM761_Switch
Switching Office = MM761_Switching_Office
Switch Type = Multimedia Switch

13. Configure Framework 
Resources, page 113

This wizard lists all current Framework 
resources (Agents, Places, and so on), and 
prompts you to create any missing resources 
that the solution requires. Note that:
• If you selected New-Style Interaction 
Server, this wizard launches before you 
configure the Interaction Server itself.

• If you selected Switch-based 
Interaction Server, this wizard launches 
as the last step in configuring the 
Interaction Server.

14. Configure the Interaction 
Server, page 115

Name = MM761_IxnSrv
Host = MMHost
Default Port = 6130
License Server Host = MMHost
License Server Port = 7260

15. Select a Stat Server, 
page 117

This wizard connects your existing Stat 
Server to all necessary components with one 
action—click ADD.

16. Add a Universal Routing 
Server, page 117

Add your existing Universal Routing Server 
to the solution.
For the full procedure, see page 117.

17. Add an Application Cluster, 
page 117

Use this wizard to group components for 
load-balancing. Otherwise, you can skip this 
step.

Table 8: Configuration Wizard Work Flow (Continued) 

Wizard Step Key Actions and Inputs (Model Setup)
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18. Add the Web API Server, 
page 118

For our model setup, enter the following 
values:
Name = MM761_WebAPIServer
Host = MMHost
Default Port = 80 (or 443 if using https)
Add connections to: Message Server, UCS, 
Stat Server, Interaction Server, SCS
You can also use this wizard to add .NET 
Web API Server & Samples. Follow the 
same steps, but copy the following 
installation package:
DotNetWebAPIServer_CompoundSamples

19. Add Web Compound 
Samples and Web Client, 
page 119

For our model setup, name the samples and 
client:
MM761_WebClient

20. Add the Universal Contact 
Server Manager, page 120

For our model setup, name the UCS 
Manager:
MM761_UCSMgr

Add a connection to UCS.

21. Select Additional CDs for 
Installation, page 121

Launch the wizards for the rest of your 
purchased components—the wizards launch 
one after another, depending on how many 
you select.
For the full procedure, see page 121

22. Add E-mail Server Java, 
page 121

Skip this step if your solution does not 
include e-mail interactions.
Name = MM761_E-mailServer
Port = 6150 

Add connections to: Message Server, 
Interaction Server, and UCS

POP Server Info
For the model setup, use MMHost as the POP3 
and SMTP server host. Adjust accordingly if 
your enterprise is using a POP3 server.
For details about creating addresses and 
accounts, and enabling web form e-mail, see 
the full procedure on page 121.

Table 8: Configuration Wizard Work Flow (Continued) 

Wizard Step Key Actions and Inputs (Model Setup)
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Complete the Knowledge 
Management Wizard:

Skip these steps if you did not purchase 
Knowledge Manager.

23. Add the Classification 
Server, page 123

Name = MM761_ClassificationServer
Port = 6160

Add connections to: Message Server, UCS, 
and Interaction Server

24. Add the Training Server, 
page 124

Name = MM761_TrainingServer
Port = 6170

Add connections to: Message Server and 
UCS.

25. Add the Knowledge 
Manager, page 124

Name = MM761_KnowledgeManager

26. Add the Chat Server, 
page 125

Skip this step if your solution does not 
include chat interactions.
Name = MM761_ChatServer
Port = 6180
ESP Server Port = 6182

Add connections to: Message Server, 
Interaction Server, and UCS

27. Add the Co-Browsing 
Server, page 126

Skip this step if your solution does not 
include co-browsing functionality.
Name = MM761_Co-BrowsingServer
Default Port = 6195

Add connections to: Message Server and a 
JDBC-based DAP (MM761_UCS_DAP in the 
model setup).

28. Create Capacity Rules, 
page 127

Select a folder in the Configuration Server 
where the rules will be stored, and then select 
the rules that Multimedia will use as its 
default.

29. Complete the wizard, 
page 127

If you quit the wizard before you reach this 
point, the solution details do not enter the 
Configuration Database. However, any 
components that you create remain available 
for further configuration.

Table 8: Configuration Wizard Work Flow (Continued) 

Wizard Step Key Actions and Inputs (Model Setup)
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Start of procedure

1.  Launch the Multimedia Configuration Wizard
a. To launch the Genesys Wizard Manager, from the Windows taskbar, 

select Start > Programs > Genesys Solutions > Multi-Channel 
Routing 7.6.1 > Multimedia Configuration Wizards > Start Wizard 

Manager.

b. Click log into the Configuration Layer. This opens the main Wizard 
Manager window (see Figure 20).

Figure 20: Wizard Manager

c. Select Multimedia from the menu on the left side of the window 
(Figure 20), and then select Deploy Multimedia Solution in your 
contact center. The Multimedia Configuration Wizard Welcome page 
opens.

d. Click Next to begin configuring Multimedia objects.

2.  Give your solution a name
At the Solution Name page, enter a name for your solution and click Next.

Name = MM761



106 Multimedia 7.6

Chapter 5: Model Configuration and Installation on Windows Configuring Multimedia Objects

3. Select Simple or Custom Configuration
a. At the Configuration Process Selection page, select one of the 

following:
• Simple single-host configuration

• Custom Configuration

For our model setup, select Custom Configuration, as shown in 
Figure 21.

Figure 21: .Configuration Process Selection

b. Click Next.

Note: The Simple single-host configuration option is available for a 
predefined host in Windows deployments only. This chapter describes 
the custom configuration process. If you choose the simple 
configuration with Windows, use this chapter by skipping those steps 
that the wizard does not present to you during deployment.

4. Copy the IP to your shared directory
a. At the Installation Package page, click Have Disk and navigate to the 

Interaction Management CD.
b. To select a destination for the package, click Browse and navigate to 

your shared directory (see “Create a Shared Directory” on page 94). 
Click Next.

Note: Multimedia uses this group of components for installation. In later 
steps you will copy to this directory installation packages that are 
specific to each Multimedia component.

c. At the Installation Ready page, confirm that your software is ready 
for installation and click Next.
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5. Select or add a Message Server
a. At the Solution Components: Message Server page, select or add a 

Message Server.
b. Click Next.

6. Create the Interaction Server DAP
At this point in the wizard, you begin creating your DAPs and associated 
DB Servers. You must create all DAPs and DB Servers here, before 
moving on to other components. The Multimedia Configuration Wizard 
does not permit you to create DAPs later in the configuration. Relaunch the 
Database Access Point Wizard as necessary.
a. At the Solution Components: Data Access Point page, click Add.
b. At the Browse for Application page, click the New Application icon 

as shown in Figure 22.

Figure 22: New Application Icon

c. Create a new DAP.
d. Enter your Database Access Point name:

Name = MM761_Ixn_DAP

7.  Add the Interaction DB Server
a. Click the folder icon beside DB Server, and then click the New 

Application icon to run the DB Server Wizard.
b. At the DB Server Name page, enter a name for your Interaction Server 

database:
Name = MM761_IxnDBServer

c. At the Server Information page, enter your host and port information:
Host = MMHost

Default Port = 6110

d. At the Installation Package page, copy the DB Server installation 
package. Select a source (the Management Framework CD) and a 
destination (the shared directory). Click Next.

e. At the Installation Ready page, confirm that your DB Server software 
is ready for installation, and then click Next.

f. At the Listening Ports and Transport Layer Security (TLS) 
Settings page, click Next.
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Note: For our model setup, we do not require any additional ports. If you 
want to install additional ports, you can do so in Configuration 
Manager later.

g. DBMS Type = mssql

h. Log Configuration: 
Click Next.

Note: For our model setup, we use only the default settings for all log 
options.

i. At the Backup Server Information page, because no backup servers are 
configured, clear the checkbox and click Next.

j. Click Finish to exit the DB Server Wizard. The Database Access Point 
Wizard will resume.

8.  Configure the Interaction Server DAP
a. Browse for Application (DB Server): 

Select the DB Server you just configured (MM761_IxnDBServer) and 
click OK.

b. Database Access Point Name and Type: 

The Name and DB Server are already filled in. Clear the Enable JDBC 
access box and click Next.

Note: It is important to clear the Enable JDBC access box. Failing to do 
so can lead to a configuration problem.

c. Database Information:
DBMS Type = mssql
DBMS Name = MMHost
Database Name/SID = IxnDB
User Name = sa
Password = <password for user sa>

d. Case Conversion = any

Note: The Interaction Server DAP must have its Case Conversion 
attribute set to any or upper. Setting it to lower causes an error when 
Interaction Server initializes.

e. Click Finish to complete the Database Access Point Wizard and return 
to the Multimedia Configuration Wizard.

f. Browse for Application: 
Select the Database Access Point that was just configured 
(MM761_Ixn_DAP) and click OK.
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9.  Create the Universal Contact Server DAP (Main)
For our model deployment, create a single DAP and database for both UCS 
and Co-Browsing Server. In your deployment, you can create both a Main 
database and an Archive database. You can also create a fourth database 
for Co-Browsing Server.

Note: UCS and Co-Browsing Server connect to their databases directly 
through JDBC. You do not need to create DB Server Application 
objects for these servers.

a. Solution Components: Database Access Point:
Click Add to open the Database Access Point Wizard. Click the New 
Application icon to configure a new DAP.

b. Database Access Point Name and Type:

Name = MM761_UCS_DAP

DB Server = [NONE]

Select Enable JDBC access.
c. Database Information: 

DBMS Type = mssql
DBMS Name = ““
Database Name / SID = Customer
User Name = sa
Password = <password for user sa>

Warning! If you do not clear the DBMS Name box, your UCS and your Co-
Browsing Server will not work properly.

d. JDBC Connection:

Host = MMHost

Port (for JDBC) = 1433 (Microsoft SQL default)
Role = Main

Note: If your RDBMS is Microsoft SQL Server on a different host, select 
the host where you have Microsoft SQL Server installed, and enter 
the connection information for that instance of the database.

e. Case Conversion = any

f. Click Finish to complete the Database Access Point configuration and 
return to the Multimedia Configuration Wizard.

g. Browse for Application:

Select the Database Access Point that was just configured 
(MM761_UCS_DAP) and click OK.

h. Click Next.
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Warning! If you are using a Microsoft SQL 2005 database, an additional 
configuration step is recommended for the UCS DAP.
In Configuration Manager, create a settings section on the 
Options tab. Create a new option, setting the option name as 
prepare and the option value to false.
For additional details, see the “Ongoing Administration and 
Other Topics” chapter of the Multimedia 7.6 User’s Guide.

10.  Add the Universal Contact Server
a. Solution Components: Universal Contact Server:

Click Add.
b. Browse for Application (Contact Server):

Click the New Application icon.
c. Universal Contact Server Name:

Name = MM761_UCS

d. Log Configuration:

Click Next.
e. Server Information:

Host = MMHost

Default Port = 6120

f. Universal Contact Server API Port:

Accept the default port value, or enter a port number where UCS 
should listen for third-party protocol connections. Click Next.

g. Application Connections: Message Server:

Click Add, select the Message Server, and then click Finish and Next.
h. Application Connections: Database Access Point:

Click Add, select MM761_UCS_DAP, and then click Finish and Next.
i. Universal Contact Server Login Account:

UCS uses the Configuration Layer to pass some of its information back 
and forth to certain components. Select the user account (Configuration 
Layer Person object) or Access Group that UCS is to use to log in to 
the Configuration Layer. The selected account or access group must 
have write access to the tenant in use.

Note: For more information on access requirements for this user account, 
see “Limitations: UCS” in the “Ongoing Administration and Other 
Topics” chapter of the Multimedia 7.6 User’s Guide.
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j. Installation Package:

i. Click Have Disk, navigate to the Interaction Management CD, and 
then click OK.

ii. Click Browse, navigate to your shared directory, and then click 
Next.

k. Installation Ready:

Click Next.
l. Click Finish to exit the Universal Contact Server Wizard and return to 

the Multimedia Wizard.
m. Browse for Application (Contact Server):

Select the Universal Contact Server and click OK.
n. Click Next.

11.  Select the type of Interaction Server
At the Interaction Server Selection page, select the type of Interaction 
Server that you plan to use. For the model setup, select New-style 
Interaction Server (see Figure 23).

Figure 23: Interaction Server Application Object Choice

• If you select New-Style Interaction Server, the Multimedia 
Configuration Wizard automatically creates a multimedia Switch object 
for you in the background. Continue at Step 13 on page 113.

• If you select Switch-based Interaction Server, the Multimedia 
Configuration Wizard checks for the required, telephony-related 
Configuration Layer resources.
— If your configuration includes a properly configured Multimedia 

type Switch object, continue at Step 14 on page 115.
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— If your configuration does not include a properly configured 
Multimedia type Switch object, continue at Step 12 on page 112.

Note: Before attempting to run your Multimedia solution, check 
Configuration Manager for the existence of a Multimedia Switch 
object. If for some reason the wizard has failed to create one, use 
the Framework Wizard to create it. No other configuration is 
required; the components that require this switch are able to locate 
it automatically. 

12.  Create a Multimedia Switch object (Switch-based 
Interaction Server only)

a. If you select Switch-based Interaction Server, the wizard checks for 
the following:

A Multimedia-type switch
A connection from the switch to a T-Server type Interaction Server

If the wizard fails to detect either the switch or its connection to 
T-Server, then it issues a warning (see Figure 24).

Figure 24: Switch Warning

b. Click Proceed to launch the Switch Wizard.

Note: You can use a preexisting Switch object (that is connected to a 
properly configured Interaction Server) from your Configuration 
Layer, if available.

Multimedia Switch
and Switching

Office

c. To create a new Multimedia type Switch object, provide a unique name 
for it and click Next. (The wizard allows you to create the new Switch 
only in folders designated to contain objects of type Switch.)
Name = MM761_Switch

Note: Even though the Configuration Layer permits assignment of 
multiple Switches of type Multimedia Switch to a single 
Interaction Server Application object, Genesys does not currently 
support such a configuration. This type of configuration can lead to 
unpredictable behavior on the part of the application that is 
connected to the switches.
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d. Switching Office:

Click Add to create a new Switching Office object. Provide the name 
and type, and click Finish.
Name = MM761_Switching_Office
Switch Type = Multimedia Switch

e. At the Switch Summary page, click Next. See Figure 25 for a sample 
summary of a Switch object’s properties.

Figure 25: Multimedia Switch Summary Information

13.  Configure Framework Resources
a. If you select New-Style Interaction Server, the wizard opens the 

Framework Resources page (see Figure 26 on page 114). This page lists 
the following:

Current Framework resources
Any missing resources required to support the media types served 
by your switch

b. To create the missing resources now, select Create missing objects 
and review the Framework resources again, and then click Next. For 
our model setup, select this optionmissing objects and review the 
Framework resources again, and then click Next. For our model setup, 
select this option. 
In your own deployment, you can choose to wait until after you finish 
the wizard to create the required objects. Select Continue the solution 
creation process with the Framework resources as they are now.
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Figure 26: Framework Resources

c. At the Framework Objects page, select the object type you want to 
create from the drop-down menu. For our model setup, create and 
configure the various objects as follows: 

Table 9: Framework Resource Object Types

Object Type Model Setup

Place Create Place objects to facilitate the routing of multimedia 
interactions:

Place Name = Agent1Place

Note: Do not create any DNs associated with this Place object, 
though you may want to create a Place Group object for this 
place, as suggested in the wizard.

Capacity Rule By default, as the final step of the solution’s configuration, the 
wizard creates and installs three capacity rules for your tenant. 
Do not create any capacity rules here (although you can, if you 
have previously installed the Resource Capacity Wizard, which 
is available on the Real-Time Metrics Engine CD).
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14.  Configure the Interaction Server
a. Solution Components: Interaction Server:

Click Add and then click the New Application icon to run the Interaction 
Server Wizard.

Note: If you use a switch-based Interaction Server in a multi-tenant 
environment, you need to install one Interaction Server per tenant 
that requires one. That is, for reporting purposes, a given 
Interaction Server cannot serve the needs of multiple tenants.

As a new feature introduced in the 7.2 release, use of the new style 
Interaction Server supports multi-tenancy. One Interaction Server 
can serve multiple tenants.

b. Interaction Server Name:
Name = MM761_IxnSrv

Agent Create Person objects to represent agents in your model setup 
and assign agent IDs to them. (Also use this step to create any 
Person objects you intend to use as the autoreply agents for 
supplying agent-related information in standard responses). 
Refer to the Framework 7 Deployment Guide for the full list of 
steps required to create Person objects. 

Agent Name = Agent One
Employee ID = Agent1
User Name = Agent1
Password = Agent1

Note: The agent values supplied here are for general use in this 
chapter’s model setup, and do not correspond to the actual 
steps suggested by the wizard for the creation of Person 
objects.
A Person object’s user name must be unique within the 
Configuration Database. This is not a concern for this model 
installation, which is in a single-tenant environment. If you 
were installing more than one Multimedia set of components in 
a multi-tenant environment, you would use distinct names 
across tenants.

Agent Login: Create Agent Login objects to enable agents to log in to the 
switch. The agent login code must correspond to the agent 
login numbering of your switch.

Skill: You do not need to create skills for this model installation.

Table 9: Framework Resource Object Types (Continued) 

Object Type Model Setup
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c. Log Configuration. Accept the default log settings and click Next.
d. Server Information:

Host = MMHost

Default Port = 6130

e. Use the Connection Wizard to connect to Message Server.
f. Application Connections: Database Access Point:

Add the DAP you created for Interaction Server, MM761_Ixn_DAP.
A message box will appear asking you to confirm the DAP settings. 
Click Yes to review the settings, and then click OK to confirm the 
settings. Click Next.

g. Application Connections: Servers for Third-Party Protocol

If you already installed related Multimedia components (Universal 
Contact Server, E-mail Server Java, and Classification Server, for 
instance), you can connect to them now using this page. 
For our model setup, click Next

h. License Server Connection:

Specify the license options to use (either a license host and port or a 
local filename) and click Next.
License Server Host = MMHost

License Server Port = 7260

i. Feature license counters:
Specify the number of licenses for Interaction Server features. Click 
Next.

j. Installation Package:

Copy the Interaction Server installation package. Select a source and 
destination. Click Next.

k. Installation Ready:

Confirm that your Interaction Server software is ready for installation, 
and then click Next.

l. Click Finish to exit the Interaction Server Wizard and return to the 
Multimedia Wizard.

m. Do one of the following:
• If you selected New-style Interaction Server, the wizard returns 

you to the Browse for Application (Interaction Server) page. 
Select the Interaction Server and click OK.

• If you selected Switch-based Interaction Server, the wizard asks 
if you want to configure Framework resources. Refer to Configure 
Framework Resources, page 113 for details on how to create 
resources you might need in your environment.

n. Click Next.
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15.  Select a Stat Server
Solution Components: Stat Server:

Click Add and select a Stat Server. This connects all the appropriate 
components in your Multimedia solution to this Stat Server.

Note: Even though the wizard allows you to create a Stat Server here, do 
not do so. Prior to using the wizard, you should have one Stat 
Server per Multimedia tenant already configured and installed in 
your environment. (Table 7 on page 93 lists prerequisite details.)

If you receive the warning message in Figure 27, this indicates that Stat 
Server does not yet have a connection to Interaction Server. This 
connection is required for both the routing and reporting of Multimedia 
interactions. 
• If you click Yes, you may receive an error message if the Stat Server 

wizard is not installed on your machine. The connection cannot be 
created at this time.

• If you click No (the recommended approach), make sure that you add 
the connection from Stat Server to Interaction Server before you 
attempt to use routing or reporting with the Multimedia solution.

Figure 27: Offer to Reconfigure Stat Server

16.  Add a Universal Routing Server
At the Universal Routing Server (URS) page, select the URS that you 
created and installed as one of the prerequisites for your Multimedia 
installation. If you receive a warning message similar to the one shown in 
Figure 27, but stating that URS is not configured to monitor Interaction 
Server, click Yes to reconfigure now, or click No to reconfigure later.

17.  Add an Application Cluster
At the Application Cluster page, add an application cluster if you intend 
to group your Multimedia components into groups for load-balancing 
purposes. After giving a name to your new application cluster, the 

Tip: If you click No, make sure you add the required connections after 
configuration and installation are complete. For more information, see 
Verifying Connections, page 137
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Application Cluster Wizard invites you to group, for instance, Chat Server, 
E-mail Server Java, and Web API Server, as well as other application 
clusters. See Figure 28.

Figure 28: Application Connections in Application Cluster Wizard

18.  Add the Web API Server
a. Solution Components: Web API Server:

Click Add and then click the New Application icon to run the Web API 
Server Wizard.

b. Web API Server Name:

Name = MM761_WebAPIServer

c. Log Configuration:

Accept the default log settings and click Next.

Warning! For Web API Server .NET, you must use Configuration 
Manager to specify the full path of your log file in the log/all 
section of the Options tab in your Web API Server Application 
object. If only a file name is specified, Web API Server does 
not create a log file.
Full permissions should be granted to the Everyone user for the 
folder containing your log file.

d. Server Information:
Enter the server information, and click Next.
Host = MMHost

Default Port = 80 (Use your web server’s http port here. The value 
might be 443 if you are using the https port.)

e. Application Connections: Message Server:

Use the Connection Wizard to connect to Message Server. Click Next.
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f. Application Connections: Servers for Load Balancing:

Connect to the applications that Web API Server will use for load 
balancing and click Next. Such applications might include Chat Server 
and E-mail Server Java, if you have them. If you do not have them, 
click Next.

g. Application Connections: Universal Contact Server:
Use the Connection Wizard to connect to Universal Contact Server. 
Click Next.

h. Application Connections: Stat Server:
Use the Connection Wizard to connect to Stat Server. Click Next.

i. Application Connections: Interaction Server:
Use the Connection Wizard to connect to Interaction Server. Click 
Next.

j. Application Connections: Solution Control Server:
Use the Connection Wizard to connect to Solution Control Server. 
Click Next.

Note: Web API Server will not work without a connection to Solution 
Control Server.

k. Installation Package:

Copy the Web API Server installation package. Select a source and 
destination. Click Next.

l. Installation Ready:

Confirm that your Web API Server software is ready for installation, 
and then click Next.

m. Click Finish to exit the Web API Server Wizard and return to the 
Multimedia Wizard.

n. Browse for Application (Web API Server):
Select the Web API Server and click OK.

o. Click Next.

19.  Add Web Compound Samples and Web Client
a. Solution Components: Web Compound Samples:

Click Add, and then click the New Application icon to run the Web 
Compound Samples Wizard. The Web Compound Samples enable you 
to begin configuring and working with components that handle 
interactions that arrive in your contact center through a website. The 
procedure for adding the Web Compound Samples includes creating 
and configuring a Web Client object in the Configuration Layer. The 
Web Client serves as an account for interactions that arrive through the 
Web API Server.
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Note: For environments using WebSphere and WebLogic, the samples 
are presented as part of an enterprise archive (EAR) project.

b. Web Compound Samples Name:

Name = MM761_WebClient

c. Installation Package:

Copy the Web Compound Samples installation package. Select a 
source and destination. Click Next.

d. Installation Ready:

Confirm that your Web Compound Samples software is ready for 
installation, and then click Next.

e. Click Finish to exit the Web Compound Samples Wizard and return to 
the Multimedia Wizard.

f. Browse for Application (Web Client):
Select the Web Client and click OK.

g. Click Next.

20.  Add the Universal Contact Server Manager

a. Solution Components: Universal Contact Server Manager:

Click Add and then click the New Application icon to run the Universal 
Contact Server Manager Wizard.

b. Universal Contact Server Manager Name:
Name = MM761_UCSMgr

c. Application Connections: Universal Contact Server:
Use the Connection Wizard to connect to Universal Contact Server. 
Click Next.

d. Installation Package:

Copy the UCS Manager installation package. Select a source and 
destination. Click Next.

e. Installation Ready:

Confirm that your UCS Manager software is ready for installation, and 
then click Next.

f. Click Finish to exit the Universal Contact Server Manager Wizard and 
return to the Multimedia Wizard.

g. Browse for Application (Contact Server Manager):
Select the Universal Contact Server Manager and click OK.

h. Click Next.
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21.  Select Additional CDs for Installation
Based on how you plan to implement Multimedia, identify any additional 
CDs you need to complete this installation.
The list of CDs that the wizard presents (shown in Figure 29) may include 
some you have not purchased. Select only those CDs that apply to your 
environment. For the purposes of the model environment, this section 
describes an installation using all possible CDs. If you select more than 
one CD, the wizard presents the appropriate component-related wizards in 
order.

Figure 29: Other CDs for Multimedia Installation

22.  Add E-mail Server Java
a. Solution Components: E-mail Server Java:

Click Add and then click the New Application icon to run the E-mail 
Server Java Wizard.

b. E-mail Server Java Name:

Name = MM761_E-mailServer

c. Log Configuration:

Accept the default log settings and click Next.
d. Server Information:

Host = MMHost
Default Port = 6150

e. Use the wizard to connect to Message Server, Interaction Server, and 
Universal Contact Server.

f. The Names of the POP3 and SMTP Servers:

POP3 server name = MMHost

POP server type = POP3

SMTP server name = MMHost
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Notes: This model installation uses MMHost as its POP3 and SMTP 
servers.

If you are using your enterprise POP3 server, enter its name as the 
POP3 server name value. You do not need to enter a value for the 
SMTP server name if it is the same server that you used for POP3 
server name.

g. POP3 User Name:

Add information about the e-mail account identified as the 
administrator on the POP3 server.
• Address = <mailboxName>@MMHost
• User name = <username>
• Password = <password>

h. Default Domain for E-mail Addresses:

E-mail address default domain name = MMHost

i. External Agent E-mail Address:

External Agent e-mail address = external@MMHost

j. Web Form Processing:

Enable Web Form Processing by selecting the check box, and provide a 
port where the Web API Server should listen for requests—for example 
IWF Processing Port = 7777. (See Figure 30.)

Figure 30: Information for Web Form Processing

k. Automated Reply Agent:

This e-mail address is used to supply field values in automated 
responses generated in the contact center. Select an existing Person 
object from the Configuration Layer.

l. Auto-reply Agent = Agent1
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m. Installation Package:

Copy the E-mail Server Java installation package. Select a source and 
destination. Click Next.

n. Installation Ready:

Confirm that your E-mail Server Java software is ready for installation, 
and then click Next and Finish.

o. Browse for Application (E-mail Server):

Select the E-mail Server and click OK.
p. E-mail Accounts:

Configure e-mail accounts that exist on your corporate e-mail server 
for customers to use when contacting your company—for example:
Customer access account 1 = <mailboxName1>@MMHost

Customer access account 2 = <mailboxName2>@MMHost

Note: If you installed the Interaction Workflow Samples, then your 
configuration will automatically include the following three e-mail 
accounts (which are used in the samples): 
Customer support, Tech support, and Warranty support.

If you did not install the Interaction Workflow Samples before 
running the wizard, then no e-mail accounts are shown. You must 
add and configure at least one e-mail account before continuing.

q. Click Finish to exit the E-Mail Wizard.

23.  Add the Classification Server
If you selected the Knowledge Management CD in Step 21 on page 121, 
the wizard now guides you through the configuration of the Classification 
Server, Training Server, and Knowledge Manager.
a. Solution Components: Classification Server:

Click Add, and then click the New Application icon to run the 
Classification Server Wizard. 

b. Classification Server Name:

Name = MM761_ClassificationServer

c. Log Configuration:

Accept the default log settings and click Next.
d. Server Information:

Host = MMHost

Default Port = 6160

e. Application Connections:

Use the wizard to connect to Message Server, Universal Contact 
Server, and Interaction Server.
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f. Access to License:

Specify the license options to use (either a license host and port or a 
local filename) and click Next.
License Server Host = MMHost

License Server Port = 7260

g. Installation Package:

Copy the Classification Server installation package. Select a source 
and destination. Click Next.

h. Installation Ready:

Confirm that your Classification Server software is ready for 
installation, and then click Next.

i. Click Finish to exit the Classification Server Wizard and return to the 
Knowledge Management Wizard.

j. Browse for Application (Classification Server):

Select the Classification Server and click OK.

24.  Add the Training Server
a. Solution Components: Training Server:

Click Add, and then click the New Application icon to run the Training 
Server Wizard.

b. Training Server Name:

Name = MM761_TrainingServer

c. Log Configuration:

Accept the default log settings and click Next.
d. Server Information:

Host = MMHost

Default Port = 6170

e. Use the Connection Wizard to connect to Message Server and 
Universal Contact Server.

f. Installation Package:

Copy the Training Server installation package. Select a source and 
destination. Click Next.

g. Installation Ready:

Confirm that your Training Server software is ready for installation, 
and then click Next.

h. Click Finish to exit the Training Server Wizard and return to the 
Knowledge Management Wizard.

i. Browse for Application (Training Server):
Select the Training Server and click OK.

25.  Add the Knowledge Manager
a. Solution Components: Knowledge Manager:

Click Add, and then click the New Application icon to run the 
Knowledge Manager Wizard.
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b. Training Server Name:

Name = MM761_KnowledgeManager

c. Use the Connection Wizard to connect to Universal Contact Server.
d. Knowledge Manager Options:

Indicate that you have a Classification Server Content Analysis license 
installed by selecting the check box of the same name. If you do not 
have this license, do not select this check box.

e. Installation Package:

Copy the Knowledge Manager installation package. Select a source 
and destination. Click Next.

f. Installation Ready:

Confirm that your Knowledge Manager software is ready for 
installation, and then click Next.

g. Click Finish to exit the Knowledge Manager Wizard and return to the 
Knowledge Management Wizard.

h. Browse for Application (Knowledge Manager):

Select the Knowledge Manager and click OK. Click Finish to exit the 
Knowledge Management Wizard.

26.  Add the Chat Server
a. Solution Components: Chat Server. 

Click Add, and then click the New Application icon to run the Chat 
Server Wizard.

b. Chat Server Name:

Name = MM761_ChatServer

c. Log Configuration. Accept the default log settings and click Next.
d. Server Information:

Host = MMHost

Port = 6180

e. Use the Connection Wizard to connect to Message Server, Interaction 
Server, and Universal Contact Server.

f. Extended Service Protocol Settings:

Identify what port and nickname you want to use for Extended Service 
Protocol (ESP) chat. (See Figure 31.)
ESP refers to the ability of URS to submit messages directly from a 
strategy into a chat session—for example, to greet a customer who is 
waiting for an agent.
Click Next.
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Figure 31: Configure ESP Settings for Chat Server

g. Installation Package:

Copy the Chat Server installation package. Select a source and 
destination. Click Next.

h. Installation Ready:

Confirm that your Chat Server software is ready for installation, and 
then click Next.

i. Click Finish to exit the Chat Server Wizard and return to the Genesys 
Web Media Wizard.

j. Browse for Application (Chat Server):

Select the Chat Server and click OK. Click Next.
k. Click Finish to exit the Genesys Web Media Wizard.

27.  Add the Co-Browsing Server
a. Solution Components: Co-Browsing Server:

Click Add, and then click the New Application icon to run the Co-
Browsing Server Wizard.

b. Co-Browsing Server Name:

Name = MM761_Co-BrowsingServer

c. Log Configuration:

Accept the default log settings and click Next.
d. Server Information

Host = MMHost2

Default Port = 6195

Tip: You must install Co-Browsing Server and the supporting third-
party software, KANA Response Live Server, on a separate host 
from the Web API Server—MMhost2 for the model setup. To install 
and configure Kana Response Live, see “Deploying KANA 
Response Live for co-browsing” on page 74.
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e. Use the wizard to connect to Message Server and a JDBC-based DAP. 
(You can use the MM761_UCS_DAP that you created.)

f. Installation Package:

Copy the Web Collaboration installation package. Select a source and 
destination. Click Next.

g. Installation Ready:

Confirm that your Co-Browsing Server software is ready for 
installation, and then click Next.

h. Click Finish to exit the Co-Browsing Server Wizard and return to the 
Genesys Web Collaboration Wizard.

i. Browse for Application (Co-Browsing Server):
Select the Co-Browsing Server and click OK. Click Next.

j. Click Finish to exit the Genesys Web Collaboration Wizard and return 
to the Multimedia Configuration Wizard.

k. Solution Components: Web API Server:
Follow the on-screen instructions to configure servers for load 
balancing. Click Next.

28.  Create Capacity Rules
a. Resource Capacity Rules Deployment:

Select a folder in the Configuration Server where Multimedia should 
store its resource capacity rules. Click Next.

b. Resource Capacity Rules Selection:

From the drop-down menu, select the capacity rule you want to use as 
the default for Multimedia. The wizard assigns that rule to the Tenant 
object associated with your deployment in the previous step. Click 
Next.

29.  Complete the wizard
a. Solution Summary:

At this point the wizard lists the solution components you have 
collected for use with Multimedia. Click Next to finish the 
configuration or Back to change the configuration of some solution 
component. See Figure 32 on page 128 for a sample of the Solution 
Summary page.
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Figure 32: Solution Summary

b. Completing the Multimedia Solution Wizard:

Click Finish to confirm your solution configuration. Remember that 
you can change configuration details at a later time as well.

Note: Only at this point, when you exit the wizard, are the details of your 
solution configuration entered into the Configuration Database. Exiting 
the wizard prior to this point requires that you begin the solution 
configuration from the beginning. Any components you create along 
the way, however, are available during subsequent solution 
configuration using the wizard.

End of procedure

Next Steps

• For Chat Server, Genesys recommends that you specify an additional port 
for dedicated communication with Web API Server: see Specifying a 
webapi-port for Chat Server, page 129.

• If you want Chat Server to use the same port for communicating with both 
Web API Server and your call center agents (not recommended), then 
continue at Performing an integrated installation of all Multimedia servers, 
page 131
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Procedure:
Specifying a webapi-port for Chat Server

Purpose:  To establish a dedicated port for Chat Server communication with 
Web API Server.

Note: Chat Server can function using a single port for communicating with 
both web clients and agents. However, for system security Genesys 
recommends that you specify an additional webapi-port, which allows 
only web clients to communicate through it. Only this port should be 
opened/exposed to outside connections, thus prohibiting agent 
connections over a firewall.

Start of procedure

1. In Configuration Manager, on the Options tab, double-click Settings.
2. Double-click webapi-port, and then enter the model setup value of 6181. 

Refer to the Configuration Worksheet, page 43 if using different values 
than the model.

3. Click OK, then OK again.
Your change takes effect immediately.

End of procedure

Next Steps

• Performing an integrated installation of all Multimedia servers, page 131

Installing Multimedia Components
This section describes the installation process for Multimedia 7.6.1 
components after you have finished configuring them with the wizards.
For Windows-only installations and the Windows portions of Solaris, Linux, 
and AIX installations, Genesys provides an installation package that integrates 
the installation of most or all Multimedia 7.6.1 components. The installation 
package is copied to one host as part of the process of running the Multimedia 
Configuration Wizards. Start IPStarter.exe, located in the Windows/ 
subdirectory of your installation directory, one time for each Windows host 
that is part of your Multimedia deployment. (Each time you run 
IPStarter.exe, you are installing the appropriate components for the given 
Windows host.)
For Solaris, Linux, or AIX installations, after going through the configuration 
process, install Multimedia components by first manually copying them from 
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their deployed locations (where the wizards placed them) to each Solaris, 
Linux, or AIX host. Then manually install each component separately by 
launching its own setup. Detailed information on Solaris, Linux, and AIX 
installations is available in “Deploying Multimedia on UNIX Hosts” on 
page 153.

Note: For all platforms, you need to install the Third Party Components, 
before installing individual components. (This does not affect Chat 
Server, Interaction Server, and Co-Browsing Server.)
On Windows, if you use IPStarter.exe, that executable takes care of 
this for you automatically. On each Solaris, Linux, or AIX host, 
however, you must manually run the Third Party Components setup 
before you run the setup for the other Multimedia components on that 
host.
For an explanation of the difference between Third Party Components 
(executable) and ThirdPartyApplications (directory), see the note on 
page 55.

For the purposes of this section, the host where you have the Multimedia 
installation directory is called the local host. Any other hosts that you 
configured to receive Multimedia components are called remote hosts.

Generalized Installation Procedure
The general outline of how the integrated installation proceeds is as follows:
1. Local host

a. The installer presents a list of Multimedia components that you 
configured to run on the local host, and asks you to verify it. 

b. The installer presents a list of components for which you did not 
specify a host, and asks if you want to install them on the local host.

c. The installer installs the appropriate components on the local host. 
2. Remote hosts

a. From each remote host in turn, you must access the installation 
package from its shared directory on the local host (see “Create a 
Shared Directory” on page 94). 

b. The installation package then begins to install on the remote host.
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Individual
Component
Installation

If for some reason you want to install individual components rather than using 
the integrated installation package, be aware that the directory structure of the 
individual installation packages looks like this:

<componentA>
AIX
Linux
Solaris
Windows

<componentB>
AIX
Linux
Solaris
Windows

...

aix
ThirdPartyComponents

linux
ThirdPartyComponents

solaris
ThirdPartyComponents

windows
Configuration Wizards
ThirdPartyComponents

That is, for each Multimedia component other than Common and Third Party 
Components, there is a directory named for the component. That directory 
contains subdirectories holding the installation packages for the supported 
operating systems.
To perform an integrated installation of all Multimedia Servers, see the next 
section.

Procedure:
Performing an integrated installation of all Multimedia 
servers

Start of procedure

1. Starting the Integrated Installation
a. Go to your shared directory, on which you had the Genesys Wizard 

Manager place the Multimedia components (for example, 
\\MMHost\GenesysSetup). Find and run windows\IPStarter.exe.

b. At the Welcome window, click Next to proceed.
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c. If any components were not assigned to a specific computer while 
running the Configuration Wizards, the Host independent components 
dialog page lists those components. Select the check box of any of 
these components that you want to install on the current machine (the 
host computer of the installation package). Click Next.

d. At the Ready to start dialog page, click Next to proceed.
e. The Integrated Installation takes you through each component’s 

necessary installation steps. Prior to each subsequent component’s 
installation, the installer displays a list of component directories (see 
Figure 33) containing:
• Components that have been installed, each with a green check 

mark next to it.
• Components not yet installed, with no markings next to them.
• The component to be installed next, with a blue check mark next to 

it. 

Figure 33: Deployment Status Window

2. Installing Third Party Components 

Note: For an explanation of the difference between Third Party 
Components (executable) and ThirdPartyApplications (directory), 
see the note on page 55.

a. On the Servlet Engine page, select your web application container and 
click Next.

b. On the Choose Servlet Location page, enter the location of your web 
application container and click Next.
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c. Confirm the location of your Multimedia Third Party Components and 
click Install.

d. Click Finish.
3. Installing Configuration Wizards 

If you do not already have the Genesys Multimedia Configuration Wizards 
installed on this host, the Installation Starter will install them for you in the 
existing Wizards directory. You may need to restart your host after 
Multimedia Configuration Wizards installation.
If you already have the Genesys Multimedia Configuration Wizards 
installed on this host, click Cancel on the first page of the Multimedia 
Configuration Wizards setup.

4. Installing Universal Contact Server
a. Click Next, and then click Install.
b. Click Finish.

Note: Once you install any given Multimedia component on your 
computer, the wizard uses that directory for all other Multimedia 
components. You are not allowed to install these components 
across different directories.

5. Installing Interaction Server
a. Click Next, then Install, if ready for installation.
b. Click Finish.

6. Installing Web API Server

Note: If Co-Browsing Server is going to be installed with Web API Server on 
the same host, then you must install KANA Response Live Server first. 
See “Deploying KANA Response Live for co-browsing” on page 74 
for details.

In addition to following the steps listed here, installing the Web API Server 
requires that you refer back to the installation of your web server and your 
web services container. Installation of those components is described in 
Chapter 4, “Deploying Third-Party Web Applications,” on page 55.
To install the Web API Server:
a. Select from the list the Web API components (as in Figure 34) to be 

installed. Click Next.
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Figure 34: Web API Server Component Choices

b. Select the web server and web application container. Click Next.
c. Browse to the web server location. Click Next.
d. Browse to the web application container location. Click Next.
e. Confirm the location of the worker.properties file you created during 

installation of the web application container (<CATALINA_HOME>\conf\jk 
directory). Click Next.

f. Select the worker.properties file. Click Next.
g. Select the ajp13 worker. Click Next.
h. Select a server-side code page—that is, the preferred language for 

processing all requests to Web API Server. Click Next.
i. At the Start Copying Files page, confirm your current settings. Click 

Next.

j. Click Yes, and then Finish.
7. Installing E-Mail Server Java

a. Click Next, then Install if ready for installation.
b. Click Finish.

8. Installing Classification Server
a. Click Next, then Install if ready for installation.
b. Click Finish.

9. Installing Training Server
a. Click Next, then Install if ready for installation.
b. Click Finish.
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10. Installing Chat Server
a. Click Next, then Install if ready for installation.
b. Click Finish.

11. Installing Universal Contact Server Manager
a. Click Next, and then Install.
b. Click Finish.

12. Installing Knowledge Manager
a. Click Next, then Install.
b. Click Finish.

Note: Beginning in release 7.6.1, the error log is written to the following 
location: Documents and Settings\<local account>\My 
Documents\KM_ErLog. The log is generated when Knowledge 
Manager is started. This change was made to comply with Vista 
security systems.

13. Installing Web Compound Samples
a. Confirm the list of necessary samples to be installed. Click Next.
b. Select the web server and web application container. Click Next.
c. Browse to the web server location. Click Next.
d. Browse to the web application container location. Click Next.
e. Confirm the location of the worker.properties file you created during 

installation of the web application container (<CATALINA_HOME>\conf\jk 
directory). Click Next.

f. Select the same worker file used for your Web API Server installation. 
Click Next.

g. Select the ajp13 worker. Click Next.
h. Select the tenant ID. Click Next.
i. Confirm the system configuration information about Co-Browsing 

Server. Click Next.
j. On the Specify code page indicate the preferred language for 

processing requests to samples. Click Next.
k. On the Webstarter Configuration page, confirm your settings. Click 

Next.
l. Click Finish.

14. Installing Co-Browsing Server
a. Enter the fully qualified domain name of the web server and the unique 

server identifier. Click Next.
b. Browse to the root folder containing your KANA Response Live 

server. (See “Deploying KANA Response Live for co-browsing” on 
page 74.) Click Next.
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c. Browse to the destination folder where the application will be installed, 
and click Next.

d. Click Install, then Finish.
The integrated installation is now complete.

End of procedure

Next Steps

• Creating Databases and Running Scripts

Creating Databases and Running Scripts
If you have not already done so, create the databases for Interaction Server, 
Universal Contact Server, and Co-Browsing Server. For UCS, you may also 
want to create an Archive database to store older UCS data and ease storage in 
the Main UCS database.

Note: If you intend to use the Event Logger functionality that is available in 
version 7.6.1, you will need to create another database and run the 
corresponding script. Configuration and deployment of Event Logger 
is explained in the “Event Logger” section in the “Interaction Server: 
Advanced Topic” section of the “Ongoing Administration and Other 
Topics” chapter of the Multimedia 7.6 User’s Guide.

Procedure:
Running scripts for your databases

Start of procedure

1. At the starting directory for each component, locate the SQL script folder:

2. Run the database scripts for each component.

Component Script Folder
Interaction Server Script

UCS sql-scripts

Co-Browsing Server dbscripts
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Note: Only one Universal Contact Server database pair (Main and 
Archive) is allowed per Tenant.

End of procedure

Next Steps

• Verifying connections

Verifying Connections
At this point in the Multimedia installation process, you must update the 
configuration settings for some components before continuing. Refer to 
Table 4 on page 52 for a list of connections that must be set in the 
Configuration Layer. Refer to the Multimedia 7.6 Reference Manual for 
information on option settings.

Procedure:
Verifying connections

Start of procedure

1. In Configuration Manager, verify that the required connections have been 
made in the Multimedia Application objects. See Table 4 on page 52 for a 
detailed list of the connections you need to add to the Multimedia objects.

2. Add a connection from Stat Server to Interaction Server.
3. Add a connection from Universal Routing Server to Interaction Server.

End of procedure

Next Steps

• Testing the Multimedia servers

Testing Multimedia Components
The minimum required components for testing include:
• Local Control Agent
• DB Server
• Configuration Server
• Message Server
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• Solution Control Server
• Solution Control Interface
• Stat Server
• Universal Routing Server

Procedure:
Testing the Multimedia servers

Purpose:  To test that the Multimedia servers will successfully launch and run 
free of errors. 

Prerequisites

• Before testing the Multimedia servers, ensure that both Universal Contact 
Server and Interaction Server have connections to Stat Server (if you have 
not already made these connections).

• Confirm that both Stat Server and Universal Routing Server have 
connections to Interaction Server.

• Be sure Genesys Framework is running. 
• Before testing chat and web form e-mail, restart the host(s) running the 

Chat Server, and ensure that your POP3 e-mail server is up and running.

Start of procedure

1. Start the servers in this order:
a. DB Server for Interaction Server
b. Interaction Server
c. Universal Contact Server
d. E-mail Server Java
e. Chat Server
f. Classification Server
g. Training Server
h. Co-Browsing Server
i. Web Server and Web Application Container for Web API Server 

launch
2. After each server starts, check its console window for errors.

End of procedure

Tip: General instructions for starting and stopping your Multimedia 
solution are in Chapter 11 on page 193. This section provides startup 
instructions for the sole purpose of testing your solution.
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Next Steps

• Testing the components using the Web-based TestTool761

Procedure:
Testing the components using the Web-based 
TestTool761
An application for testing the components, called TestTool761, is included as 
part of the installation of Web API Server. Use this tool to test the various Java 
classes and servlets that run the Multimedia solution

Start of procedure

1. Open a web browser window and enter the following URL:
http://<WebAPIServerhost>/TestTool761

Note: The address used to access the testing application is case sensitive.

You should see a window that looks like the one in Figure 35. 

Figure 35: Multimedia 7.6.1 Test Tools Page

2. Click any of the links to launch the various testing tools. The results of the 
test display in the bottom frame of the web page.

End of procedure

Next Steps

• Testing that Genesys Desktop can handle interactions
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Procedure:
Testing that Genesys Desktop can handle interactions

Purpose:  To log in the Genesys Desktop agent that will receive test 
Multimedia interactions (e-mail, chat, and web e-mail).

Test agent handling of interactions by configuring and installing Genesys 
Desktop. For instructions on how to do this, see the Genesys Desktop 7.6 
Deployment Guide.

Note: After installing Genesys Desktop, use Configuration Manager to 
ensure that the Desktop Application object has a connection to your 
Interaction Server or if applicable, Interaction Server Proxy.

Start of procedure

1. Enter the following URL into your web browser:
http://<Host_IP_Address:port>/gdesktop

2. To log in an agent, enter the following information:
• Agent ID
• Password
• The name of the agent’s associated Place

End of procedure

Next Steps

• Testing the Setup

Testing the Setup
Next you should test your installation’s functionality. This requires that you 
implement an interaction workflow. The workflow and its associated routing 
strategies can be very simple. The simplest way to test the setup is to use the 
ABC Simple BP and the ABC Simple Chat BP business processes that are 
installed as part of your Interaction Workflow Samples installation.

Using the Sample Business Processes
The ABC Simple BP receives e-mail interactions that enter the system and 
delivers them to an agent group. This business process also allows the agent 
who works on a given interaction to reply to it and send a resulting outbound 
e-mail. The ABC Simple Chat BP does essentially the same thing, but for chat 
interactions; it receives chat interactions that enter the system and delivers 
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them to an agent group. See the Universal Routing 7.5 (or later) Business 
Process User’s Guide for more details on these and the other sample business 
processes. That guide also describes how to work with strategies and queues in 
the Interaction Design portion of IRD. 

Procedure:
Configuring ABC Simple BP for routing e-mail 
interactions

Start of procedure

1. Set E-mail Server Java default-inbound-queue option (in the email-
processing section) to the value Inbound queue, which is the name of the 
inbound queue in ABC Simple BP.

Note: If you installed the Interaction Workflow Samples before using the 
wizard installation, you will find that two Interaction Queue 
objects named Inbound queue and Outbound queue already exist in 
your <Tenant>\Scripts folder in Configuration Manager. Use the 
Inbound queue name as the value for this E-mail Server Java 
default queue option.

2. The Person object you plan to use for handling e-mail interactions must be 
a member of the Agent Group named E-mail distribution for 
processing, which serves as a target for interactions in the Process ABC 
strategy of this sample business process.

3. From the Interaction Design portion of IRD, if they are not already 
activated, activate the two strategies that this business process uses, 
Process ABC and Send ABC.
See the Universal Routing 7.5 (or later) Business Process User’s Guide and 
Universal Routing 7.6 Interaction Routing Designer Help for additional 
instructions on creating and activating/loading routing strategies.

End of procedure

Next Steps

• Configuring ABC Simple Chat BP for routing chat interactions
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Procedure:
Configuring ABC Simple Chat BP for routing chat 
interactions

Start of procedure

Be sure you have set the following prior to testing this workflow:
1. If you installed the Interaction Workflow Samples before using the wizard 

installation, you will find that an Interaction Queue object named Chat 
inbound queue already exists in your <Tenant>\Scripts folder in 
Configuration Manager. That queue is also the value for the Chat Server 
default option (in the endpoints:<tenant_id> section). Make sure this is 
the case.

2. The Person object you plan to use for handling chat interactions must be a 
member of the Agent Group named Chat distribution for processing, 
which serves as a target for interactions in the Chat inbound strategy 
strategy of this sample business process.

3. From the Interaction Design portion of IRD, if they are not already 
activated, activate the three strategies this business process uses: Chat send 
transcript email strategy, Chat request transcript send strategy, 

and Chat inbound strategy.
See the Universal Routing 7.5 (or later) Business Process User’s Guide and 
Universal Routing 7.6 Interaction Routing Designer Help for additional 
instructions on creating and activating/loading routing strategies.

End of procedure

Next Steps

• Sending a test e-mail to a Desktop agent

Procedure:
Sending a test e-mail to a Desktop agent

Purpose:  To send a test e-mail from your installed Multimedia solution to a 
Genesys Desktop agent using the ABC Simple BP routing strategy.

Start of procedure

1. If you have not already started the necessary components (as noted in 
“Testing Multimedia Components” on page 137), do so now.

2. Open your e-mail client and send an e-mail to the POP box that E-mail 
Server Java checks (the value of that component’s address option).
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3. Ready an agent at the Genesys Desktop and look for the arrival of the 
e-mail interaction.

4. If the inbound e-mail fails (for example, E-mail Server Java does not see 
the message or E-mail Server Java sends the message to a bad directory), 
check each of the E-mail Server Java options, logs, and the routing 
strategies for possible errors.

End of procedure

Next Steps

• Starting a test chat session with a Desktop agent

Procedure:
Starting a test chat session with a Desktop agent

Purpose:  To start a test chat session between a sample customer from the Web 
Client and a Genesys Desktop agent, using the Web Client and the ABC 
Simple Chat routing strategy.

Start of procedure

1. Start the web server and the web application container, if you have not 
already.

2. If you have not already started the necessary components (as noted in 
“Testing Multimedia Components” on page 137), do so now.

3. Ready an agent at the Genesys Desktop.
4. Start the Web Client by opening a browser and selecting a Chat link from 

http://<WebAPIServerhost>/WebAPISamples761.

5. Click Chat Sample with user typing notification.
6. Fill in customer data and click Start Chat.
7. Look for the arrival of the chat interaction at the Genesys Desktop.
8. If chat does not work (for example, a disconnected from chat server 

message appears or the customer joins but the agent does not), check each 
of the manual install steps. Specifically, check the:

Chat Server options.
Web API Server options.
WebAPISamples761 parameters, contained in the constants.jsp file.

End of procedure
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Next Steps

• Sending a test web form e-mail to a Desktop agent

Procedure:
Sending a test web form e-mail to a Desktop agent

Purpose:  To send a test web form e-mail from the Web Client to a Genesys 
Desktop agent.

Start of procedure

1. If you have not already started the necessary components (as noted in 
“Testing Multimedia Components” on page 137), do so now.

2. Start the Web Client by opening a browser and clicking the E-mail over 
the Web sample link from http://<WebAPIServerhost>/WebAPISamples761.

3. Fill in customer data and click Submit.
4. Ready an agent at the Genesys Desktop and look for the arrival of the web 

form e-mail interaction.
5. If web form e-mail does not work (for example, no thank you page 

displays, a thank you page displays with an error, or a thank you page 
displays but the e-mail never pops to the desktop), check each of the 
manual install steps.

End of procedure

Next Steps

• You have completed all steps for testing the setup of Multimedia 7.6.1.
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6 Deploying an E-Mail System 
in Secured Mode
This chapter describes how to configure an e-mail system to work in secured 
mode using SSL. This applies to POP3, IMAP4, and SMTP. The information 
in this chapter is divided among the following sections:

Configuring the Corporate E-Mail Server, page 145
Configuring SSL for E-mail Server Java, page 147
Configuring the Mailer, page 150

Configuring the Corporate E-Mail Server
This section describes the procedures for configuring the corporate mail server, 
such as Lotus Domino, to work in secured mode using SSL. This section 
includes the following procedure:
• Configuring the corporate e-mail server to work in secured mode

Procedure:
Configuring the corporate e-mail server to work in 
secured mode

Prerequisites

• Microsoft Certificate Services must be installed on Host1 (in this example, 
Host1 is running Windows 2000 Server):

IIS must be installed
Navigate to Control Panel > Add/Remove Programs > Add/Remove 
Windows Components > Certificate Services



146 Multimedia 7.6

Chapter 6: Deploying an E-Mail System in Secured Mode Configuring the Corporate E-Mail Server

• A corporate mail server such as Lotus Domino, which is used in this 
procedure, must be installed on Host2. In this example, Lotus Domino 
version 5.3 is used.

Start of procedure

1. From a browser on Host2, go to website of the Certification Authority (CA) 
at the following URL: http://Host1/Certsrv 
a. From the main menu select Retrieve the CA certificate revocation 

list and Install this CA certification Path.
b. From the main menu select Retrieve the CA certificate revocation 

list and Download CA certificate (Base 64 encoded)
c. Save the file certnew.cer in c:\temp (this is the trust certificate).

2. From Lotus Domino administration, open SSL Domino Administration by 
selecting File > Database > Open. Select the server and open Server 
Certificate Admin (file certsrv.nsf). 

3. The Domino SSL Administration Page has four top-level menu sections. 
The following is a sample configuration:
a. Create Key Ring

Key Ring File Name: JavaEmail.kyr
key ring password: password
Common name: Host2
Organization: Company
State or Province: State
Country: Country

b. Create Certificate Request
Key ring file name: JavaEmail.kyr
Create Certificate Request: 
i. The certificate request in PKCS format is displayed.
ii. Copy the request by selecting all the text in a temporary file.
iii. On the CA website, select Request a certificate > Advance 

Request > Submit a certificate request using a base64 encoded 
PKCS...

iv. Copy the request in PKCS format and submit.
v. Launch Programs > Administrative Tools > Certification 

Authority

vi. Select the last certificate in the Pending Requests folder and issue 
it.

vii. In the Issued Certificates folder, open this certificate and copy it 
to a new file: certificate.cer.

viii. Copy the file certificate.cer to \\Host2\temp.
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c. Install Trusted Root Certificate into Key Ring
Key ring file name: JavaEmail.kyr
Certificate Label: Microsoft Certificate Authority
Certificate Source: File: C:\temp\certnew.cer

d. Install Certificate into Key Ring
Key ring file name: JavaEmail.kyr
Certificate Source: File: C:\temp\certificate.cer
Select Merge Certificate into Key Ring.

4. Copy the JavaEmail.kyr and JavaEmail.sth files from c:\Lotus\Notes\Data 
to c:\Lotus\Domino\Data.

5. In Domino Administration, set the SSL key file name in Internet Ports to 
JavaEmail.kyr.

6. Enable SSL on the Domino POP, IMAP, and SMTP ports.
7. Restart the Domino server.

End of procedure

Next Steps

• Configuring SSL for E-mail Server Java

Configuring SSL for E-mail Server Java
This section describes procedures for configuring your E-mail Server Java 
application to work with SSL. This configuration is supported for E-mail 
Server Java version 7.0 and above. The following procedures are included in 
this section:
• Generating the .keystore file
• Modifying the E-mail Server Java startup command line
• Configuring E-mail Server Java’s POP, IMAP, and SMTP ports

Procedure:
Generating the .keystore file

Prerequisites: 

• Configuring the corporate e-mail server to work in secured mode
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Start of procedure

1. Copy the certificate.cer file to the host running E-mail Server Java 
(Host3 for this sample configuration).

2. Use the Java keytool utility that is available with the JRE to import the 
certificate. Use the JRE installed with Multimedia Third Party 
Components. The utility can be found in 
<Multimedia_Install_Dir>/jre/bin for Unix operating systems, and in 
<Multimedia_Install_Dir>\jre\bin for Windows operating systems. 
For example:
keytool -import -file certificate.cer

3. A .keystore file is generated. On Windows, the default path to find this 
file is C:/Documents and settings/<username>/.KeyStore

End of procedure

Next Steps

• Modifying the E-mail Server Java startup command line

Procedure:
Modifying the E-mail Server Java startup command 
line

Purpose:  To provide E-mail Server Java with the location of the .keystore file 
on startup.

Prerequisites

• Generating the .keystore file

Start of procedure

1. Locate the E-mail Server Java startup file (startServer.bat and 
setini.bat on Windows operating systems, or startServer.sh on Unix 
operating systems). 

2. Open the file in a text editor and modify the startup command line so E-
mail Server Java can locate the .keystore file. For example:
java -Djavax.net.ssl.trustStore="C:/Documents and 
settings/<username>/.KeyStore" --Xmx512M ....

3. Save and close the file.

End of procedure
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Next Steps

• Configuring E-mail Server Java’s POP, IMAP, and SMTP ports

Procedure:
Configuring E-mail Server Java’s POP, IMAP, and 
SMTP ports

Purpose:  The ports must be configured in order for the e-mail system to work 
in secured mode.

Prerequisites

• Generating the .keystore file
• Modifying the E-mail Server Java startup command line

Start of procedure

1. In Configuration Manager, open the properties for your E-mail Server Java 
application.

2. In the Options tab, locate the [pop-client] section for IMAP and configure 
the type, port, and enable-ssl options. For example:
[pop-client1]

type = IMAP

port = 993 (the default SSL port for IMAP)
enable-ssl = TRUE

3. Locate the [pop-client] section for POP3 and configure the type, port, 
and enable-ssl options. For example:
[pop-client2]

type = POP3

port = 995 (the default SSL port for POP3)
enable-ssl = TRUE

4. Locate the [smtp-client] section and configure the port and enable-ssl 
options. For example:
port = 465 (the default SSL port for SMTP)
enable-ssl = TRUE

5. Save your changes.

End of procedure

Next Steps

• Configuring the mailer to work in secured mode
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Configuring the Mailer
This section describes the procedures to configure the mailer, such as Outlook 
Express, to work in secured mode with SSL. This section contains the 
following procedure:
• Configuring the mailer to work in secured mode

Procedure:
Configuring the mailer to work in secured mode

Prerequisites

• A mailer (Outlook is used in this example) must be installed on Host4.

Start of procedure

1. On the Certificate Authority website (http://Host1/Certsrv), select 
Retrieve the CA certificate revocation list and Install this CA 
certification Path.

2. Select Request a certificate > User Certificate Request (E-Mail 
Protection Certificate). The following is a sample configuration):
Name: client1 (this field must be set to the name of your Outlook account)
E-Mail: client1@mail.com
City: City
State: State
Country: Country
Submit the request.

3. Launch Programs > Administrative Tools > Certification Authority.
a. Select and issue the last certificate in the Pending Requests folder.
b. Locate the certificate in the Issued Certificates folder, open it and 

copy it to a new file client1.cer.
c. Copy client1.cer to \\Host4\temp (Outlook is located on Host4).

4. On Host4, open the certificate named client1.cer located in c:\temp\ and 
install it.

5. Open Outlook and choose Tools > Accounts > Mail, and select the client1 
account.
a. In Security, select the certificate in Signing certificate and 

Encrypting preferences.
b. In Advanced, validate SSL and provide the correct port numbers.
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6. In Tools > Options, select the Security tab.
a. Select Digitally sign all outgoing messages.
b. Click on Advanced and select Always encrypt to myself when sending 

encrypted mail, Include my digital ID when sending signed 
messages and Add senders' certificates to my address book.

End of procedure
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7 Deploying Multimedia in 
UNIX Environments
This chapter describes procedures for configuring and installing Multimedia 
components in UNIX environments—Solaris, AIX, and Linux—as well as for 
configuring the Web API components in a WebSphere or WebLogic 
environment.
This chapter has these sections:

Deploying Multimedia on UNIX Hosts, page 153
Deploying WebSphere on AIX or Solaris, page 156
Deploying WebLogic on Solaris, page 169

Note: You can deploy all Multimedia 7.6.1 components on UNIX platforms, 
except for the following user interfaces:
• Knowledge Manager
• Universal Contact Server Manager
• Interaction Workflow Samples

Deploying Multimedia on UNIX Hosts
Configuring and installing Multimedia 7.6.1 on Solaris, AIX, or Linux follows 
the general procedure introduced in Chapter 5, beginning on page 91. You can 
use the Multimedia 7.6.1 Configuration Wizards on a Windows host to 
configure components that will run in UNIX environments. For the installation 
phase, however, you should proceed in a slightly different fashion than you 
would for a Windows-only environment. The main difference is that after 
configuration, you will need to manually copy the individual component 
installation packages to each UNIX host, as initially suggested in “Installing 
Multimedia Components” on page 129. Also consider the guidelines under 
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“Copying Installations to Remote Computers” in Chapter 8, “Deploying with 
Configuration Wizard Framework,” of the Framework 7.6 Deployment Guide.
After you copy the software to the UNIX hosts, do one of the following:
• Run the setup for individual components manually.
• Use the Multimedia CD on each host to run the setup for the components 

directly from that CD. 

Note: For all platforms, before you install individual components, but with 
two exceptions, you must first install the Third Party Components 
provided for you. On Windows, if you use IPStarter.exe, it takes care 
of this automatically. On Solaris , AIX, or Linux, however, you must 
manually run the Third Party Components setup on each host before 
you run the setup for the other Multimedia components for that host.
Interaction Server and Chat Server are exceptions to this guideline. On 
Windows for Chat Server, and on all platforms for Interaction Server, 
you can install without first installing Third Party Components.
For an explanation of the difference between Third Party Components 
(executable) and ThirdPartyApplications (directory), see the note on 
page 55.

Procedure:
Deploying Multimedia on Solaris, AIX, or Linux from a 
Windows host

Purpose:  To suggest how you might use the Multimedia Configuration 
Wizards on a Windows host to configure and install components to other hosts 
for Solaris, AIX, or Linux deployments.

Start of procedure

1. On each Solaris, AIX, or Linux host, define the variable GES_HOME_761 to 
target the directory containing Multimedia components.

Warning! Do not include any spaces in the GES_HOME_761 name (for example, 
use MCR761 instead of MCR 7.6.1).

2. When you run the Multimedia Configuration Wizard, it will ask you to 
specify the destination for copying installation packages. Do one of the 
following:
• Create a shared directory on your Solaris, AIX, or Linux computer for 

the installation package deployment, making sure that it is accessible 
from the Windows host.
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• Create a shared directory on a Windows host (as recommended in 
“Create a Shared Directory” on page 94 for the Windows installation), 
making sure that it is accessible from the Solaris, Linux, or AIX host(s) 
that will run your Multimedia components.

In either case you must copy all installation packages to the Solaris, Linux, 
or AIX computer(s) that will host your Multimedia solution.

3. On a Windows machine, run the Multimedia Wizards as described in 
Chapter 5, beginning on page 91.
The Wizards copy the installation packages using a directory structure such 
as the following:
<componentA>

IBM_AIX
Linux
Solaris
Windows_2000
Windows_Server_2003

<componentB>
IBM_AIX
Solaris
Windows_2000
Windows_Server_2003

...

aix
ThirdPartyComponents

linux
ThirdPartyComponents

solaris
ThirdPartyComponents

windows
CommonWizardComponentSet
ThirdPartyComponents

4. After completing configuration using the Wizards, begin installation by 
running the installation package in <platform>\ThirdPartyComponents on 
each host where you plan to install components.

5. Continue installation by running the installation package for each 
remaining Multimedia component. You will find that package in the 
<platform> subdirectory contained in the directory named for each 
component.

End of procedure

Next Steps

• For Solaris deployments, you need to install and configure one of the 
following web application servers:

Deploying WebLogic on Solaris, page 169
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Deploying WebSphere on AIX or Solaris, page 156
Configuring Apache and Tomcat for Linux or Solaris, page 72

• For AIX deployments, you need to deploy the following web application 
server:
Deploying WebSphere on AIX or Solaris, page 156

• For Linux deployments, you need to install and configure the following:
Configuring Apache and Tomcat for Linux or Solaris, page 72

Deploying WebSphere on AIX or Solaris
In Multimedia 7.6.1, you can use the IBM WebSphere Application Server in 
both AIX and Solaris deployments. After configuring and installing 
Multimedia as outlined in Chapter 5 on page 91, and in “Deploying 
Multimedia on UNIX Hosts” on page 153, you need to enable your WebSphere 
deployment to use the Web API Server and the MCR 7.6.1 Samples. 
For AIX deployments, WebSphere is the only supported web server. For 
Solaris, however, you can use WebSphere, Apache/Tomcat, or WebLogic in 
your deployment. For WebSphere deployment procedures, see:
• Deploying WebSphere on AIX, page 157
• Deploying WebSphere on Solaris, page 160
• Testing the WebSphere installation on AIX or Solaris, page 169

Note: For information about deploying Solaris with Apache or WebLogic, 
see the following sections:
• “Configuring Apache and Tomcat for Linux or Solaris” on page 72
• “Deploying WebLogic on Solaris” on page 169

Prerequisites

This section assumes that you have your WebSphere environment ready to go, 
and that you have completed the model setup. The steps outlined in this section 
use values you entered for that model installation.

Checklist of Genesys Components for Your AIX or Solaris 
Host

Your Multimedia installation of the Web API Server created an EAR project, 
MCR_API_EAR.ear, with three parts: Third Party Components, Web API, and 
Compound Samples.



Deployment Guide  157

Chapter 7: Deploying Multimedia in UNIX Environments Deploying WebSphere on AIX or Solaris

Note: For an explanation of the difference between Third Party Components 
(executable) and ThirdPartyApplications (directory), see the note on 
page 55.

Environment
This document refers to the root directory for IBM WebSphere as 
<WEBSPHERE_HOME>. The root directory for the IBM HTTP Server, an Apache-
based Web Server, is <IHS_HOME>. <MCR_API_EAR> represents the base directory 
of your MCR_API_EAR.ear file location. A sample directory structure in this case 
might be: 
<WEBSPHERE_HOME>/AppServer/installedApps/DefaultNode/MCR_API_EAR.ear.

Note: For instructions on how to configure and install Genesys Web API 
Server and the Compound Web Samples, see the Web API Server 
sections of the following procedures:
• Configuring Multimedia objects using the wizard, page 98
• Performing an integrated installation of all Multimedia servers, 

page 131

Procedure:
Deploying WebSphere on AIX

Note: Although WebSphere 5.x is supported, the following procedures apply 
to WebSphere 6.0.

Start of procedure

1. Launch your WebSphere 6.0 Application Server.
2. Start the Administrative Console.
3. In the left frame, click Applications > Enterprise Applications. 
4. In the right frame, select the Default Application and click Stop. (You 

must do this because the WebSphere default application shares the same 
context root as the one you created in your EAR project.)

5. In the left frame, click Applications > Install New Application.
6. In the right frame, for Local path, browse to or enter the full path to your 

EAR project. Click Next.
7. Retain defaults and click Next.
8. Retain defaults and click Next.
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9. Under Map modules to servers, select your web and application servers 
from the Clusters and Servers list.

10. Check each Module corresponding to your web projects. Click Apply. Click 
Next. See Figure 36.

Figure 36: Map Modules to Application Servers

11. Click Next.
12. Review the summary and click Finish.
13. Click the Save to Master Configuration link.
14. Click Save.
15. In the left frame, click Servers > Web Servers. 
16. In the right frame, select your web server. Click Generate Plug-in.
17. You must also update the web server configuration file to accommodate the 

specifics of your deployment.
a. Locate the <IHS_HOME>/conf/httpd.conf file.
b. Add the following text (one for each web project, with your 

environment’s specifics), indicating a virtual root, to the end of 
httpd.conf:

Alias /CodeBase761 “<MCR_API_EAR>/CodeBase761”
Alias /CoBrowse761 “<MCR_API_EAR>/CoBrowse761”
Alias /CompoundSample761 “<MCR_API_EAR>/CompoundSample761.war”
Alias /WebAPISamples761 “<MCR_API_EAR>/WebAPISamples761.war”
Alias /TestTool761 “<MCR_API_EAR>/TestTool761.war”

Also see, for example, Figure 37 on page 159.
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Figure 37: Sample Text Required in httpd.conf File

c. Save the httpd.conf file.
d. Restart the IHS Web Server.

18. In the Genesys Configuration Layer, make the following change to your 
Web API Server Application object:
In its Log section, update the messagefile option with the full path to your 
log and message files for the web project, for example:
<MCR_API_EAR>/WebAPI761.war/webapimsg.lms.

19. Back in WebSphere, in the left frame, go to Applications > Enterprise 
Applications. In the right frame, stop all non-Genesys web applications.

20. Now select your EAR in the right frame and click Start. The status of the 
application should be a green right-pointing arrow, as shown in Figure 38.

Figure 38: Start Your EAR Application

End of procedure

Next Steps

• Testing the WebSphere installation on AIX or Solaris, page 169
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Procedure:
Deploying WebSphere on Solaris
The following procedures and sample screens apply to WebSphere version 
5.1.1.10. For other versions of WebSphere, variations may occur.

Start of procedure

1. Launch your WebSphere Application Server.
2. Login to the Administrative Console (typically using the address 

http://<yourhost>:9090/admin) and proceed to the main page (see 
Figure 39).

.

Figure 39: Administration Console—Main Page
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3. In the left frame of the main page, click Applications > Enterprise 
Applications (see Figure 40).

Figure 40: Click Enterprise Applications

4. After the Enterprise Application page opens, in the right frame, select 
Default Application, and then click Stop (see Figure 41).

Figure 41: Stop the Default Application

Tip: You must click Stop, because the WebSphere default application 
shares the same context root as the one you created in your EAR project.
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5. After the page refreshes, in the left frame, click Applications > Install 
New Application (see Figure 42).

Figure 42: Click Install New Application

6. After the Install New Application page opens, in the right frame, enter the 
full path to the MCR_API_EAR.ear file that was prepared when you ran the 
installation package script (see Figure 43). Click Next.

.

Figure 43: Enter the Path to the MCR API EAR File

Tip: If you experience difficulties, check access permissions for your 
UNIX user account as it applies to the .ear file.
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7. Retain the Override and Virtual Host defaults, (see Figure 44) and click 
Next.

.

Figure 44: Retain Defaults

8. At the Step 1 page (see Figure 45), retain all defaults, or change the 
Application Name value (retaining defaults for the remaining fields), and 
then click Next.

.

Figure 45: Change Application Name
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9. At the Step 2 page (see Figure 46), select all the checkboxes and click 
Next.

Figure 46: Select All Checkboxes

10. At the Step 3 page (seeFigure 47) , select your web and application servers 
from the Clusters and Servers drop-down list, and then click Apply.

Figure 47: Select Your Web and Application Servers

11. From the list of modules, select all the checkboxes and click Next.
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12. At the Step 4 page (see Figure 48), review the summary of the your install 
options. If it is correct, click Finish. Otherwise, click Previous to return to 
an earlier page and make any necessary changes.

Figure 48: Review the Summary

After a few moments, you will receive a message notifying you that the 
installation was successful (see Figure 49).

Figure 49: Notice of Successful Installation

13. Click the Save to Master Configuration link in the middle of the right 
frame.
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14. At the confirmation page (see Figure 50), click Save.

Figure 50: Confirmation Page

After the save is complete, the main WebSphere Admin page opens.
15. If you are using the IBM HTTP Server to provide frontline access to 

WebSphere, you must also do the following:
a. In the navigation tree in the left frame, click Environment > Update Web 

Server Plugin (see Figure 51).

Figure 51: Click Update Web Server Plugin
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b. At the Update web server plugin configuration confirmation page 
(as shown in Figure 52), click OK.

Figure 52: Update Web Server Plugin Confirmation Page

c. Update the web server configuration file to accommodate the specifics 
of your deployment. To do this, locate the <IHS_HOME>/conf/httpd.conf 
file and add following text (one for each web project, with your 
environment’s specifics), indicating a virtual root, to the end of it:
Alias /CodeBase761 “<MCR_API_EAR>/CodeBase761”

Alias /AgentCoBrowse761 “<MCR_API_EAR>/AgentCoBrowse761”

Alias /CompoundSample761 “<MCR_API_EAR>/CompoundSample761.war”

Alias /WebAPISamples761 “<MCR_API_EAR>/WebAPISamples761.war”

Alias /TestTool761 “<MCR_API_EAR>/TestTool761.war”

For an example of an amended http.conf file, see Figure 53:

Figure 53: Sample http.conf File
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d. Save the http.conf file.
e. Restart the IHS Web Server.

16. In the Genesys Configuration Layer, make the following change to your 
Web API Server Application object:
• In its Log section, update the messagefile option with the full path to 

your log and message files for the web project, for example:
<MCR_API_EAR>/WebAPI761.war/webapimsg.lms.

17. Back in WebSphere, in the left frame, go to Applications > Enterprise 
Applications.

18. At the Enterprise Applications page, in the right frame, select your Web 
API Server EAR application and click Start.
The status arrow next to your EAR application should change to green as 
shown in Figure 54.

Figure 54: Start Your EAR Application

End of procedure

Next Steps

• Testing the WebSphere installation on AIX or Solaris, page 169
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Procedure:
Testing the WebSphere installation on AIX or Solaris

Purpose:  Use the Genesys MCR 7.6.1 Samples Pages to test the your IBM 
WebSphere deployment.

Start of procedure

1. Launch the IBM HTTP Server. 
2. Enter the following address in your browser:

http://<yourhost>/WebAPISamples761/

The main MCR 7.6.1 Samples page opens. If you can access and work 
with those sites, you successfully performed the installation.

Figure 55: MCR 7.6.1 Web API Samples

End of procedure

Next Steps

• You have completed all the actions required to deploy WebSphere on AIX 
or Solaris

Deploying WebLogic on Solaris
For deployment on Solaris, after configuring and installing Multimedia as 
outlined in Chapter 5, beginning on page 91, and “Deploying Multimedia on 
UNIX Hosts” on page 153, you need to enable a web application to use Web 
API Server and the Web Samples. You can deploy any of the following web 
applications on Solaris hosts:
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• BEA WebLogic Server—See this section for deployment details.
• IBM WebSphere Application Server—See “Deploying WebSphere on AIX 

or Solaris” on page 156 for details.
• Apache HTTP Server and Apache Tomcat Application Container—See 

“Configuring Apache and Tomcat for Linux or Solaris” on page 72 for 
details.

Prerequisites

This section assumes that you have your WebLogic environment installed and 
ready, and that you have completed the model setup. The steps outlined in this 
section use values you entered for that model installation.

Checklist of Genesys Components for Your Solaris Host
Your Multimedia installation of the Web API Server created an EAR project, 
MCR_API_EAR.ear, with the following components:
• WebAPI761.war—Web API
• TestTool761.war—Test tool
• CompoundSample761.war—Compound Samples
• WebAPISamples761.war—Web API Samples

Procedure:
Deploying Genesys web applications for WebLogic

Start of procedure

1. Run the install.sh script.
2. Enter the host name where you will install the Web API Server.
3. If you have not specified configuration information using a Wizard, you 

are prompted to enter the following information:
• Configuration Server Hostname
• Network Port
• User Name
• Password
• Backup Configuration Server Hostname
• Backup Network Port

4. Specify which application to install.
5. Choose the web server type, and then enter the web server root directory.
6. Enter the WebLogic domain directory that you are using.
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7. Select the code page–character set pair for processing requests from 
computers with different locale settings.

8. Choose the CompoundSample application to install.
9. Enter the fully qualified host name where Co-Browsing Server is installed.
10. Enter the Configuration Server tenant name.
11. Press Enter to confirm the destination directory, and to begin the 

installation.
The installer will extract the necessary files to the locations you specified, 
and will update the following files:
• <Apache root>/conf/httpd.conf.
• All related *.jsp files.
• startWebLogic.sh.

End of procedure

Next Steps

• Checking your WebLogic configuration file, page 171

Procedure:
Checking your WebLogic configuration file
WebLogic automatically generates a config.xml configuration file during the 
first run of the domain created in DEVELOPMENT mode. This configuration 
file specifies which Web API applications WebLogic starts.
To confirm that your Multimedia web application will run correctly, complete 
the following steps:

Start of procedure

1. Locate and open your WebLogic config.xml file.
2. Search for the following lines inside your configuration file:

<Application Name="_appsdir_MCR_API_EAR_ear"
Path="/data/bea/user_projects/domains/webapisrv/applications/MCR_API_EAR.ear"
StagingMode="nostage" TwoPhase="true">

<WebAppComponent Name=”WebAPI761” Targets=”myserver” URI=”WebAPI761.war”/>
<WebAppComponent Name=”TestTool761” Targets=”myserver” URI=”TestTool761.war”/>
<WebAppComponent Name=”CompoundSample761” Targets=”myserver” 

URI=”CompoundSample761.war”/>
<WebAppComponent Name=”WebAPISamples761” Targets=”myserver” 

URI=”WebAPISamples761.war”/>
</Application>
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Warning! If the Multimedia web application is not present in your config.xml 
file, then remove the .app_poller_lastrun file located in the 
<WebLogic_Domain>/<MCR_SERVER> folder and restart your WebLogic 
server. WebLogic will regenerate the config.xml file and add the 
MCR application automatically.

End of procedure

Next Steps

• Deploying your web applications, page 172

Procedure:
Deploying your web applications
Genesys web applications for WebLogic are deployed automatically during the 
installation process. However, if you choose to create a custom package based 
on the Web API Server, then you will have to use WebLogic to manually 
deploy the related web applications.

Start of procedure

1. Start your Admin and Managed servers, if they are not already running.
2. Open your web browser and start the Administrative console.
3. Log in using your username and password.

4. Open the Deployments section for your domain, and select Applications as 
shown in Figure 56.

Figure 56: Deploy a Web Application in WebLogic

Note: For this procedure, the only Managed server shown in WebLogic 
Server Console screenshots is called MCR_Server.

5. Click Deploy a new Application.
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6. Specify the full path to your MCR_API_EAR.ear application archive, and then 
click “Target Application” button. See Figure 57.

Figure 57: Select a Target Application

7. Select your Managed Servers, and click Continue. See Figure 58.

Figure 58: Select the Managed Servers

8. At the Review your choices and deploy page, confirm that the Deployment 
Targets setting is correct and then click Deploy. See Figure 59 on page 174.
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Figure 59: Confirm Application Details

9. The deployment is now complete.
Check your summary page to ensure that each module in the web 
application has a deployment status of “Available”, as shown in Figure 60.

Figure 60: Application Summary Page

End of procedure

Next Steps

• Testing the WebLogic installation and deployment, page 175
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Procedure:
Testing the WebLogic installation and deployment

Start of procedure

1. Ensure Apache is running. 
2. Start WebLogic.
3. In a browser, enter the following addresses:

• http://<Apache host>:<Apache listen port>/TestTool761
• http://<Apache host>:<Apache listen port>/WebAPISamples761
• http://<Apache host>:<Apache listen port>/CompoundSample761
If you can access and work with those sites, you have successfully 
completed the installation and deployment.

Note: The addresses listed above are case sensitive.

End of procedure

Next Steps

• You have completed all the actions required to deploy WebLogic on 
Solaris.
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Chapter

8 Manual Deployment—Web 
Components and UCS
This chapter describes the manual deployment of Web API Server and Web 
Compound Samples, together called the Multimedia Web Components, and 
Universal Contact Server (UCS) and UCS Manager.
The information in this chapter is divided among the following topics:

Introduction, page 177
Configuring Multimedia Web Components and UCS, page 178
Installing Multimedia Web Components and UCS, page 180

Introduction
It is possible that you may want to use Web API Server, Web Compound 
Samples (together called the Multimedia Web Components) or UCS and UCS 
Manager without deploying the other Multimedia components. For example, 
Genesys Voice Callback requires these three components. In such a situation 
you may want to install these components on their own without using the 
Multimedia Configuration Wizard or the Multimedia integrated installation. 
This chapter describes procedures for such manual configuration and 
installation.
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Requirements
These components require certain other components to operate:
• The Multimedia Web Components require a web server and an application 

container. See Chapter 4 for a description of installing these objects.
• Web API Server, UCS, and UCS Manager require Multimedia Third Party 

Components installed on the host. Step 1 of Installing Multimedia Web 
Components and UCS, page 180 describes configuration and installation of 
this component.

Note: For an explanation of the difference between Third Party Components 
(executable) and ThirdPartyApplications (directory), see the note on 
page 55.

Configuring Multimedia Web Components 
and UCS

In the Configuration Layer, create or edit the following Application objects: 
1. Creating or editing the Web API Server application object, page 178
2. Creating or editing the UCS application object, page 179
3. Creating or editing the UCS Manager application object, page 180

Procedure:
Creating or editing the Web API Server application 
object

Start of procedure

1. Create an Application object if it does not already exist.
2. Open the Properties dialog box of the Application object. 
3. On the Host tab:

• In the Host box, enter the name of the desired host.
• In the Communication Port box, enter the number of the web server 

HTTP port.
4. On the Connections tab, add connections to:

• Solution Control Server (mandatory)
• Universal Callback Server
• Chat Server
• E-mail Server
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• Interaction Server
• Stat Server
• Config Server, if you support Genesys Advanced Disconnect Detection 

Protocol (ADDP)
• Co-Browsing Server
Only the connection to Solution Control Server is mandatory. Make 
additional connections based on your planned configuration.

End of procedure

Next Steps

• Creating or editing the UCS application object

Procedure:
Creating or editing the UCS application object
UCS requires one database (the main database). It can optionally use a second 
(archive) database to store older UCS data and ease storage in the main 
database.

Start of procedure

1. Create the main and (optional) archive databases if you have not already 
done so. See also “Creating Databases and Running Scripts” on page 136.

2. Run the SQL script located in the sql_scripts folder of the UCS starting 
directory.

3. Create a Database Access Point (DAP) for the main database. Create a 
second DAP for the archive database if you have one. Use the JDBC 
connection type.

4. Create a UCS Application object if it does not already exist. 
a. On the Server Info tab, enter the host name and communication port.
b. On the Start Info tab, enter the working directory.
c. On the Connections tab, add connections to:

• Message Server
• Stat Server
• The two DAPs that you created in the Step 3.

d. Click Apply.
e. On the Security tab, in the Log On As area, select the This Account 

check box, and then select a Person or Access Group with privileges 
that are high enough to include write permission.
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f. On the Options tab, ports section, specify for the option ucsapi a 
valid network port number that UCS will use for connections from 
Java clients.

End of procedure

Next Steps

• Creating or editing the UCS Manager application object

Procedure:
Creating or editing the UCS Manager application 
object

Start of procedure

1. Create a UCS Manager Application object if it does not exist.
2. On the Connections tab, add a connection to UCS.

End of procedure

Next Steps

• Installing Multimedia Web Components and UCS

Installing Multimedia Web Components 
and UCS

Complete the following procedure to install the Multimedia Web Components 
and UCS. 

Procedure:
Installing Multimedia Web Components and UCS

Start of procedure

1. Install the Multimedia Third Party Components on the same host as UCS 
and the Multimedia Web Components.
a. Locate and double-click Setup.exe.
b. Select the servlet container that you are using.
c. Enter or browse to the location of the servlet container.
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2. Install the Multimedia Configuration Wizards.

Genesys Multimedia Configuration Wizards are required by the installation 
of Web API Server and Web Compound Samples. 
Locate and double-click Setup.exe.

3. Install Web API Server and Web Compound Samples
Manual Deployment of Web API Server and the Web Compound Samples 
is identical, except for two steps, to the Wizard deployment as described in 
“Add the Web API Server” on page 118 and “Add Web Compound 
Samples and Web Client” on page 119. The differences are:
a. You must locate and double-click Setup.exe.
b. During the installation you need to provide Configuration Layer 

connection parameters.
4. Install UCS

a. Locate and double-click Setup.exe.
b. Enter information for login to your Configuration Server:

• Host
• Port
• User
• Password

5. Install UCS Manager:
Locate and double-click Setup.exe.

End of procedure
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Chapter

9 UCS Proxy and Interaction 
Server Proxy
This chapter describes the manual deployment of Universal Contact Server 
Proxy and Interaction Server Proxy. These two components are new in release 
7.6.1. 
This chapter includes these sections:

Deploying UCS Proxy, page 183
Deploying Interaction Server Proxy, page 186

Deploying UCS Proxy
Some operating systems have limits to the number of open connections that 
will be supported. To work around this operating system limitation, Universal 
Contact Server Proxy has been introduced in release 7.6.1. Desktop 
applications can be configured to connect to UCS Proxies instead of the main 
Universal Contact Server, allowing many more available connections. This 
component is not part of the Multimedia Configuration Wizards and must be 
installed manually. UCS Proxy only supports connections from desktop 
application.

Note: UCS Proxy supports High Availability in Warm Standby mode.

Requirements
This component works with Universal Contact Server. In order to work 
properly, all components that are needed by Universal Contact Server must be 
installed. This will depend on your environment and how you are using 
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Universal Contact Server. For more details, refer to the chapter that is 
applicable to you:
• Chapter 5, “Model Configuration and Installation on Windows,” on 

page 91 for a typical Multimedia Solution running on Windows.
• Chapter 7, “Deploying Multimedia in UNIX Environments,” on page 153 

for a sample deployment of a Multimedia Solution running on UNIX.
• Chapter 8, “Manual Deployment—Web Components and UCS,” on 

page 177, for environments that are not using all Multimedia components, 
but that do require Universal Contact Server, such as Voice Callback.

Deploying Universal Contact Server Proxy can be divided into the following 
procedures:
1. Creating the Universal Contact Server Proxy application object, page 184
2. Installing Universal Contact Server Proxy, page 185
3. Configuring Genesys Desktop to use UCS Proxy, page 185

Procedure:
Creating the Universal Contact Server Proxy 
application object

Purpose:  Before installing the Universal Contact Server Proxy component, a 
corresponding Application object must exist in the Configuration Database.

Prerequisites

• A Universal Contact Server Application object must already be 
configured.

Start of procedure

1. Create an Application object for UCS Proxy if it does not already exist.
a. Import the Universal Contact Server Proxy application template from 

the Interaction Management CD.
b. Create a new Application object based on the template.

2. Open the Properties dialog box of the Application object. 
3. On the Server Info tab:

• In the Host box, enter the name of the desired host.
• In the Communication Port box, enter the port UCS Proxy will use for 

listening.
4. On the Connections tab, add connections to:

• the primary Universal Contact Server (mandatory)
• Message Server (optional)
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5. Click Apply.
6. If you would like to configure your UCS Proxy for HA, repeat this 

procedure for the second UCS Proxy.

End of procedure

Next Steps

• Installing Universal Contact Server Proxy

Procedure:
Installing Universal Contact Server Proxy

Prerequisites

• Creating the Universal Contact Server Proxy application object

Start of procedure

1. Locate the Setup.exe for Universal Contact Server Proxy (available on the 
Interaction Management CD).

2. Double-click Setup.exe.
3. Enter the login information for your Configuration Server:

• Host

• Port

• User

• Password

4. Select the appropriate UCS Proxy Application object from the list.

End of procedure

Next Steps

• Configuring Genesys Desktop to use UCS Proxy

Procedure:
Configuring Genesys Desktop to use UCS Proxy

Purpose:  In order to take advantage of the benefits provided by UCS Proxy, 
your desktop Application must be updated to connect to the UCS Proxy 
instead of the main Universal Contact Server.
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Start of procedure

1. Login to Configuration Manager.
2. Locate the Genesys Desktop Application object and open its Properties 

dialog box.
3. On the Connections tab, remove the connection to the main Universal 

Contact Server.
4. Add a connection to the UCS Proxy.
5. Click Apply.

End of procedure

Deploying Interaction Server Proxy
Some operating systems have limits to the number of open connections that 
will be supported. To work around this operating system limitation, Interaction 
Server Proxy has been introduced in release 7.6.1. Desktop applications can be 
configured to connect to Interaction Server Proxies instead of the main 
Interaction Server, thereby allowing many more available connections. This 
component is not part of the Multimedia Configuration Wizards and must be 
installed manually. Interaction Server Proxy only supports connections from 
desktop applications.

Note: Interaction Server Proxy supports HA in Warm Standby mode.

Requirements
This component works with Interaction Server. In order to work properly, all 
components that are needed by Interaction Server must be installed. For more 
details, refer to the chapter that is applicable to you:
• Chapter 5, “Model Configuration and Installation on Windows,” on 

page 91 for a typical Multimedia Solution running on Windows.
• Chapter 7, “Deploying Multimedia in UNIX Environments,” on page 153 

for a sample deployment of a Multimedia Solution running on UNIX.
Deploying Interaction Server Proxy can be divided into the following 
procedures:
1. Creating the Interaction Server Proxy application object, page 187
2. Installing Interaction Server Proxy, page 187
3. Configuring Genesys Desktop to use Interaction Server Proxy, page 188
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Procedure:
Creating the Interaction Server Proxy application 
object

Purpose:  Before installing the Interaction Server Proxy component, a 
corresponding Application object must exist in the Configuration Database.

Prerequisites

• An Interaction Server Application object must already be configured.

Start of procedure

1. Create an Application object for Interaction Server Proxy if it does not 
already exist.
a. Import the Interaction Server Proxy application template from the 

Interaction Management CD.
b. Create a new Application object based on the template.

2. Open the Properties dialog box of the Application object. 
3. On the Server Info tab:

• In the Host box, enter the name of the desired host.
• In the Communication Port box, enter the TCP port Interaction Server 

Proxy will use for listening.
4. On the Connections tab, add connections to:

• the primary Interaction Server (mandatory)
• Message Server (optional)

5. Click Apply.
6. If you would like to configure your Interaction Server Proxy for HA, 

repeat this procedure for the second Interaction Server Proxy.

End of procedure

Next Steps

• Installing Interaction Server Proxy

Procedure:
Installing Interaction Server Proxy

Prerequisites

• Creating the Interaction Server Proxy application object
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Start of procedure

1. Locate the Setup.exe for Interaction Server Proxy (available on the 
Interaction Management CD).

2. Double-click Setup.exe.
3. Enter the login information for your Configuration Server:

• Host

• Port

• User

• Password

4. Select the appropriate Interaction Server Proxy Application object from 
the list.

End of procedure

Next Steps

• Configuring Genesys Desktop to use Interaction Server Proxy

Procedure:
Configuring Genesys Desktop to use Interaction 
Server Proxy

Purpose:  In order to take advantage of the benefits provided by Interaction 
Server Proxy, your desktop Application object must be updated to connect to 
the Interaction Server Proxy instead of the main Interaction Server.

Start of procedure

1. Login to Configuration Manager.
2. Locate the Genesys Desktop Application object and open its Properties 

dialog box.
3. On the Connections tab, remove the connection to the main Interaction 

Server.
4. Add a connection to the Interaction Server Proxy.
5. Click Apply.

End of procedure
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Chapter

10 Uninstalling Multimedia
This chapter describes how to uninstall Multimedia components. It covers the 
following topics:

Using Wizards to Uninstall Multimedia, page 189
Removing Multimedia Components, page 190
Removing Genesys Desktop, page 192

Using Wizards to Uninstall Multimedia
Complete the following procedure to uninstall Multimedia.

Procedure:
Uninstalling Multimedia using the wizards

Start of procedure

1. Launch the Genesys Wizards Manager.
2. Click Multimedia on the left side of the window. The Wizard presents a list 

of currently installed Multimedia Solutions. Selecting one of them enables 
you to change or uninstall the solution (Figure 61).
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Figure 61: Genesys Wizard Manager

3. Click Uninstall. The Wizard asks you to confirm your decision, and then 
uninstalls the solution.

End of procedure

Next Steps

• Removing Multimedia components

Removing Multimedia Components
Use the following procedure to remove Multimedia components from each 
host machine.

Procedure:
Removing Multimedia components

Start of procedure

1. From the Windows Start menu, open the Control Panel (Settings > 
Control Panel) and click Add or Remove Programs.

2. At the Add or Remove Programs dialog box, select these programs:
Genesys .Net Web API Server & Samples 7.6.1
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Genesys Chat Server 7.6.1
Genesys Classification Server 7.6.1
Genesys Co-Browsing Server 7.6.1
Genesys E-mail Server Java 7.6.1
Genesys Interaction Server 7.6.1
Genesys Interaction Server Proxy 7.6.1
Genesys Interaction Workflow Samples 7.6.1
Genesys Knowledge Manager 7.6.1
Genesys Multimedia Configuration Wizards 7.6.1
Genesys Multimedia Third Party Components 7.6.1
Genesys Training Server 7.6.1
Genesys Universal Contact Server 7.6.1
Genesys Universal Contact Server Proxy 7.6.1
Genesys Universal Contact Server Manager 7.6.1
Genesys Web API Server 7.6.1
Genesys Web Compound Samples 7.6.1

3. Click Change/Remove. Repeat this step as needed for each component listed 
in Step 2.

4. Using Windows Explorer, browse to the GCTI main directory and delete the 
complete Multimedia subdirectory, including all subfolders.

5. In your RDBMS, delete the tables and databases that relate to Multimedia. 
For the model setup presented in Chapter 5, beginning on page 91, for 
instance, this would mean deleting the IxnDB, Customer, and, possibly, 
co-browse databases from the Microsoft SQL 2000 RDBMS on host 
MMHost. If you have an Archive instance of your Universal Contact Server 
database, you would delete its Customer database as well. If you have an 
Event Logger database, you would delete that as well.

6. Consult with your database administrator about deleting the database files 
themselves.

7. Delete your Web Samples virtual directories by using the IIS Management 
Console or the Internet Service Manager. 

End of procedure

Next Steps

• You have completed all the necessary steps to uninstall your Multimedia 
7.6.1 Solution.
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Removing Genesys Desktop
To remove Genesys Desktop, refer to the Genesys Desktop 7.6 Deployment 
Guide.
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Chapter

11 Starting and Stopping 
Procedures
This chapter describes how to start and stop Multimedia 7.6.1. It covers these 
topics:

Starting with Solution Control Interface, page 193
Starting Manually, page 194
Stopping with Solution Control Interface, page 196

Starting with Solution Control Interface
Complete the following procedure to start Multimedia using the Solution 
Control Interface (SCI).

Procedure:
Starting Multimedia using SCI

Note: You cannot use Solution Control Interface to start or stop Web API 
Server. See “Starting Manually” for instructions on how to start your 
Web API Server.

Prerequisites

You must start all of the following Genesys components before starting SCI:
• Local Control Agent
• Primary Database Server
• Configuration Server
• Solution Control Server (SCS)
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Start of procedure

1. Start SCI.
2. Go to the Solutions view.
3. Select the name of your Multimedia solution on the List pane. (For the 

model installation, the name is MM761.)
4. Click Start on the toolbar or select Start from the shortcut menu and 

confirm the action in the dialog box.
The command to start Multimedia is sent to SCS, which uses Local 
Control Agents (LCAs) to activate the solution components in the Solution 
configuration object.
After all of the Multimedia components have reported a status of Running 
within the configured timeout, SCI reports a successful start of Multimedia 
by changing the solution status from Pending to Running.

Note: Because many components are shared by a number of solutions, 
some Multimedia components can have status Running before the 
solution as a whole has started. 

End of procedure

Next Steps

• You have completed all of the steps to start Multimedia using SCI.
For more information, see Framework 7.6 Solution Control Interface Help. To 
view the Help file, open SCI, and then launch the Help file.
For information about the following Management Layer topics, see the 
documentation for Genesys Framework 7.6:
• Message Server
• Solution Control Server
• Solution Control Interface
• Local Control Agent
• Log Database

Starting Manually
This section describes how to manually start Multimedia and the Multimedia 
servers. For information on manually starting Database Server, Message 
Server, and Stat Server, see the Framework 7.6 Deployment Guide. For 
Universal Routing, see the Universal Routing 7.6 Deployment Guide.
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Procedure:
Starting Multimedia components from the 
command line

Start of procedure

1. A *.bat (or *.sh for UNIX) file for Interaction Server is available in its 
installation directory (as is the case with almost all Multimedia 
components). You can use this file to start Interaction Server (or the given 
component). Or you can start Interaction Server by using a command line 
with the following command-line options:
-host The name of the host where Configuration Server is running
-port The Configuration Server port
-app The Application object name in the Configuration database
-l The port and host of the license server
You can place the command line with the specified command-line 
parameters in your own *.bat file. For Solaris, Linux, and AIX 
environments, you should also place the command line parameters in the 
startup script.
Example
interaction_server.exe -host cs-host -port 2020 
-app “IxnSrv” -l 7260@MMHost

End of procedure

Procedure:
Starting Multimedia components as services
Services may include LCA and the web server. 

Start of procedure

1. From the Windows Start menu, select Settings > Control Panel. 
2. In the Control Panel window, select Administrative Tools > Component 

Services. 

3. In the Component Services window, verify that a given service is running. 
If it is not, start it.

End of procedure
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Procedure:
Starting Multimedia from the Windows Start menu
You can start all Multimedia applications from the Windows Start menu.

Start of procedure

• From the Windows Start menu, select Start > Programs > Genesys 
Solutions > Multi-Channel Routing 7.6.1 > <ApplicationName> > 

<Shortcut to Application>.

End of procedure

Note on E-mail Server Java

Before starting E-mail Server Java, make sure the computer where it is 
installed has TCP/IP loaded and that it can communicate with the corporate 
mail server. If the server has a dial-up connection to the Internet, connect to the 
Internet before starting E-mail Server Java. 
As soon as you start the e-mail POP server, E-mail Server Java retrieves all the 
messages stored in the specified POP mailbox and stores them in the 
Interaction Server database. If you are evaluating e-mail functionality, empty 
the POP mailbox ahead of time.

Stopping with Solution Control Interface
Complete the following procedure to stop Multimedia using SCI.

Procedure:
Stopping Multimedia using SCI

Start of procedure

1. Start the SCI.
2. Go to the Solutions view.
3. Select the name of your Multimedia solution on the List pane (MM761 in the 

model setup).
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4. Click Stop on the toolbar or select Stop from the shortcut menu and 
confirm the action in the dialog box.
The command to stop Multimedia is sent to SCS, which uses LCAs to 
terminate the solution components in the reverse order of the component 
startup. (The component startup order is defined in the Solution 
configuration object.)
SCI reports a successful de-activation of Multimedia after all of the 
solution components have terminated within the configured timeout. Upon 
a successful de-activation of Multimedia, its status changes from Running 
to Stopped.

Note: Because many components are shared by a number of solutions, 
some Multimedia components can continue to have the status 
Running after the solution has stopped.

End of procedure

Next Steps

• You have completed all the steps to stop Multimedia using SCI.
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Appendix

Deploying an E-Mail 
Solution Using MIME 
Customization
Multipurpose Internet Mail Extensions (MIME) is a standard that allows 
e-mail messages to include graphics, audio or video files, or text in languages 
other than English.
This appendix describes how to create a custom transformer that enables you 
to modify the content of e-mails and still ensure that they are compliant with 
MIME standards.

Overview, page 199
Configuration Process, page 200
Message Flow Pattern, page 206

Overview
MIME customization in a Genesys e-mail handling environment ensures that 
you have normalized formats for all e-mail messages processed by your system 
and stored in the UCS database. To accomplish this, your e-mail solution uses 
a custom transformer to transform any MIME content in incoming or outgoing 
messages.
You implement this solution by using MIME customization APIs (as described 
in “Creating a custom transformer” on page 201) to change the content of 
incoming and outgoing e-mails. After creating the custom MIME transformer, 
you configure the E-mail Server Java Application object to enable the MIME 
customization option. For details, see “Configuring the E-Mail Server Java 
Application Object” on page 203.
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Your custom server then does all of the work required to handle incoming and 
outgoing e-mail messages as needed.
• When an e-mail message is received, E-mail Server Java uses the custom 

MIME transformer to transform the message before saving it in the UCS 
database.

• When an e-mail message is sent, E-mail Server Java uses the custom 
MIME transformer to transform the message (if it requires MIME 
customization) before sending it to the external e-mail server.

Configuration Process
Complete the following procedure to deploy a MIME-compliant e-mail 
solution.

Procedure:
Deploying a MIME-compliant e-mail solution

Start of procedure

1. Viewing a sample transformer
2. Creating a custom transformer
3. Configuring the E-mail Server Java application object, page 203

End of procedure

Procedure:
Viewing a sample transformer
E-mail Server Java 7.6.1 includes a sample incoming MIME transformer. This 
sample is an “MS-TNEF Microsoft specific format to MIME” transformer, and 
can be found in the mimeapi subdirectory.

Start of procedure

1. Open the directory where E-mail Server Java 7.6.1 is installed.
2. In the mimeapi subdirectory, you can find the following files:

• esj-mime-api-doc.jar—Javadoc documentation for the API.
• esj-mime-api.jar—The actual API archive.
• samples—A subdirectory, containing the following files:

TNEFMimeTransformer.java—Java source code for this sample.
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readme.txt—A readme file describing the sample.

End of procedure

Next Steps

• Creating a custom transformer, page 201

Procedure:
Creating a custom transformer

Overview

To transform MIME content of e-mail messages, you must create a custom 
transformer. Your transformer code needs two Java classes: one to implement 
the API for transforming MIME content of incoming e-mail, and another to 
provide an API that transforms MIME content of outgoing e-mail. Both of 
these classes return the transformation result, and contain the following 
parameters:
• input—The MIME message content.
• config—Properties contained in the [mime-custom-outbound-properties] 

section of your E-mail Server Java Application object.
• debugLogStream—Log object to be used for debugging purposes.
Each custom class that you create should satisfy the following conditions:
• Implements one of the two appropriate interfaces (see “Incoming E-Mail 

Customization API” and “Outgoing E-Mail Customization API” for 
details). 

• Is thread-safe.
• Does not change the MIME message ID.

Start of procedure

1. Create two Java classes: one for transforming incoming e-mail, another for 
transforming outgoing e-mail. Use the following interfaces:
• Incoming E-Mail Customization API, page 202
• Outgoing E-Mail Customization API, page 202

2. Bundle these two classes into a JAR file called mimecustomization.jar.

Tip: Use the instructions in the readme.txt to download the JTNEF 
library and then compile the source. After you complete these two 
actions, you can use the sample to transform MS-TNEF incoming 
mails into regular MIME messages.
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3. Place the new JAR file in the esj\lib\external\ folder of your E-mail 
Server Java installation.

End of procedure

Next Steps

• Configuring the E-mail Server Java application object, page 203

Incoming E-Mail Customization API

Your custom transformer for incoming e-mail must implement the following 
interface:

EmailInTransformer Interface
public interface EmailInTransformer {

public TransformerResult transform(byte[] input, java.util.Properties config, 
java.io.PrintStream debugLogStream);

public class TransformerResult {
public static TransformerResult noTransformationNeeded();
public static TransformerResult succesfull(byte[] transformedInput);
public static TransformerResult failure(String failureReason, FailureAction 

failureAction);
// Implementation details skipped …

}

public class FailureAction {
public static final FailureAction RETRY;
public static final FailureAction BYPASS_TRANSFORMATION;
public static final FailureAction DEPEND_ON_BAD_FORMAT_OPTION;
// Implementation details skipped …

}
}

}

Outgoing E-Mail Customization API

The only difference between this API and the incoming e-mail customization 
API is that the failureAction parameter and class have been removed. If a 
transformation fails, then the original message is sent to the external e-mail 
server.
Your custom transformer for outgoing e-mail must implement the following 
interface:

EmailOutTransformer Interface
public interface EmailOutTransformer {

public TransformerResult transform(byte[] input, java.util.Properties config, 



Deployment Guide  203

Appendix: Deploying an E-Mail Solution Using MIME Customization Configuration Process

java.io.PrintStream debugLogStream);
public static class TransformerResult {

public static TransformerResult noTransformationNeeded();
public static TransformerResult succesfull(byte[] transformedInput);
public static TransformerResult failure(String failureReason);
// Implementation details skipped …

}
}

}

Configuring the E-Mail Server Java Application Object
After you create the custom MIME transformer, configure the E-mail Server 
Java Application object to specify the class names and configuration settings 
used with your custom transformer. E-mail Server Java will use the values you 
specify to transform content that is sent and received as e-mail messages.

Procedure:
Configuring the E-mail Server Java application object

Start of procedure

In Configuration Manager, configure the following sections on the Options 
panel of your E-mail Server Java Application object:
• [mime-custom-inbound-properties]—Content in this section is passed to 

the EmailInTransformer.transform() method using the config parameter. 
You can use this section to define custom options and settings.
This section is not part of the default template. Add this section manually 
to set options for your custom transformer for incoming e-mail.

• [mime-custom-outbound-properties]—Content in this section is passed to 
the EmailOutTransformer.transform() method using the config parameter. 
You can use this section to define custom options and settings.
This section is not part of the default template. Add this section manually 
to set options for your custom transformer for outgoing e-mail.

• [mime-customization]—Use this section to enable or disable the MIME 
customization, to specify the fully qualified class names of your custom 
classes, or to set allow optional debugging or saving features.
See Table 10 on page 205 for details about the options applicable to this 
section.

End of procedure
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Next Steps

• You have completed the actions required to deploy a MIME-compliant 
e-mail solution.
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MIME Customization Options Table
Table 10: MIME Customization Options Section

Option Name Value Description

[mime-customization] Section

enable-inbound Default Value: false
Valid Values: true, false

If set to true, sends inbound e-mail 
messages to the specified inbound 
MIME transformer class.

enable-outbound Default Value: false
Valid Values: true, false

If set to true, sends outgoing e-mail 
messages to the specified outbound 
MIME transformer class.

enable-inbound-debug-log Default Value: false
Valid Values: true, false

If set to true, activates the inbound 
debug logger.

enable-outbound-debug-log Default Value: false
Valid Values: true, false

If set to true, activates the outbound 
debug logger.

inbound-class-name Default Value: ""
Valid Values: <any string>

Specifies the fully qualified name of the 
custom inbound transformer.

outbound-class-name Default Value: ""
Valid Values: <any string>

Specifies the fully qualified name of the 
custom outbound transformer.

inbound-keep-received-mime Default Value: false
Valid Values: true, false

Controls the way E-mail Server Java 
saves the content of MIME messages.
If set to true, and if the message was 
transformed successfully, then saves the 
unmodified MIME content of incoming 
e-mails received in the UCS database 
(along with the transformed content).

outbound-keep-sent-mime Default Value: false
Valid Values: true, false

Controls the way E-mail Server Java 
saves the content of MIME messages.
If set to true, and if the message was 
transformed successfully, then saves the 
transformed MIME content of outgoing 
e-mails is also saved in the UCS 
database (along with the initial content).
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Message Flow Pattern

Incoming E-Mail Message Flow
Figure 62 shows the message pattern for incoming e-mail messages.

Figure 62: Message Flow for Incoming E-Mail
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E-mail Server Java checks if a message with the same MIME message-
ID already exists the UCS database to avoid duplicate processing.
The MIME message is only transformed if UCS does not find that 
message in its database.
If the transformation is successful and the option to keep original MIME 
messages is enabled, E-mail Server Java saves the original message in 
the UCS database.
The messaging client removes any messages that are marked for 
deletion after the session is closed.
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Outgoing E-Mail Message Flow
Figure 63 shows the message pattern for outgoing e-mail messages.

Figure 63: Message Flow for Outgoing E-Mail
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Only if the MIME message does not exist in the UCS database.

Only if the MIME message already exists in the UCS database.

Only if required. SMTP sessions are pooled, and closed when unused for a configured time period.

Only if Transformation was successful and the option to keep original MIME messages is enabled.
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